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PREFACE

APPLICATION STORAGE MANAGER AND DISKXTENDER

The Windows NT/2000 edition of Application Storage Manager (ASM) was
developed for StorageTek by OTG Software and is based on their DiskXtender (DX)
product.  With ASM and a full line of world-class tape drives and tape libraries,
StorageTek can deliver A COMPLETE SOLUTION for cost-effective storage
management of your standalone and distributed Windows NT/2000 systems.

BENEFITS

DISKXTENDER allows you to extend the capacity of NTFS volumes by automating
migration of files to storage media. DISKXTENDER uses separate media services to
manage media in storage devices, so that all drive, library, and media specific issues
are handled and optimized by the media service (like MEDIASTOR).  This enables
DISKXTENDER to focus specifically on the management of files, allowing clients to
simply save and retrieve files on any extended NTFS volume.

With DX, many terabytes of data storage can be made available on an NTFS volume
without adding to the physical capacity of the hard disk where the volume is located.
DX can be used to represent the contents of multiple pieces of media as folders on a
single volume, keeping track of the exact location of all files on media. CD-ROM,
Erasable-Optical (also called Magneto-Optical), WORM, DVD, and Tape media can
all be managed easily and effectively, using a variety of file systems.

DISKXTENDER adds value to the NTFS file system, enhancing Windows native
capabilities, by providing file migration services. Because of the design of
DISKXTENDER, file migration can be added without losing any Windows features.
Windows NT/2000 still manages all issues like security, long file name support, and
network connectivity.

DX provides a rule-based system for file storage management. Rather than simply
migrating all files to media without distinction between files, DX allows you to set
criteria that govern which files will be stored where. Using the rules you create, DX
manages file storage locations in the background, moving files to media and purging
their data to make space on the extended drive. To the end user, however, all files
appear to be located on the NTFS drive extended by DX.

DX provides comprehensive file management capabilities, a single point of
administration, and scheduling features to optimize system performance. Time-
consuming processes that compete for system resources – such as media restore,
media compaction, and file movement to media – can be set to occur at convenient
times. DX also monitors system warnings and errors, and can be configured to send
alerts to specific users or computers.
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This system guide explains how to configure and utilize DISKXTENDER to most
effectively manage your file system migration. It contains all the necessary
information to achieve the best results for implementing and customizing your
automated data storage solution.

DOCUMENTATION CONVENTIONS

Consistent formatting is used throughout the DISKXTENDER System Guide to
represent certain information.

Table 1: Documentation Conventions

THIS CUE: REPRESENTS:

monospaced text Characters that must be typed on your screen exactly as
they appear in this document.

<SMALL CAPITALS> Keys on your keyboard used in combination or
sequence. For example <ALT>+B means to hold down
the <ALT> key while pressing B, and <ALT>, F, X means
to press and release each of the keys in order: first
<ALT>, then F, then X.

ALL CAPITALS Directory names, filenames, and acronyms.

italics References to manual titles, chapter titles, and section
headings; placeholders; and emphasis.

WARNING ����
Precautionary note
between two lines.

Warnings about actions that could have adverse affects
on the functionality of the DX system.

NOTE ����
Explanatory note
between two lines.

Additional information needed as you follow the step-
by-step operations in this manual.
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CHAPTER SUMMARY

The following table summarizes each chapter of this document:

Table 2: Chapter Summary

CHAPTER: DESCRIPTION:

Chapter One:
Introduction on page
1

This chapter provides a brief overview of the system,
including its concepts and components.

Chapter Two:
Working in the
Administrator on
page 19

This chapter describes the Administrator interface and
basic functionality.

Chapter Three:
Extended Drive
Administration on
page 43

Extended drive properties are discussed, as are
troubleshooting functions such as alerts. In addition, use
of the report generator and report layout editor are
discussed.

Chapter Four: DX
Computer
Administration on
page 75

This chapter discusses DX computer properties and
troubleshooting functions such as logs and event
viewing. In addition, procedures for using the Repair
Disk function are provided.

Chapter Five:
Reports on page 127

This chapter discusses how to run DX reports, what
information is contained in them and how to set up and
save custom layouts for your DX reports.

Chapter Six: Backup
and Recovery on page
161

This chapter discusses the functions available in DX to
allow you to effective back up your DX system and
procedures for restoring your backup system in the event
of disaster or failure.

Chapter Seven:
Explorer Add-Ons on
page 189

This chapter discusses the functions available through
the Explorer Add-ons. In addition, procedures are
provided for accessing and executing explorer add-ons
functions.

Chapter Eight:
Removing DX and DX
Components on page
217

This chapter provides detailed instructions for removal of
DX components (extended drive, media folders, media),
and procedures for uninstalling DX, the Remote
Administrator and the Explorer Add-Ons.
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RELATED DOCUMENTATION

Refer to the following additional documentation:

� DISKXTENDER Data Management Guide

� DISKXTENDER System Guide

� MEDIASTOR System Guide if using OTGMS as a media service

� SANXTENDER System Guide if using SANX to migrate file data over a SAN

� ACSLS documentation if using ACSLS as a media service

� Tivoli Storage Management documentation if using TSM as a media service.

ONLINE HELP

Help is available online from any DISKXTENDER dialog box. For a description of the
dialog box, press the <F1> key. A Help window appears, outlining the dialog box
parameters and fields.

A knowledgebase help file with error descriptions, tech notes, software notes,
fixed/known bugs is also available in the OTG DISKXTENDER program group on the
Start menu. All DX2000 guides, including this one, are also available in PDF format
on the installation CD.
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CCHHAAPPTTEERR
OONNEE

INTRODUCTION

DISKXTENDER (DX) is a storage management system that provides support for
multiple media types, flexible media and data organization, and rules-based file
migration. DX accomplishes this through an easy-to-navigate interface, and
transparent communication with storage locations and device management software.

DISKXTENDER allows you to extend the storage capabilities of NTFS volumes by
using DX file migration services to move files from the NTFS volume to other, less-
expensive storage media. For example, users on your network may typically save
data to an NTFS volume on your Windows NT/2000 file server. You can vastly
expand file storage capabilities by extending one or more of the file server’s drives
with DISKXTENDER. File data on a drive extended by DX can be moved to media
through a media service (e.g., to tape in a library managed by OTG’s MEDIASTOR)
without affecting the file listing seen by the end user.

You are the architect of the DISKXTENDER system. DISKXTENDER allows you to
leverage your existing hardware configuration or create a new one. Powerful features
of DX, combined with an easy-to-use graphical user interface, allow you to fine-tune
a file storage strategy for any type of application requirement. Because DX supports
several media services, media types and file systems, you can select a storage
configuration most suited to your available resources and your storage needs.

Before designing a storage strategy, you should be comfortable with DISKXTENDER
terminology and concepts. In addition, many of the issues discussed in this system
guide should be carefully planned before implementing a DX storage strategy. Take
the time to read all sections, as this will help you attain the best performance,
functionality, and organization for your storage solution.

This section identifies key terminology and concepts that are vital for you to
understand. Included are descriptions of DX modules, conceptual and practical
definitions, as well as guidelines for planning and implementing your DX storage
strategy.
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A DISKXTENDER GLOSSARY

To make it easier for you to follow the discussion of DX architecture in this chapter,
here are brief descriptions of key terms used in the DX Concepts section. You can
either read this glossary first or refer to it as needed while you read about DX. For an
in-depth overview of DX, see DX Concepts on page 4.

Table 3: DISKXTENDER Glossary

TERM: DEFINITION:

Cluster A processing environment consisting of two or more server
computers and a RAID array, connected together in such a
way that they behave like a single computer, and so that the
server computers share the single storage device.

Data
Management

DX manages the location of the file data for DX files. DX
can manage the contents of a file separately from the file tag
for that file. The file tag for a DX file is always displayed on
the DX extended drive. In the background, transparent to the
user, DX controls the location of the file data for each file
managed by DX.

Drive A drive is a hardware device through which media can be
read from or written to.

Extended Drives An extended drive is a hard drive, or partitioned part of a
hard drive on the computer where DX is installed. That drive
must be formatted with the NTFS file system. DX expands
or “extends” the drive by moving files from the hard drive to
storage media (based on parameters you set) and then
purging the file data for those files (also based on parameters
you set). This process creates the illusion that the space
available on the hard drive is much larger than it really is –
making the drive space appear to have been “extended.”

Fetch The process of retrieving file data from storage media when
a user requests the file. Specifically, a fetch is moving the
file data from the media back to the extended drive.

File Data A file’s data is the contents of the file.

File Tag A file tag is the identifying information for a file. The file tag
includes such information as file location, file attributes, file
size, and file age. This is sometimes also referred to as
“metadata”, though true metadata includes the file tag and
other file information.

File Migration File migration is the process of moving files to and from the
extended drive and storage media. DX moves files to media
using parameters configured through move groups and move
rules. DX retrieves files from media through client file
requests and configured prefetches.
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TERM: DEFINITION:

File System A file system is software that provides an interface for saving
and retrieving files on storage media. File systems control all
aspects of media management, including directory/file
structures, data layout, and data transfer.

Hard Drive A hard drive is a stationary piece of media.

Hardware Device A hardware device is a piece of equipment that holds and
spins a magnetic or optical disk and reads and writes
information to it.

Jukebox/ Library A jukebox or library is a hardware device containing one or
more removable media drives, shelves for pieces of media,
and a mechanism for moving pieces of media between the
shelves and the drives.

The terms “jukebox” and “library” are interchangeable. In
most instances in this manual, the term “library” is used to
refer to libraries or jukeboxes.

Logical Cluster
Name

The network identifier of a clustered environment. Because a
cluster functions as a single element, users access the logical
cluster name via the network, rather than any of the
individual servers in the cluster itself.

Logical Media A “logical” piece of media is a piece of media that is defined
by its location on a piece (or pieces) of media rather than by
the physical constraints of the media itself.

For example, a network share that shares a single folder to
the network could be treated as a piece of media in DX. In
contrast, a RAID device, which has multiple drives, could
also be treated as a single piece of media if the entire device
is shared as a single network share.

Media Media refers to a physical medium on which data is written
and from which data can be retrieved. Depending on the type
of media, the medium may be different and the information
may be recorded in different ways.

In most instances in this manual, the term “media” refers to
the storage media to which DISKXTENDER files are migrated.

Media Pool A media pool is a reserve of pieces of media available for
use with a particular extended drive.

Media Service A media service provides access to the media to which DX
migrates files. In some cases, the media service is a network
share. In other cases, a media service is a device
management service that will retrieve a specific piece of
media and mount the media in a device such as a library
drive when requested to do so.
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TERM: DEFINITION:

Media Type The type of a piece of media is determined by the
composition of the media and the method used to record
information on that media. Some examples of media types
are optical media, CD-ROM media, DVD-RAM media, and
tape media.

Network
Attached Storage
(NAS)

Network Attached Storage is logical media that has been
shared to the network to allow network users to access the
media. DX can point to any network share as a Network
Attached Storage media service.

NTFS Volume An NTFS volume is a piece of stationary media or a partition
on a piece of stationary media that has been formatted with
the NTFS file system.

OTG MEDIASTOR
(OTGMS)

OTGMS is a device management package that can be used as
a media service by DX. OTGMS has the ability to manage
retrieval of media in a wide variety of hardware devices.

Removable Media
Drive

A removable media drive is a drive where different pieces
can be inserted and removed as needed, such as a CD-ROM
drive.

Removable Media Removable media is media that must be mounted in a drive
before it can be accessed. Removable media can be inserted
and removed as needed to allow for access to multiple pieces
of media.

Stationary Drive A stationary drive is a drive where the same piece of media
is always mounted, such as the hard drive on your computer.

Stationary Media Stationary media is media that is always mounted in a drive
and cannot be removed without removing the entire drive.

DX CONCEPTS

The architecture, components, and data management tools of DISKXTENDER are
discussed in this section. For an overview of each of the following concepts, see the
following sections:

� DISKXTENDER Components - see below

� DISKXTENDER’S Distributed Storage Model – see page 8

� Media Services – see page 9

� Extended Drives – see page 9

� Media Management Tools – see page 13
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� Event Scheduling – see page 14

� Client Connectivity – see page 17

DISKXTENDER COMPONENTS
DISKXTENDER is comprised of several components, or modules and each have
specific functionality within the system. Several of these modules are discussed
briefly in the sections that follow.

DiskXtender Data Manager Service
The DISKXTENDER Data Manager Service is a Windows NT/2000 service that runs
on the computer where DISKXTENDER is installed. All media, schedule, and extended
drive management is coordinated by the DX Data Manager. The DX Data Manager
service uses two auxiliary drivers, the DxSpy driver, and the DxSpyRec driver to
monitor and report file activity on the extended drive. These drivers watch for
changes in the folders designated for DX file migration services, intercept requests
for migrated files, and track the addition, modification, or deletion of DX files. The
DX Data Manager moves, purges, and deletes files on the extended drives according
to the file move, purge, and delete rules that have been set for the extended drives.
The DX Data Manager communicates with computers offering media services
(hardware device management) to retrieve files that need to be fetched from media
and to send files that need to be saved to media.

DX Data Manager functionality can be managed through the DX Administrator,
either on the DX Data Manager machine or from any remote installation of the DX
Administrator.

OTG License Server
Licensing information for your DX system is managed on the OTG License Server.
The License Server is the program through which the licenses for your OTG
products are registered and maintained. The OTG License Server program is
included on the DISKXTENDER CD, and can be installed on the DX computer or on a
separate computer, as long as that computer is visible to the DX computer through
the network.

Use the Edit product license information option in the Setup wizard (accessed
through the OTG DiskXtender program group) to point to the License Server
computer once your DX licensing information has been registered in the License
Server.

DX Administrator
The Administrator allows you to view and configure the underlying structure of the
DX system, providing a single interface for managing multiple DX computers and
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the extended drives on those computers. Through this module, you can manage all
major aspects of the DX system:

� Media services connectivity (connectivity to storage media or to device
management software that manages hardware devices containing storage media)

� Drive saver and timeslice settings (for drives in the storage devices managed by
the media services)

� Functionality of extended drives (the NTFS volumes for which DX provides
data management services)

� Functionality of the DX service, to include setting options and alerts, and
viewing statistics.

The Administrator has an intuitive “tree” view where DX extended drives and the
configuration items for those extended drives are grouped as sub-trees for ease of
use.

All aspects of extended drive and DX service functionality can be configured
through the Administrator. You can assign pieces of media to media folders on an
extended drive and then define rules to control the management of files in the media
folder. You can set up schedules to control when events, such as file migration and
processing of media management tasks, occur. You can configure alerts to send
messages alerting a particular user or workstation to DX errors or warnings relating
to the extended drive. In addition, you can view event, warning, and error logs and
run reports on various aspects of DX system functionality.

Enterprise (Remote) Administration
Regardless of whether you are running a full installation of DX or only the Remote
Administrator, the Administrator interface for DX can be used to configure any DX
computer visible on the network (provided security settings allow access). Because
enterprise (remote) administration capability is automatically installed when you
install DISKXTENDER, you can remotely administer any DX computer from any other
DX computer. You can also use the DX Remote Administrator Setup to install only
remote administration components, if that is all you need on the administration
computer.  DX (full installation) needs only to be installed on computers containing
the NTFS volumes that DX will use as extended drives. It is important to be sure,
however that the same version of DX (or DX Remote Administrator) is installed on
both the administering computer and the remote DX computers it is being used to
administer.

Online Help
 DX contains context-sensitive help links that provide instructional help and
examples. The Online Help is automatically installed with DX and with the DX
Remote Administrator). Press the <F1> key at any time to get help on the currently
displayed dialog box, window or wizard page.  You can also access the online help
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from the program group in the Start menu.  The program group also provides access
to the OTG Knowledge Base.

Explorer Add-ons
DISKXTENDER includes a utility that can be installed on clients that are using files on
DX extended drives to allow file and folder management functions to be performed
from the Windows Explorer on the client workstation. When you right-click on a file
or folder in the Explorer window on the client workstation, a DISKXTENDER option
appears on the shortcut menu.

Explorer Add-ons can be used to view file properties, such as the actual file size, the
file status (i.e., fetched or purged), and the DX attributes for the file. You can view
file properties on many files within a media folder at once using the Explorer Add-
ons. You can also run file reports, enable or disable direct read, and purge files using
the DX Explorer Add-ons.

Reports
DISKXTENDER contains a reporting feature that can be used to track system statistics.
You can create various reports of system activities, including extended drive
information, media information, media services, and DISKXTENDER settings in the
Windows NT/2000 registry. In addition, the reporting function allows you to create
and save custom layouts for your reports, and to choose the layout you want when
the report it is run.

System Backup and Recovery
DISKXTENDER contains several functions that can make creation and/or maintenance
of a comprehensive backup and recovery plan easier. DX allows you to create
backup files for your system registry and for extended drive data. In addition, if you
use a clustered environment to manage fault-tolerance for your system,
DISKXTENDER can be installed and run on a clustered environment, allowing for
automatic fail-safe of your DX system.

Command Line Utilities
DISKXTENDER includes several utilities that allow you to perform device
management independently. These utilities are located in the \OTG
DISKXTENDER\BIN\ directory, and are run from the command prompt.
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DISKXTENDER’S DISTRIBUTED STORAGE MODEL

DISKXTENDER is one component of a distributed storage system. Within this system,
DX is responsible for managing the movement of data on NTFS volumes to a pool of
storage media. Once a media service has provided access to media, DX
communicates directly with the media to read and write data and perform media
tasks.

Various media services can be responsible for providing access to media pools. Four
types of media services are available for use with DX: Network Attached Storage
(NAS), OTG MEDIASTOR (OTGMS), StorageTek’s ACSLS media services, and
Tivoli Storage Manager (TSM). DX connects with these media services either
through a network share or through Remote Procedure Calls (RPC). DX transfers
files to the media provided by the media services and sends requests for pieces of
media to the media services as needed.

Figure 1: DISKXTENDER Architecture
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This architecture allows you to set up the components of your storage solution on
several computers and avoid the bottleneck of a single-server/multiple-client
architecture. You can configure remote storage of files distributed across a network,
while maintaining a high level of scalability and administrative flexibility.

DX monitors activity on extended NTFS volumes and then communicates with
media services for media to be retrieved as needed. DX relays each request for a
piece of media to the appropriate media service, and the media service mounts the
media so DX can retrieve or store files, or carry out media tasks. DISKXTENDER
transparently manages the connections between DX and the media services, and the
movement of files between the extended drive and the media. The client (i.e., end
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user) connection to the NTFS volume is managed entirely by Windows NT/2000;
DISKXTENDER is not involved in client connectivity at all.

This configuration allows you as the administrator to “extend” the capacity of hard
drives on your network servers, seamlessly to the end user. The end user saves files
to and retrieves files from the NTFS volume, unaware that that volume has been
extended by DX. Because clients connect to Windows NT/2000 rather than DX, the
extensive connectivity offered by Windows NT/2000 remains in effect. Any client
that can connect to a Windows NT/2000 server can access files on an extended drive.

MEDIA SERVICES
When you configure a DX computer, you must configure media services for that
computer before you can move files to media. Media services provide access to
media. When you configure a media service in DX, you point to the location where
the media for the media service resides and, where appropriate, to the device
management software that controls the device(s) where the media will be accessed.

DX manages all functions relating to the transfer of information to and from media.
The only role of a media service is to place pieces of media in a location where DX
can work with the media. DX performs all movement and fetching of files and all
media tasks through direct communication with media and media drives.

When DX needs a piece of media, it sends a request to the appropriate media service
for that media. If the media service is a network share (NAS media), the media is
already available and DX can proceed with the function that needs to be performed.

If the media service involves a device management product, the media service will
cause the device being managed to retrieve the media, or will prompt the
administrator of the media service to insert the appropriate piece of media. For
example, if OTGMS is being used to manage an optical library, OTGMS will cause
the picker arm of the library to retrieve the correct piece of media and insert that
media in a drive where the media can be read from or written to. Once the media is
in the drive, DX can write files to the media, fetch files from the media, or carry out
media tasks such as formatting or labeling the media.

EXTENDED DRIVES
An extended drive is an NTFS volume (hard drive) from which DISKXTENDER
provides file migration services, moving files to media and fetching files from media
according to the parameters you set. Frequently used files can be kept on the NTFS
volume, while less active files can be moved to storage media. It is the addition and
use of the storage media through DX that “extends” the space on the NTFS volume,
by moving files to storage media, and then purging the file data, while making the
file appear to still reside on the extended drive.

To a client retrieving files from a drive extended by DX, all files, whether on the
extended NTFS volume or on the storage media, appear to be present on the NTFS
volume. According to move and purge rules you configure, DX moves files to
removable media and then purges the file data from the extended drive. When the
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file data is purged, DX leaves a file “tag” on the extended drive containing file
information, such as the size and time and date of creation or modification. The file
tag also contains an attribute, left by DX, that points to the location of that file on
storage media. When the extended drive is viewed through Windows Explorer, the
entire file appears to still be stored on the hard disk of the extended drive, even if the
file data has actually been purged.

Every DX computer must have at least one extended drive that defines relationships
between directories, media, and ultimately to where new or modified files are
moved.

File Migration
All files that are written to DISKXTENDER are initially saved to the NTFS volume.
New/modified files are then moved to storage media and purged from the NTFS
volume as specified in the move and purge rules that apply to the files. Files are also
retrieved from media and stored on the NTFS volume automatically by
DISKXTENDER. This movement of files to and from media is referred to as file
migration.

One of DISKXTENDER’s main performance advantages lies in the ability to configure
your system so DISKXTENDER maintains frequently used files on faster access, fixed
media (hard drive) whenever possible. You should carefully plan extended drive
size, and move and purge rules around application needs, anticipated volume, and
available time/hardware for migration processing.

Scheduled file moves and prefetches prevent system bottlenecks resulting from read
and write contention on the same DX computer. With a large enough extended NTFS
volume, the DX computer can process all client read requests at full speed,
processing moves for new/modified files and scheduled prefetches at a later, less
active time.

Different aspects of file migration are controlled in different ways in DISKXTENDER:

� Fetch requests are automatically processed as quickly as possible.

� Prefetch requests are configured for each extended drive by selecting the files to
be prefetched. Prefetch requests are then processed according to the Prefetch
schedule.

� Deferred fetch requests are queued requests that are created during inactive fetch
schedule times. When the fetch schedule becomes active, the deferred fetch
requests are processed and retrieved at that time.

� Move rules control which files are moved to media, or more accurately, which
files are written to the move list for migration to media. The move list is updated
during drive scans and processed when a Move files to media activity schedule
is active. Media Activity schedules can be configured so that time and system
resource consuming activities take place during reduced traffic times.
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Fetch Files from Media
DISKXTENDER provides virtually limitless background mass storage services by
creating the illusion that all files on an extended drive are actually on the NTFS
volume to which clients are connected. In reality, some files on the volume have
been moved to media and purged from the NTFS volume. When a file has been
moved to media and then purged, DX leaves behind a file “tag” which contains only
the file details (size, creation date, etc.) and the location of the file on DX media.
When viewed through Windows Explorer, all proper file details (i.e., correct size,
date, etc.) appear.

When a request is issued for a file, the file data may or may not be present on the
NTFS volume. If the file is present, DX allows Windows to handle the file request. If
only the file tag is present on the NTFS volume (i.e., file data has been moved to
storage media and purged from the volume), DX retrieves the file and completes the
request. When a file is retrieved, this process is referred to as a “fetch.”

Prefetch Files from Media
DISKXTENDER has a prefetch utility that allows you to schedule file retrieval. You
can designate which files should be fetched to the NTFS volume and schedule when
the file retrieval will occur. Any files that you know will be needed can be marked
for prefetch so that they will already be present on the NTFS volume when they are
requested.

You can schedule a prefetch request to occur once at a set time, to reoccur at set
times, or to be processed immediately. Prefetching files at low traffic times frees
system resources and speeds read request response during high traffic times. When a
file is retrieved in response to a configured, scheduled prefetch request, this process
is referred to as a “prefetch.”

The Prefetch Request Manager, in the Tools menu in the Administrator, can be used
to schedule, configure and manage prefetch requests.

NOTE ����
Prefetches will fetch all requested files to the extended drive, to include files marked
for direct read.

Deferred Fetch Requests
If a client attempts to retrieve a purged file when the Allow fetches from media
schedule is inactive, DX cannot fetch the file at that time. DISKXTENDER contains an
extended drive option that allows you to queue file requests when the Allow fetches
from media schedule is inactive. This option, Defer fetch requests if fetch is
disabled, is available through the Options tab on the extended drive Properties dialog
box. If enabled, DX will queue all file requests made during an inactive fetch
schedule as deferred fetches. DX then processes all deferred fetches when the Allow
fetches from media schedule becomes active. See Extended Drive Settings - Schedule
option on page 51 for more information on Allow fetches from media schedule.
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Move Files to Media
New or modified files remain on the NTFS volume until they have been moved to
storage media and purged. You control the timing of file moves through move rules
and schedules. When the extended drive is scanned, DX checks for files that are
eligible for move. If a file is eligible, DX adds it to a move list. Whenever a Move
Files to Media schedule is active, DX processes the move list, writing each file on
the list out to media. When a file is copied out to media, this process is referred to as
a “move.”

SPACE MANAGEMENT
Part of managing an extended drive involves managing space on the extended drive.
Ideally, files that will be retrieved frequently should remain in their original format
on the drive, whereas files that will not be retrieved can be purged to file tags once
they are moved to media, leaving more space for frequently accessed files. In order
to manage more files than would be actually able to fit on the extended drive, you
need to configure space management rules.

Space management rules allow you to control what files are kept immediately
available on the extended drive and what files are purged. Using DISKXTENDER as
your data management system allows you to automate not only the movement of
files to storage media but also the purging and deletion of migrated files from the
extended drive.

Purge Rules and Delete Rules enable automation of file data truncation and file data
deletion based on specific aspects of files, which you determine and configure.

� Purge rules control when files are truncated on (or purged from) the extended
drive. Files are purged either during a drive scan or whenever extended drive
capacity is within the range set by the purge watermarks.

� Delete rules control when files are deleted from the extended drive and from any
storage media to which they have been moved.

Purge Files
The term ‘purge’ is used to describe the process of truncating file data on the
extended drive for files that have been moved to media. When a file is purged, it is
replaced with a file tag that references the file’s location on media. Purging occurs
either during an extended drive scan or whenever the extended drive reaches a
particular capacity, depending on how you choose to configure your purge rules. In
the properties for each extended drive, you can set the watermarks that determine
when purging based on drive capacity begins and ends. Purge rules are configured to
control which files are purged on drive scan or moved to the purge list that is
processed when the watermark is reached.

You can purge files based on file age. Purge rules can be used to dictate file purge
based on create time, last access time, or last modification time. This process is
performed automatically by DX in the background, transparent to client applications.
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NOTE ����
You may also configure your move rules to purge files immediately after they have
been moved to media.

Delete Files
Delete rules allow the system administrator to remove files from storage based on the
same parameters as used in move rules and purge rules. However, delete rules
actually delete files from the extended drive and from media. When a file is deleted
from the extended drive, the file tag is deleted from the extended NTFS volume and
the file data is marked for deletion on the media. This means that the file data will
either be deleted immediately from media or, (for optical or tape media formatted
with OTG file system) will not be transferred to a new piece of media when the
media is compacted. You can also configure secure file delete as an extended drive
property option, which will overwrite any deleted files on tape and optical media,
making them completely unrecoverable even before compaction.

These rules can be used, for example, to help manage archival of particular files kept
in order to comply with legal requirements. You could create a delete rule that
deletes all files in a particular directory that you are not legally required to keep. As
long as the files fit the legal criteria, they are backed up to media by DX and remain
in the directory. Once the files no longer meet the required criteria (e.g., the files
reach a certain age), however, DX can automatically delete them in accordance with
a delete rule.

MEDIA MANAGEMENT TOOLS

DISKXTENDER provides several tools that simplify the management of DX media.

COPY MEDIA MANAGER
DISKXTENDER has a Copy Media Manager that you can use to view and manage
copy media tasks. You can assign the label copy task to media and view the status of
existing copies. You can also promote a piece of copy media to original status. You
can access the Copy Media Manager by opening it from the Tools menu in the
Administrator.

MEDIA PREPARE MANAGER
DISKXTENDER has a Media Prepare Manager that you can use to assign the format
and label media tasks to several pieces of media at once. You can select pieces of
media in the system and assign either or both of these tasks to them from one
centralized interface. You can access the Media Prepare Manager by opening it from
the Tools menu in the Administrator.
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MEDIA TASK QUEUE MANAGER
DISKXTENDER has a Media Task Queue Manager that you can use to view and
manage scheduled media tasks. Tasks can be removed, added, promoted, or demoted
using the Media Task Queue. All tasks assigned to media in the DX system can be
managed from the queue. You can access the Media Task Queue Manager by
opening it from the Tools menu in the Administrator.

PREFETCH REQUEST MANAGER
DISKXTENDER has a Prefetch Request Manager that you can use to schedule prefetch
requests and to manage scheduled requests. Requests can be created, modified, or
deleted using the Prefetch Request Manager. All prefetch requests in the DX system
can be managed from the Request Manager. You can access the Prefetch Request
Manager by opening it from the Tools menu in the Administrator.

EVENT SCHEDULING

DISKXTENDER provides scheduling for many system events, such as moving files to
media, media copy updates, scheduled media task processing, prefetching files, and
drive scans. This allows time-consuming processes to occur at convenient times such
as nights and weekends, thus providing more efficient use of system processing
during active times. Scheduling system events during inactive times ensures that the
events do not compete with network clients for system, drive or library resources.
Schedules can be defined, modified, and deleted through the Administrator.

MEDIA ACTIVITIES
A media activities schedule can be created for DX. Separate schedules can be set up
for each extended drive. Schedules are configured in the Schedule Properties dialog
box, which can be accessed from the Properties dialog box for the extended drive.

Move Files to Media
This schedule controls when a move list on an extended drive is processed and files
on the list are moved out to media.

Process Scheduled Media Tasks
This schedule controls when media tasks that were given a “scheduled” value are
processed. All tasks for a piece of media are processed, and then tasks for the next
piece of media in the media queue are processed. Media are processed in the order
they are listed in the Media Task Queue Manager.
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Update Copy Media
When this schedule is active, copies of original media in the DX system are
automatically updated to match the piece of original they are copies of. Copy media
are created by assigning the label copy task to blank media.

Allow fetches from media
When this schedule is active, user requests for purged files (no longer resident on the
extended drive) can be carried out. By default, this schedule is always active. Some
enterprises, however, require that fetch access to files on media be restricted at
certain times of the day. This media activity schedule option allows you to configure
that kind of time-based restriction, if necessary.

Prefetch Requests
Prefetch requests are scheduled separately from other media activities, during
prefetch request configuration. Flexible scheduling options are available for
scheduling prefetch requests. Prefetch requests are scheduled in the Prefetch Request
Manager.

Any files that you know will be needed can be marked for prefetch so that they will
already be present on the NTFS volume when they are requested. You can schedule a
prefetch request to occur once at a set time or to reoccur at set times, or you can
configure the request to be processed immediately. Prefetching files at low traffic
times frees system resources and speeds read request response during high traffic
times. When a file is retrieved in response to a configured, scheduled prefetch
request, this process is referred to as a “prefetch.”

EXTENDED DRIVE SCAN
Extended drive scans inventory the contents of the extended drive and determine
what files are to be written to the move and purge lists. Files will not be moved or
purged, even if the extended drive reaches capacity or the Move files to media
activity reaches a scheduled time, unless they are listed on the move list or purge list.
The primary purpose of drive scans is to write files that qualify for move rules with
an age delay to the move list.  Files that qualify against move rules with no age delay
are typically written to the move list as soon as they are saved to the extended drive.

If you configure any move rules or purge rules to have age-delays, you must perform
regular extended drive scans to update the move and purge lists. If any of your move
and purge rules use a file age exception to delay move and/or purge of files, you
should set a regular drive scan schedule to make sure that all appropriate files are
written to the move and purge lists.
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WARNING ����
While files qualifying for a move rule with no time delay are automatically added to
the move list, file-sharing issues or sharing violations can prevent files from being
added to the move list when appropriate. DX must have full access to a file in order
to obtain information required for the move list. If the file is open or is otherwise
being accessed by a program or user, DX cannot add it to the move list.

Because files may not be added to the move list due to file-sharing issues, regular
drive scans are required to be sure that all appropriate files are written to the move
list when they qualify, and as such, are being written out to storage media (in
coordination with your Move files to media schedule). DX allows you to force drive
scans at any time, and to set a regular schedule for drive scans. Because drive scans
for very large extended drives can be time consuming, and to make sure files due to
be added to the move list are not currently being accessed, you may want to schedule
your drive scans to occur during times of low extended drive and system traffic.

In addition, when you remove a piece of media from the extended drive, you must
run a drive scan to complete removal of the media and remove the files on the media
from the drive.

Forced Drive Scans
An option is available on the extended drive shortcut menu that allows you to force
an immediate drive scan of the extended drive. A drive scan started using the Force
Drive Scan command is started immediately, independently of any drive scan
schedule you may have in place. You can use this command to run a drive scan if
you remove a piece of media and would like to refresh the extended drive contents
immediately.

Scheduled Drive Scans
You can also schedule drive scans to occur automatically. Drive scans are scheduled
separately from other events (in each extended drive’s Properties dialog box in the
Administrator). Because drive scans are time-consuming yet system-critical events,
more flexible scheduling options are available to allow you to schedule scans more
or less frequently as appropriate.
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CLIENT CONNECTIVITY

The extended drive is a partitioned volume, which resides on a computer using
Windows NT or Windows 2000 as the operating system. The volume is shared
through a network, so that it is visible and accessible to other users. The client
computers that save and retrieve files to and from the shared drive can use virtually
any operating system to read and write the extended drive files.

FILE STREAM SUPPORT
Because NTFS supports file streams, many applications now take advantage of file
streams to store their data. In addition, MAC and NFS file systems use file streams to
store private data.

Support for file streams ensures that DISKXTENDER can protect all application data in
files (not just the primary data). File streams are moved and fetched along with the
primary file data. In addition, file streams can be restored from storage media (along
with primary file data) for disaster recovery purposes.

File stream properties can be viewed through the Explorer Add-ons, if the file
selected contains file streams.

CLIENT FILE SYSTEM SUPPORT
Because DX uses the extended NTFS volume to store files before migration, and is
capable of migrating file streams, all clients that can connect to an NTFS drive can
store and access DX files on an extended drive.

FAT (File Allocation Table)
DX2000 supports FAT as a read-only file system. Operating systems that use FAT as
a file system include Windows 3.x, Windows 95, and Windows 98, Windows NT
and Windows 2000. DX cannot format media with the FAT file system and since
FAT is supported as read-only, FAT media cannot be added to move groups.

NTFS (Native Transport File System)
Clients using Windows NTFS can read and write files on DX extended drives.
Windows NT/2000 uses NTFS or FAT as file systems.

MAC (MacIntosh)
MacIntosh and Apple computers use the MAC file system. Because DISKXTENDER
protects file stream data, client connectivity drivers for MAC can be used to connect
to DX extended drives.



Chapter One: Introduction

18 Application Storage Manager System Guide

NFS (New File System)
UNIX and LINUX applications have NFS as a file system. Because DISKXTENDER
protects file stream data, client connectivity drivers for NFS can be used to connect
to DX extended drives.
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WORKING IN THE ADMINISTRATOR

Because DISKXTENDER (DX) is a Windows-based package, the same easy, intuitive
navigational standards apply to all of its components. The Administrator provides a
user-friendly interface that allows you to easily create and configure DISKXTENDER
components as well as manage DX computer and extended drive properties.

The Administrator has an intuitive “tree” view that displays the underlying structure
of the DX system. Each extended drive appears as a primary tree node and the
configuration items for those extended drives are grouped as sub-trees for ease of
use.

The Administrator view is the interface through which you can configure all aspects
of extended drive and DX functionality. Using the Administrator you can:

� View and configure all registered and connected DX computers.

� Create an extended drive and configure/manage its properties.

� Create media folders for each extended drive.

� Assign pieces of media to media folders and then define rules to control the
management of files in the media folder.

� Set up schedules to control when events, such as file migration and processing
of media management tasks, occur.

� Configure alerts to send messages alerting a particular user or workstation to DX
errors or warnings relating to the extended drive.

� View event, warning, and error logs and run reports on various aspects of DX
system functionality.

DX Administration can be performed on the same computer where DX is installed or
from a remote workstation running Windows NT or Windows 2000. This chapter
explains the basic layout of the Administrator, as well as the general functionality.
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Included are explanations of window features, and methods for carrying out system
operations.

STARTING THE ADMINISTRATOR

Starting the Administrator allows you access to extended drives and their associated
media and media information. You can connect to local or remote DX computers
through the Administrator and extend drives on those computers. Using the
Administrator, you can manage DX file organization and directory structure, manage
media, and set event schedules on multiple DX computers.

Upon successful connection to one or more DX computer(s), the tree view of the
Administrator displays all configured DX components in a tree-like structure. The
tree structure contains a primary Extended Drive node with two secondary nodes for
each extended drive: Media Folders and Available Media.

NOTE ����
The Extended Drive and Media Folders nodes will not appear until extended drives
and media folders are created. Media will not appear until you configure a media
service and allocate media to the DX extended drive.
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To open the administrator:
� From the Windows Start menu, select Programs and then OTG DISKXTENDER.

From the DISKXTENDER menu, select Administrator. The Administrator window
appears.

Figure 2: DISKXTENDER Administrator

When the Administrator opens, it automatically connects to all registered DX
computers. If this is a full installation of DX (as opposed to a Remote Administrator
installation) the local computer is automatically registered, and therefore
automatically appears in the Administrator. Once the connection has been made, the
window displays information relevant to each connected DX service.

If you want to administer the DX service on computer(s) other than those currently
connected, you must register those DX computers through the Administrator. For
more detail on registering DX computers, see Registering a DX Computer on page
34.

THE ADMINISTRATOR WINDOW

The Administrator window is made up of several components: the main menu, the
Computer drop-down list box, a toolbar and a status bar. The menu bar contains the
main menu commands and can be found at the top of the window. The Computer
drop-down list box can be found just below the main menu on the left, and the
toolbar can be found just below the main menu to the right of the Computer drop-
down list box. The status bar can be found at the bottom of the window.
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The main portion of the window is for navigation and information display. The main
portion of the window is split into three panes. The left pane of the window contains
the tree-like structure from which most commands are performed. The top right pane
displays the contents of the item currently selected in the tree. The bottom right pane
displays a description or detailed properties of the item selected.

Split bars separate the panes of the Administrator window. These split bars can be
moved to change the size of each pane.

To move the split bar:
� Drag the bar to its new location.

THE TREE VIEW: EXPLORING DX
The left pane of the Administrator window contains a tree showing all extended
drives configured for registered DX computers. Commands for managing DX
functionality can be accessed from the tree. When you right-click on a tree node, a
shortcut menu containing commands for performing DX functions appears. The
shortcut menu commands will vary, depending on what item you selected in the tree
view.

Each node in the tree indicates whether it is expandable; that is, whether it contains
items beneath it. A plus sign (+) marks a node that is expandable. Once a node has
been expanded, the plus sign changes to a minus sign (-), indicating that it has been
expanded and can now be collapsed.

To expand a node:
� Click the plus sign, or double-click the item.

To collapse a node:
� Click the minus sign, or double click the item.

If a node appears with neither sign, that means it currently contains no items within
it. For example, if the Blank node of the Available media tree does not have a plus
(+) or minus (-) sign in front of it, there are no Blank media available for that
extended drive.

THE CONTENTS VIEW: NODE DETAILS
The top right pane of the Administrator window contains the contents of the node
currently selected in the tree on the left. These contents include the same information
displayed underneath the node in the tree, if the node is expanded. For example,
selecting the Original node of the Available Media tree will list all available
formatted and labeled media in the Contents view. The same information is listed
underneath the Original node if that node is expanded. You can select an item either
in the tree view or in this Contents section to make the appropriate commands
available.
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THE DESCRIPTION VIEW: ITEM DETAILS
The bottom right pane of the Administrator window contains details about the item
currently selected in the tree on the left. This section provides helpful information
about the current configuration and settings. For example, if a move rule is selected,
the description view shows the following information about the move rule: directory,
file type, size and attributes settings, and move settings.

TOOLBAR
The toolbar contains buttons that provide quick access to many of the Administrator
commands and features. For more information on using the toolbar, see the Toolbar
section on page 28.

MAIN MENU
The main menu contains a list of menus with commands for carrying out functions in
the Administrator. Although functions are easily performed using shortcut mouse
clicks, all functions can be performed through the main menu commands as well.
When you select a node, the Edit menu changes to contain the same commands
available on the shortcut menu for that node.

COMPUTER DROP-DOWN LIST
The Computer drop-down list displays the name of the currently active computer.
You can use the drop-down feature of this text box to activate a different DX
computer in the Administrator. Selecting a computer from this list has the same
effect as clicking on or highlighting a different computer in the tree view of the
administrator.

In order for a computer to appear in the Computer drop-down list, the computer must
be registered through the administrator. For additional information on registering DX
computers to add them to this list box, see Registering a DX Computer on page 34.

STATUS BAR
The status bar is located at the bottom of the Administrator window and displays
information about a command or toolbar button.

To show or hide the status bar:
� From the DX Administrator’s View menu, select Status Bar. A checkmark

beside the command indicates that the status bar is displayed.
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WORKING IN THE ADMINISTRATOR

The following sections describe several features and functions available in the
Administrator, as well as basic navigation through DISKXTENDER. For information
on unfamiliar techniques, see Documentation Conventions on page viii or refer to
your Windows user manual.

COMMON INTERFACE FEATURES
In most DX dialog boxes, the Cancel button closes the dialog box and stops a
process without implementing or saving any changes made.

All DX wizards provide Next, Back, Finish, and Cancel buttons. Some DX wizards
also have Help buttons. The following table describes each of these buttons.

Table 4: Common Wizard Buttons

BUTTON: DESCRIPTION:

Returns to the previous page (disabled on the first page).

Moves to the next page in the sequence (replaced by Finish
button on final page).

Discards any information provided, terminates the process
and closes the window.

Applies the settings entered on all pages and executes the
function for which the wizard was designed, according to
your selections throughout the wizard.

Opens online help related to the current wizard.

Some DX components have a status bar at the bottom of the window. Translations of
certain commands or important messages to the user appear on the status bar.

A checkmark next to an option, whether that option is located in a dialog box or in a
menu, signifies that the option has been enabled. Clicking a checked option will clear
the checkmark and disable the option.
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USING THE KEYBOARD WITH THE ADMINISTRATOR
DISKXTENDER is designed for use with a mouse for quickly accessing commands
and features. However, a combination of mouse and keyboard techniques can be
used for efficiently carrying out any action in DX. Keep in mind that keys are often
used in combinations or sequences. The following table describes how key
combinations and key sequences are represented in this system guide:

Table 5: Documentation Conventions for Keyboard Techniques

KEYBOARD
TECHNIQUE:

DOCUMENTATION
CONVENTION:

EXAMPLE:

Key combination Keys separated by a plus
sign should be pressed at
the same time.

The example, <SHIFT> + <F1>
means to hold down the < SHIFT >
key while pressing the <F1> key.

Key sequence Keys listed in sequence
and separated by
commas should be
pressed in sequence.

The example, <ALT>, <F>, <A>
means to press and release each of
these keys in order: first <ALT>,
then <F>, then <A>.

Shortcut Keys
There are certain keys that can be used through the DX Administrator to carry out
functions.

Table 6: Shortcut Keys

KEY: DESCRIPTION:

<DEL> Press this key to select Delete when there is a Delete button or
command available in the interface. This key can also be used to
delete selected items in the Tree view or in lists.

<F2> Press this key to select Edit when there is an Edit button available in
the interface. This key can also be used to open the Properties dialog
box for selected items in the Tree view or in lists. You can also
double-click an item to edit it.

<INS> Press this key to create a new item wherever a New option is
available.

<CTRL> Press and hold this key while selecting items in a list to select
multiple non-sequential items.

<SHIFT> Press and hold this key while selecting or pressing the up or down
arrow key to select sequential items in a list.

<TAB> Press this key to move from one option to the next in a dialog box.
(For more information, see Using the Keyboard in a Dialog Box on
page 26.)



Chapter Two: Working in the Administrator

26 Application Storage Manager System Guide

Using the Keyboard with Menus
The DX Administrator has a main menu below the title bar. The menus hold most
commands available in DX. To carry out commands, highlight the appropriate item
in the tree view, select a menu, and then choose a command from that menu.

Choosing the command carries out the action. Every menu, as well as every item in a
menu, has one underscored letter or number, which is used for carrying out keystroke
commands. Instead of using the mouse to open the menu and choose a command,
you can utilize the underscored letters.

NOTE ����
In Windows 2000, the underscores that indicate shortcut keys in menus and dialog
boxes are not visible by default. To view the shortcut keys, press the <Alt> key.

To perform commands using only the keyboard:
1 Press the <ALT> key to activate the menu bar.

2 You have the following choices:

� Press the underscored letter for the menu you want to open.

� Use the right and left arrow keys to highlight the menu you want to open,
and then press <ENTER>.

The selected menu opens. The first command is selected by default.

3 You have the following choices:

� Press the underscored letter (or number) of the menu command you want to
perform.

� Use the up and down arrow keys to highlight the menu command you want
to perform, and then press <ENTER>.

The command is performed.

NOTE ����
Shortcut key combinations are listed to the right of some menu items. You may be
able to use this combination instead of opening the menu and choosing a command.

Using the Keyboard in a Dialog Box
The <TAB> key can be used in any dialog box to move from field to field. This
includes text boxes, checkboxes and option buttons, drop-down lists and list boxes,
and command buttons. Another method of moving through a dialog box is to press
and hold the <ALT> key, while typing the letter underscored in the option name or
group name.
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The following table lists the keyboard commands for selecting each type of field.

Table 7: Selecting Field Types In A Dialog Box

FIELD: KEYBOARD ACTION:

Command
Button

Press <TAB> to move to the button, then press the <SPACEBAR>
or <ENTER>. If the button has an underscored letter, press and
hold the <ALT> key while typing the underscored letter.

Option Button Press <TAB> to move to the group of options, and then use the
arrow keys to select the appropriate option button. If the option
has an underscored letter, press and hold the <ALT> key while
typing the underscored letter.

Checkbox Press <TAB> to move to the checkbox, and then press the
<SPACEBAR> to select or clear the checkbox. If the checkbox
has an underscored letter, press and hold the <ALT> key while
typing the underscored letter.

Text Box Press <TAB> to move to the text box, then enter or delete text
as appropriate. Use the arrow keys to move between characters
in the box. To select text, place the cursor by the first character
to be selected and press and hold the <SHIFT> key while
pressing the appropriate arrow key.

List Box Press <TAB> to move to the list box, then use the up or down
arrow key to scroll to the item to be selected. Or, type the first
letter of the item to be selected; the first item that starts with
that letter is selected.

Drop-down List
Box

Press <TAB> to move to the list box, then press <Alt> + the
down arrow key to open the drop down list. Use the up or down
arrow key to scroll to the item to be selected. Press <Alt> + the
up arrow or the down arrow to select it.

USING A POINTING DEVICE WITH THE ADMINISTRATOR
The Administrator was designed for easy use with a pointing device. The following
table lists terms used in this manual that refer to use of a mouse as a pointing device.
If your pointing device is not a mouse, or if you have configured your mouse for use
with the left hand, you may need to reinterpret procedures that use these terms.

Table 8: Pointing Device Conventions

TERM: DESCRIPTION:

Point Move the pointer to an item.

Click Point to an item. Quickly press and release the left mouse button
to select an object.
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TERM: DESCRIPTION:

Double-click Point to an item. Quickly press and release the left mouse button
twice to activate a function.

Right-click Point to an item. Quickly press and release the right mouse
button to select an object.

Drag Point to an item. Press and hold the left mouse button down.
Move the pointer to the target location and release the button.

For most items (such as a node in the tree), when selected with the right mouse
button, a shortcut menu appears, consisting of the same commands found in the Edit
menu. This feature provides a quick and easy method of performing many DX
actions.

Shortcut Menus
For most items in the Tree and Contents views of the Administrator, you can access
a shortcut menu by right-clicking on the item. You can then use either mouse button
to select commonly used functions from the shortcut menu that appears.

Drag and Drop
You can drag any item in the Tree or Contents view to the Delete toolbar button to
delete it. You can also drag and drop media to a media folder or move group from
the Original Media list to add it, or drag media from the media folder or move group
to remove it.

Toolbar
The toolbar contains buttons that provide quick access to many of the Administrator
commands and features. To identify the function of a button, point to the button with
the mouse. The button’s function appears in the status bar at the bottom of the
window.

To show or hide the toolbar:
� From the DX Administrator’s View menu, select Toolbar. A checkmark beside

the command indicates that the toolbar is displayed.

Figure 3: DX Administrator Toolbar
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Table 9: DX Administrator Toolbar Buttons

BUTTON: NAME: MENU OPTION: FUNCTION:

 Connect From the Service
menu, select Connect

Connects to the selected
DX computer.

Disconnect From the Service
menu, select
Disconnect

Disconnects from the
currently active DX
computer.

Service
Manager

From the Tools menu,
select Service Manager

Opens Service Manager.

Register
Computer

From the Service
menu, select Register

Displays the Register
Computers dialog box,
which allows you to register
DX computers.

Configure
Media
Services

From the Service
menu, select Configure
Media Services

Opens the Configure Media
Services dialog box, which
allows you to add, delete
and configure media
services.

New
Extended
Drive

From the Service
menu, select New
Extended Drive

Opens the New Extended
Drive Wizard, which allows
you to create an extended
drive.

New Object From the Edit menu,
select New

Displays a dialog box that
allows you to create a new
object. The dialog box that
appears is determined by
the current selection.

Delete
Object

From the Edit menu,
select Delete

Deletes or removes the
selected object.

Rename
Object

From the Edit menu,
select Rename

Allows you to rename the
selected object.

Object
Properties

From the Edit menu,
select Properties

Displays the Properties
dialog box for the selected
object.
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REFRESHING THE ADMINISTRATOR WINDOW

Refreshing updates the contents of the display window and repaints everything in the
window. The Administrator window is refreshed when each of the following occurs:

� After each command is performed.

� Each time a node in the tree is expanded or collapsed.

� When you press <F5>. (This is considered a forced refresh.)

� When the time specified for automatic refresh frequency has expired.

CONFIGURING AUTO REFRESH FREQUENCY
You can configure the frequency of the automatic refresh of the Administrator. The
default refresh rate is 5 seconds.

To enable or disable auto refresh:
� From the Tree menu, select Auto Refresh.

To change the auto refresh frequency:
1 From the Tree menu, select Auto Refresh Frequency. The Auto Refresh

Frequency dialog box appears.

Figure 4: Auto Refresh Frequency Dialog Box

2 In the Frequency text box, enter the appropriate number of seconds between
refreshes.

3 Click OK.

EXTENDED DRIVES

The DX Administrator tree view displays all current DX extended drives for the
connected DX computer(s). Under each extended drive, the available media and the
media folders created for the extended drive are listed. Under each media folder
appears the move groups, and move, purge, and delete rules for the media folder.
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MEDIA FOLDERS
Extended drives contain media folders to logically group the media. Media folders
provide a virtual directory structure for media. The media folder is a virtual directory
that defines a point in the directory tree (from the root of the extended drive) where
the media’s files are located. In order to be used by DX, media must be assigned to a
media folder.

Under each extended drive, a node appears for each media folder created for that
drive. Under each media folder is a Media node listing all media assigned to that
folder. Media folders and their media are listed in alphabetical order. A folder icon
represents each folder and a media icon represents each piece of media.

MOVE GROUPS
A move group is a subset of the media in a media folder. When you configure file
migration, you select target media for each move group and a target move group for
each move rule. Selecting a move group specifies that only media in that move group
will be used to store files moved under that rule. At least one move group must exist
in order to create move rules. This being the case, DX allows you to create Move
Groups at the same time you create Move Rules if necessary.

In the tree view, move groups are listed under the Move Groups node underneath
each media folder.

MOVE RULES
Move rules regulate the movement of files to media. When a move rule is created,
you specify which files should be moved and which target Move Group of media
will be used to store them. You can either select an existing Move Group or you can
create one at the time you create the Move Rule. At least one move rule must be
configured in order for files to be moved to media.

Move rules are created from and listed in the Move Rules node, underneath each
media folder.

PURGE RULES
Purge rules regulate the reclamation of file space on the extended drive. When a
purge rule is created, you specify which moved files should be purged from the
extended drive and when. Purging files reclaims file space on the extended drive.
You have two options with respect to purging files. You can enable the Purge with
move option in your move rule(s), or you can create separate Purge Rules for each
media folder.

Purge rules are created from and listed in the Purge Rules node, underneath each
media folder.
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DELETE RULES
Delete rules can be added to permanently delete files from the extended drive and
from media. A delete rule defines a specific folder, file type, and file age. Delete
rules are carried out during an extended drive scan, at which time all files matching
the configured delete rules are automatically and permanently deleted from the
extended drive and from the storage media containing those files.

Delete rules are created from and listed in the Delete Rules node underneath each
media folder.

NOTE ����
Once files are deleted using a Delete rule, DX can no longer access those files.
Whether the files are physically deleted on the media is determined by the properties
of the media itself (optical rewritable, tape, DVD-RAM).

AVAILABLE MEDIA
The Available Media node contains all media allocated for the extended drive not yet
assigned to a media folder. Media is grouped by type into seven nodes in the
Available Media tree: Original, Copy, Duplicate, Blank, Foreign, Unknown and
Unformatted Media.

Original Media
All media that have been prepared for use by an extended drive but are not currently
assigned to a media folder appear in the Original Media node. In order for a piece of
media to appear in this list, the media must be all of the following:

� Formatted for the file system for which the hardware device is configured

� Labeled

� Not currently assigned to a media folder

Media appearing in this list is ready to be assigned to a media folder when necessary.
In addition, Original media can be reformatted, deleted (if offline), or renamed, and
its media properties viewed.

Copy Media
Copy media are media that are identical copies of other media in the DX system. The
only difference between an original piece of media and its copy is the serial number
for each piece of media. If an original piece of media becomes unreadable, the copy
of the media can be promoted to an original piece of media once the damaged
original is removed from the DX system.
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Duplicate Media
Duplicate media is any media with the same serial number as another piece of media
in the DX system. Duplicate media is unusable with DX and must be reformatted in
order to have another serial number assigned to it.

Blank Media
Blank media is media that has been formatted for use with DISKXTENDER but not
labeled. Blank media can be labeled, reformatted, deleted (if offline), or renamed,
and its media properties viewed.

Foreign Media
Any media that has been formatted for a file system other than that of its current
device, or media unsupported by DISKXTENDER is considered by DX to be “foreign”
media and is placed in the Foreign node. Media in this list can be formatted (if the
media is of a type that DX supports), and its media properties viewed.

Unknown Media
Media that is either an unsupported media type or media that has been formatted
with a file system not recognized by DX will be placed in the Unknown media node.
Unknown media is unusable with DX, and DX will not allow any commands to be
performed on this media.

Unformatted Media
All unformatted media are listed under the Unformatted media node. Media in this
list can be formatted, and its media properties viewed.

SEARCHING IN THE ADMINISTRATOR

As multiple components (extended drives, media folders, media) and multiple DX
computers (for remote administration) are added to the system, the extended drives
tree may become so large as to become difficult to locate a specific node of the tree.
The Find command in the Tree menu can be used to quickly locate occurrences of
text within the extended drives tree. This can be especially useful for finding a
specific media folder or pieces of media.

The Administrator searches from the currently highlighted position in the tree to
either the end or to the beginning of the tree, depending on the direction you choose.
To search the entire tree, select an item either at the top or bottom of the tree before
beginning the search and select the Up or Down direction as appropriate.
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To search for specific text in the tree:
1 From the Tree menu, select Find. The Find dialog box appears.

Figure 5: Find Dialog Box

2 In the Find What text box, type the text to be found.

3 Click the Up or Down option button to search up or down in the tree from the
currently highlighted position.

4 Click the Match Case checkbox to find only words having a certain pattern of
uppercase and lowercase letters. For example, select this option to find
“MEDIA” but not “media.”

5 Click Find Next. The first occurrence of the text is highlighted in the tree. If the
tree is not visible, move the Find dialog box by dragging its title bar.

6 To find the next occurrence, click Find Next again.

NOTE ����
After you close Find dialog box, you can select Find Next from the Tree menu (or
press F3) to find the next occurrence of the most recently specified text.

REMOTE ADMINISTRATION

DISKXTENDER (DX) allows you to administer the DX system both from the
computer on which DX is installed and from remote computers. You can use the
Administrator function that comes with a full installation of DISKXTENDER to
administer other DX computers, or you can install the Remote Administrator, which
simply provides you with the Administrator interface and the registration capability
to attach remotely to any networked DX computer.

The remote administration function is the same whether you use a DX Administrator
(full installation) or a Remote Administrator. Regardless of which Administrator
function you have installed, you have to register the remote DX computer in order to
allow the Administrator you are running to find and connect to the remote DX
computer.

REGISTERING A DX COMPUTER
You can remotely administer one or more DX computer(s) both from the
Administrator function installed with a full installation of DISKXTENDER and by
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using the Remote Administrator. The Register command available through the
Service menu of the Administrator allows you to access other DX computers by
connecting through the network.

If access to a DISKXTENDER computer on the network is necessary, you must register
the DX computer to add the DX computer’s name to the Computer drop-down list
and to the tree view of the Administrator. Only computers where DISKXTENDER is
currently installed can be registered.

Registering DX computers can be done either using the Auto-Detect function, or by
adding each DX computer manually. For procedures, see the Registering a DX
Computer using Auto Detect section below or the Registering a DX Computer
manually section on page 39.

NOTE ����
If you need to register a DISKXTENDER service that is installed on a clustered
environment, be sure to select the logical cluster name for registration.

Registering a DX Computer using Auto Detect
For large systems with several DX computers, the normal registration process
becomes unwieldy, since you must browse and select each computer on the network.
The Auto-Detect feature lets you detect and select all currently running DX services
on the network without browsing the system to find individual DX computers.

The Auto-Detect function works as a wizard that leads you through the registration
process.

To start the Auto-Detect Wizard:
1 In the Administrator, select the Register option from the Service menu or click

the icon on the toolbar.

Figure 6: Register Computer Icon

The Register Computers dialog box appears.
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Figure 7: Register Computers Dialog Box

NOTE����
All computers already registered with the currently open Administrator appear
in the Register Computers dialog box, to include the local computer. If you are
registering through a Remote Administrator, and you have not yet registered any
DX computers, the Register Computers dialog box is blank.

2 Click Detect to start the Auto-Detect wizard. The Introduction page appears.

Figure 8: Introduction Page

3 Read the Introduction and click Next. The Computer List page appears.
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Figure 9: Computer List Page

The Computer List page lists all detected computers on which DX is installed
and where the DX service is actively running (stopped services or powered-off
computers will not be detected).

4 Select the computers you want to register and click Next. To select two or more
computers in sequence, select the first computer, then press and hold the
<SHIFT> key while selecting the last item. To select two or more computers out
of sequence, press and hold the <CTRL> key while selecting computers.

NOTE ����
If a computer that you want to register does not appear in the Computers
Detected list, you will have to register the computer manually. See Registering a
DX Computer manually on page 39.

5 Click Next. The Summary page appears.
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Figure 10: Summary Page

6 The Summary page lists the selected computers. Review the list to make sure the
computers you want to register are listed. Click Back to return to the Computer
List page, if necessary.

7 If the information in the summary is correct, click Finish. The selected
computers are registered and now appear in the Computer List in the Register
Computers dialog box.

Figure 11: Register Computers Dialog Box

8 If you inadvertently list a computer you do not want to register, or you wish to
delete a previously registered computer, select that computer and click Delete.
The computer is removed from the list.
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9 Once the appropriate computers appear in the Register Computers dialog box,
click Close. The Administrator attempts to connect to all registered DX
computers. All registered computer name(s) now appear in the Computer drop-
down list located directly beneath the main menu in the administrator, and in the
tree view of the administrator window.

The Administrator can now be used to administer the DISKXTENDER service on the
registered DX computer(s). You can switch between registered computers by
selecting different computer names from the Computer drop-down list or by clicking
on and highlighting the computers in the tree view of the Administrator.

Registering a DX Computer manually
To manually register a DX computer:
1 In the Administrator, select the Register option from the Service menu or click

the icon on the toolbar.

Figure 12: Register Computer Icon

The Register Computers dialog box appears.

Figure 13: Register Computers Dialog Box

NOTE����
All computers already registered with the currently open Administrator appear
in the Register Computers dialog box, to include the local computer. If you are
registering through a Remote Administrator, and you have not yet registered any
DX computers, the Register Computers dialog box is blank.
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2 Click Add to register a new DX computer. The Select Computer dialog box
appears.

Figure 14: Select Computer Dialog Box

The Select Computer dialog box allows you to select any visible network
computer. To successfully register, the selected computer must have
DISKXTENDER installed.

3 Select the computer you want and click OK (or double-click the computer). You
are returned to the Register Computer dialog box and the computer you selected
appears in the computer list.

Figure 15: Register Computers Dialog Box

4 Repeat this process for every computer you wish to manually register as a
DISKXTENDER computer for remote administration.
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5 If you inadvertently list a computer you do not want to register, or you wish to
delete a previously registered computer, select that computer and click Delete.
The computer is removed from the list.

6 Once the appropriate computers appear in the Register Computers dialog box,
click Close. The Administrator attempts to connect to all registered DX
computers. All registered computer name(s) now appear in the Computer drop-
down list located directly beneath the main menu in the administrator, and in the
tree view of the administrator window.

The Administrator can now be used to administer the DISKXTENDER service on the
registered DX computer(s). You can switch between registered computers by
selecting different computer names from the Computer drop-down list or by clicking
on and highlighting the computers in the tree view of the Administrator.

CONNECTING TO DX COMPUTERS

When the Administrator is opened, it attempts to connect to all registered DX
computers (to include the local computer for full installations of DX). Once these
connections have been made, the window displays information pertaining to each
DX service. The Administrator allows you to switch easily between registered DX
computers by clicking on and highlighting the computers in the tree view, or by
selecting different computers from the Computer drop-down list.

Figure 16: Computer Drop-Down List

Remember, in order to successfully connect to a DX computer, you must have
administrator rights on the selected DX computer.

DISCONNECTING THE ACTIVE SERVER
You may wish to disconnect from the currently active DX computer. Disconnecting
from the active service removes that computer’s DX components from the tree view,
though the computer will still appear, listed with a status of (Disconnected).
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To disconnect from the active DX computer:
� Highlight the computer from which you want to disconnect, and click the

Disconnect toolbar button or select Disconnect from the Service menu.

Figure 17: Disconnect Computer Toolbar Button

RECONNECTING THE ACTIVE SERVER
Once disconnected from a DX computer, the computer name will still appear in the
tree view, but with the status of (Disconnected). You can reconnect to any of
the registered DX computers at any time.

To reconnect to a DX computer:
� Highlight the computer to which you want to connect, and click the Connect

toolbar button or select Connect from the Service menu.

Figure 18: Connect Computer Toolbar Button
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EXTENDED DRIVE ADMINISTRATION

Administering your extended drive involves management of the files saved on the
extended drive, and of the extended drive itself. Much of the administration of the
extended drive can be done through configuration of the extended drive properties
and proper setup of certain schedulable events.

As the DX administrator, you will want to become very familiar with the properties
and options for the extended drives. Understanding how these functions work, and
more importantly, how they work together, will allow you to configure DX in a way
that will make management of the system simple, and make DX more efficient.

Since the extended drive is one of the most critical components of the DX system,
this guide has devoted this entire chapter to explaining the extended drive functions
and options available to you. In this chapter, you will find detailed information on
extended drive schedules for drive scans, media activity schedules and extended
drive backups. You will also find discussions about the available options for each
extended drive, and procedures for how to access these extended drive properties.

THE EXTENDED DRIVES TREE

The Tree View in the Administrator displays all current extended drives for the
registered DX computer(s), the available media pool for each extended drive, and all
media folders configured for each extended drive. In addition, associated media,
move groups, move rules, purge rules, and delete rules appear below each media
folder for which they have been configured.
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Figure 19: Extended Drives Tree

EXTENDED DRIVE COMMANDS

The commands available to assist you with administering your extended drive are
available in two places from the interface: the Edit menu and the shortcut menu. The
commands available through both are identical when the extended drive is selected
in the tree view (see Figure 19 above).

To access the extended drive commands:
� You have two choices:

� Select the extended drive in the tree view and click Edit from the main
menu.

� Right-click on the extended drive in the tree view.

Figure 20: Extended Drive Commands

The commands available for your extended drive appear. Briefly defined, these
commands are:
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Table 10: Extended Drive Edit/Shortcut Menu Commands

COMMAND: FUNCTION: FOR MORE
INFORMATION, SEE:

Force Drive
Scan

Forces an immediate scan of the
extended drive. Drive scans write files to
move and purge lists, and remove files
from media folders when the
corresponding media is removed from
the folder.

Forcing Drive Scans
on page 46.

Add Media to
Media
Folders

Starts the wizard that allows you to add
one or more pieces of Original
(unassigned) media to a media folder.

Setting Up File
Migration chapter of
the DX2000 Data
Management Guide.

Remove
Media from
Media
Folders

Starts the wizard that allows you to
remove one or more pieces of media
(and their corresponding files) from a
media folder.

Removing Media
from Media Folders
on page 221.

Force Backup Forces an extended drive backup
whenever needed.

Forcing an Extended
Drive Backup on
page 172.

Abort Backup Stops an extended drive backup after
one has started.

Stopping an Extended
Drive Backup in
Progress on page
173.

Restore
Backup

Allows you to restore backed up files. Restoring Extended
Drive from Backup
on page 184.

Create Media
Folder

Starts the wizard that creates a media
folder (or turns an existing folder into a
DX media folder) on the currently
selected extended drive.

Setting Up File
Migration chapter of
the DX2000 Data
Management Guide.

Delete Media
Folder

Starts the wizard that allows you to
delete one or more media folders from
the currently selected extended drive.

Deleting Media
Folders on page 224.

Delete
Extended
Drive

Deletes the currently selected extended
drive and all of that drive’s associated
components.

Deleting Extended
Drives on page 225.

Properties Opens the extended drive Properties
box, through which you can set up
schedules and configure extended drive
options.

Extended Drive
Properties on page
47.

This chapter deals specifically with administration and maintenance of the extended
drive using drive scans, both forced and scheduled, setting up of other schedulable
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extended drive events, and viewing and configuring the extended drive properties
and options.

FORCING DRIVE SCANS

Drive scans must be performed periodically in order to write files to the move and
purge lists, and consequently to move the files to storage media and to purge the data
from the extended drive. During a drive scan, DX inventories all of the files on an
extended drive and checks each file against the migration rules for the drive, adding
eligible files to the move and purge lists.

WARNING ����
File-sharing issues or sharing violations can prevent files from being added to the
move list when appropriate. DX must have full access to a file in order to obtain
information required for the move list. If the file is open or is otherwise being
accessed by a program or user, DX cannot add it to the move list.

Drive scans are also necessary when removing a piece of media from a media folder,
in order to completely remove that media’s files from the folder on the extended
drive. Normally DX will prompt you to run a drive scan at that time, but if necessary
you can wait until a later time to force the drive scan needed to remove those files, or
wait until the next scheduled drive scan.

Drive scans can be forced or scheduled. Until you set up a drive scan schedule for
the extended drives, automatic (scheduled) drive scans are disabled. However, you
can force an extended drive scan whenever needed.

If you are planning any DX system maintenance, forcing an extended drive scan, in
conjunction with activating your Move files to media schedule, is an excellent way
to be sure all appropriate files are written to media before the maintenance is done.

To force a drive scan on the extended drive:
� You have two options:

� Select the extended drive in the tree view and select Force Drive Scan from
the Edit menu.

� Right-click on the extended drive and select Force Drive Scan from the
shortcut menu.

A drive scan is run on the extended drive and the appropriate files are marked for
move or purge or are deleted as necessary.

For details on scheduled drive scans, see Extended Drive Settings - Drive Scan
Option on page 53.
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EXTENDED DRIVE PROPERTIES

Much of your extended drive administration can be taken care of automatically with
proper setup and configuration of the available extended drive properties. The
options available within the Extended Drive Properties dialog box allow you to do
everything from setting up media activity schedules and drive scan schedules, to
having the system inform you when extended drive space gets low and setting up a
percentage full watermark for when to purge files.

When you open the Extended Drive Properties dialog box, you will see four tabs:
General, Settings, Options and Statistics.

To open the extended drive properties dialog box:
� You have two choices:

� Select the extended drive and select Properties from the Edit menu.

� Right-click on the extended drive and select Properties from the shortcut
menu.

The Extended Drive Properties dialog box appears.

Figure 21: Extended Drive Properties Dialog Box

The information and configuration possibilities available on each of these tabs are
discussed in detail in the sections that follow.

� For information on the General tab, see The General Tab on page 48.

� For information on the Settings tab, see The Settings Tab on page 50.

� For information on the Options tab, see The Options Tab on page 61.

� For information on the Statistics tab, see The Statistics Tab on page 72.
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THE GENERAL TAB
When opening the Extended Drive Properties dialog box, the General tab appears by
default. The General tab displays identifying information for the drive, as well as
extended drive total space and free space information.

NOTE ����
The information shown in the General tab is a summary of the information shown in
the description view of the administrator when the extended drive is selected.

To view the general tab of the extended drive properties:
� With the Extended Drive Properties dialog box open, click the General tab.

Figure 22: Extended Drive Properties: General Tab

The information on the tab is separated into two sections: Drive Information and
Size Information. The following table describes each of the items appearing on
the General tab:

Table 11: Extended Drive Properties: General Tab Items

GROUP: ITEM: DESCRIPTION:

Drive
Information:

Computer Name: The name of the DX computer
where the extended drive is located.

Drive Letter: The drive letter of the extended
NTFS volume (extended drive).

Volume Name: The volume name of the extended
NTFS volume (extended drive).
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GROUP: ITEM: DESCRIPTION:

Serial Number: The serial number of the physical
hard drive on which the extended
NTFS volume is located.

Physical Name: The physical name of the hard drive
on which the extended NTFS
volume is located.

Drive Space: The percentage of drive space used
on the physical hard drive on which
the extended NTFS volume is
located.

Status: The status (online or offline) of the
extended drive.

Size
Information:

Sector Size: The size of each sector on the
extended drive.

Total Physical
Capacity:

The total physical space available on
the extended drive.

Total Logical
Capacity:

The total usable space available on
the extended drive.

Drive Free Space: The total free space available on the
extended drive.
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THE SETTINGS TAB
The Settings tab provides access to the scheduling functions for drive scans and
media activities.

To view the settings tab of the extended drive properties:
� With the Extended Drive Properties dialog box open, click the Settings tab.

Figure 23: Extended Drive Properties: Settings Tab

The Settings tab provides access to three extended drive settings: the media activity
schedule, the drive scan schedule and the extended drive backup schedule. Clicking
the appropriate button on the Settings tab opens the applicable scheduling function.

After configuring the Schedule, Drive Scan and Backup settings, you have three
options:

� Click OK to save your changes and close the Extended Drive Properties dialog
box.

� Click Apply to save your changes without closing the Extended Drive Properties
dialog box.

� Click Cancel to discard all changes and close the Extended Drive Properties
dialog box.
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Extended Drive Settings - Schedule option
A media activity is defined as any activity for which media must be mounted in a
drive. When a client accesses a file, a fetch or file retrieval request is sent, which is a
media activity that takes place immediately upon request. Scheduling other less
urgent media activities during inactive times ensures that those activities do not
compete with network clients or media devices for system drive or library resources.

There are four storage media activities that can be scheduled for each extended drive.
Those activities are:

� Move files to media

� Process scheduled media tasks

� Update copy media

� Allow fetches from media

The extended drive scheduler allows any or all of these four media activities to be
scheduled for a time range (e.g., 2am-4am). This range provides a “window of
opportunity” for the activity(s) to occur. Any time within this range that an activity
can begin, it will. If for any reason the activity does not begin during this time, it will
not be performed until the next time the schedule is active.

The activity scheduler exists as a property of each extended drive, and is accessed
through the Settings tab of the Extended Drive Properties dialog box. These
schedules are specific to and must be configured separately for each extended drive.

Figure 24: Extended Drive Schedule Dialog Box

Within the scheduler, colored lines represent each activity, allowing you to quickly
see which activities are schedule for when. When the scheduler first appears, three of
the four available activities are scheduled to occur from 8 p.m. to 9 a.m. every day of
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the week. The Allow fetches from media activity is scheduled to occur 24 hours a
day, 7 days a week (always active). These are the defaults for each DX extended
drive, and these schedules will remain set this way until changed.

The schedule grid contains columns for each hour of the day and rows for each day
of the week, creating cells which each represent one hour. For example, the blacked
out cell in Figure 24 above represents 5 p.m. to 6 p.m. on Sunday. DISKXTENDER’S
scheduler allows you to set scheduled activities by selecting one or many cells in the
grid and by selecting one or more activities for those time period cells. You can
easily schedule all activities for a large block of time, or you can schedule specific
activities for smaller blocks of time.

When you select an area in the schedule grid and click the Set button, any activities
checked will be scheduled for that time period. Any activities not checked will be
cleared for the selected area, even if they were already scheduled for some or all of
the time blocks.

NOTE ����
Any time that the Allow fetches from media schedule is not active, client requests for
purged files will not be honored (to include direct reads). By changing the schedule
for this activity, you may accidentally prevent clients from having access to purged
files. We recommend that you leave the default setting for fetches (always active) in
place, unless your organization requires a time-based restriction of access to purged
files. If there is a time-based restriction, enabling deferred fetch requests will allow
clients access to files when the Allow fetches from media schedule becomes active
again. See Defer fetch request if fetch is disabled: on page 70 for more information.

To set up a media activity schedule:
1 From the Settings tab in the Extended Drive Properties dialog box, click

Schedule. The Schedule dialog box appears.

2 To change schedule settings, select the area of the grid that corresponds to the
time period during which you would like to schedule or clear an activity.

� To set an activity for the selected blocks, check the appropriate option(s) in
the Activities section of the Schedule dialog box.

� To clear an activity for all selected blocks, uncheck the appropriate
option(s) in the Activities section of the Schedule dialog box.

Use the buttons described in the following table to make and save changes as
needed.

Table 12: Schedule Properties Dialog Box: Set/Clear Buttons

BUTTON: ACTION:

Sets the activities that are checked and clears the activities that
are not checked in the highlighted area of the schedule grid.

Clears all scheduled activities in the highlighted area of the
schedule grid, regardless of which options are checked in the
Activities section.
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3 After making changes, review the activity schedule carefully to make sure that in
setting a schedule for one activity you have not accidentally cleared scheduled
times for another activity.

4 When your changes to the activity schedule are complete, you have the
following choices:

� To save changes and close the Schedule dialog box, click OK.

� To discard all changes made since the Schedule dialog box was opened and
close the Schedule dialog box, click Cancel.

NOTE ����
You must save changes to the schedule using the Set and Clear buttons before
selecting OK or Apply. Making changes and selecting OK without using the Set or
Clear buttons will close the dialog box without saving your changes.

Extended Drive Settings - Drive Scan Option
The primary purpose of drive scans is to write files that qualify for move and purge
rules with an age-delay to the move and purge lists. Files will not be moved or
purged unless they are listed on the move list or purge list respectively. During a
drive scan, DX inventories all of the files on an extended drive and checks each file
against the migration rules for the drive, adding eligible files to the move and purge
lists as appropriate.

If you configure any move rules or purge rules to have age-delays, you must perform
regular extended drive scans to update the move and purge lists. If any of your move
and purge rules use a file age exception to delay move and/or purge of files, you
should set a regular drive scan schedule to make sure that all appropriate files are
written to the move and purge lists. Files that qualify against move rules with no age
delay are typically written to the move list as soon as they are saved to the extended
drive.

WARNING ����
File-sharing issues or sharing violations can prevent files from being immediately
added to the move list when appropriate. DX must have full access to a file in order
to obtain the information required for the move list. If the file is open or is otherwise
being accessed by a program or user, DX cannot add it to the move list.

Because files may not be added to the move list due to file-sharing issues, regular
drive scans are required to be sure that all appropriate files are written to the move
list when they qualify, and as such, are being written out to storage media (in
coordination with your Move files to media schedule). DX allows you to set a
regular schedule for drive scans. Because drive scans for very large extended drives
can be time consuming, and to make sure files due to be added to the move list are
not currently being accessed, you may want to schedule your drive scans to occur
during times of low extended drive and system traffic.

Drive scans can also be forced whenever needed. For details on forcing drive scans,
see Forcing Drive Scans on page 46.
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Drive scan scheduling is managed at the extended drive level, using the Drive Scan
button on the Settings tab in the properties for each extended drive. Until you set up
a drive scan schedule for the extended drives, automatic drive scans are disabled.

To access the drive scan scheduler:
� From the Settings tab in the Extended Drive Properties dialog box, click Drive

Scan. The Drive Scan dialog box appears.

Figure 25: Drive Scan Dialog Box

The Drive Scan dialog box allows you to schedule drive scans as frequently as is
appropriate for your system needs. Drive scans can be scheduled to occur once,
hourly, daily, weekly, or monthly. You can also disable automatic drive scans.
When each different Drive Scan scheduling option is selected, the appropriate
configuration boxes appear on the right side of the Drive Scan dialog box.
Details on configuring each scheduling option appear below.

To perform a one-time drive scan:
1 Click Once on the Drive Scan dialog box. The Date and Time spin-boxes

appear.

Figure 26:One-time Drive Scan Options

2 In the Date spin-box, specify the date you want the drive scan to occur.
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3 In the Time spin-box, specify the time you want the drive scan to occur.

4 Click OK.

NOTE ����
The default values for the Date and Time spin boxes are today’s date and 12:00AM
respectively. Because it is likely this default time occurs in the past, the drive scan
will not run unless you change the defaults to a date and/or time in the future.

NOTE ����
After a one-time Drive Scan is processed, the Drive Scan schedule is disabled,
meaning drive scans will not occur again unless forced or scheduled.

To configure the drive scan to occur on an hourly basis:
1 Click Hourly on the Drive Scan dialog box. The Perform Scan Every ____

Hour(s) text box and Time spin-box appear.

Figure 27: Hourly Drive Scan Options

2 In the Perform Scan Every ____ Hour(s) text box, specify the hourly rate at
which you want the drive scans to occur. You can enter a number from 1 to 24.

3 In the Time spin-box, specify the time you want the first drive scan to occur.

4 Click OK.
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To configure the drive scan to occur on a daily basis:
1 Click Daily on the Drive Scan dialog box. The Perform Scan Every ____ Day(s)

text box and Time spin-box appears.

Figure 28: Daily Drive Scan Options

2 In the Perform Scan Every ____ Day(s) text box, specify the daily rate for the
drive scans. You can enter a number anywhere from 1 to 365.

3 In the Time spin-box, specify the time when you want the drive scans to occur.

NOTE ����
File-sharing violations will prohibit DX from being able to write eligible files to
the move list. For this reason, choose a time for your daily drive scans when it is
least likely that clients will be accessing files from the extended drive.

4 Click OK.

To configure the drive scan to occur on a weekly basis:
1 Click Weekly on the Drive Scan dialog box. The Perform Scan Every ____

Week(s) text box, the Time spin-box, and checkboxes for the days of the week
appear.

Figure 29: Weekly Drive Scan Options



Chapter Three: Extended Drive Administration

Application Storage Manager System Guide 57

2 In the Perform Scan Every ____ Week(s) text box, specify the weekly rate for
the drive scans. You can enter a number anywhere from 1 to 52.

3 In the Time spin-box, specify the time you want the drive scans to occur.

NOTE ����
File-sharing violations will prohibit DX from being able to write eligible files to
the move list. For this reason, choose a time for your weekly drive scans when it
is least likely that clients will be accessing files from the extended drive.

4 Under Select Day(s) of Week, specify which day(s) of the week you want the
drive scans to occur.

5 Click OK.

To configure the drive scan to occur on a monthly basis:
1 Click Monthly on the Drive Scan dialog box. The Perform Scan Every ____

Month(s) text box, the Time spin box, and the Day of Month drop-down list box
appear.

Figure 30: Monthly Drive Scan Options

2 In the Perform Scan Every ____ Month(s) text box, specify the monthly rate for
the drive scans. You can enter a number from 1 to 12.

3 In the Time spin-box, specify the time you want the drive scans to occur.

NOTE ����
File-sharing violations will prohibit DX from being able to write eligible files to
the move list. For this reason, choose a time for your monthly drive scans when
it is least likely that clients will be accessing files from the extended drive.

4 In the Day of Month drop-down list box, specify the date for the drive scans to
occur.

5 Click OK.
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To disable automatic drive scans for this drive:
1 Click Disable on the Drive Scan dialog box.

Figure 31: Disable Drive Scan Option

2 Click OK.

Extended drive scans are disabled by default.

WARNING ����
Disabling drive scans can result in files not being migrated to media when
appropriate. Drive scans ensure proper synchronization of DX files by writing files
that qualify for age-delayed move rules to the move list, along with files that may
have had a sharing violation when DX initially attempted to access the file. For this
reason, you should not disable drive scans unless absolutely necessary, and if you do,
to do so for only limited periods of time.
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Extended Drive Settings - Backup option
Extended drive backups should be performed periodically in order to back up
DISKXTENDER managed files and file tags. While you may be using a system backup
program, these programs can often be limited when it comes to backing up all of the
data necessary to restore your DISKXTENDER files in the event of a system problem
or disaster. Standard backup programs most often either do not back up the attributes
pointing to file locations on media, or they cause every purged file on the drive to be
retrieved, making backups far too time-consuming and sometimes incomplete due to
time-constraints.

However, DX contains an Extended Drive Backup utility that is specifically
engineered to allow you to reliably back up all of the data on your extended drives
while you are using DX. During an extended drive backup, DX inventories all of the
files on an extended drive and sees that the appropriate information (file data for non
DX-managed files, file metadata for DX-managed files, to include file tags) is saved.
DX then creates a data set file containing all of the information obtained from the
inventory. The Extended Drive Backup utility allows you to set a network path for
the backup data set file, set your backup schedule, and choose to run both
incremental and/or full backups. You can then back up that file to another location
using a standard backup program.

A full DX backup creates a backup file containing needed information for all files on
the extended drive. Incremental backups are generally used in between scheduled
full backups to capture files not previously backed up by DX. Incremental backups
update the information in the file created by the full backup. Incremental backups
take significantly less time than full backups, and for this reason can be scheduled
more frequently.

Extended drive backup scheduling is managed at the extended drive level, using the
Backup button on the Settings tab in the properties for each extended drive. Until
you set up a backup schedule for the extended drives, automatic backups are
disabled.
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Figure 32: Extended Drive Backup Dialog Box

The Backup dialog box contains three sections. The top section allows you to type in
or browse to the folder in which you want your backup files saved. The second
section is a Scheduling section that allows you to select a regular schedule for
incremental backups. The third section is a Full Backup section that allows you to set
regular schedules for complete DX backups.

Figure 33: Full Backup Frequency Dialog Box

The Full Backup Frequency dialog box is accessed through the Full Backup
Frequency button on the extended drive Backup page. This button is active when the
Perform at scheduled interval option is checked. Full backups can be scheduled to
occur every time the incremental schedule is activated (Always), Once per week on a
specified day, or Once per month on a specified day. Full backups can often be time-
consuming because a full backup will include all files on the extended drive,
regardless of whether or not they are managed by DISKXTENDER.

Because configuration and scheduling of the Extended Drive Backup utility should
be a part of a complete backup and recovery plan, we have placed more details and
specific instructions for this function in the Extended Drive Backup Utility section
beginning on page 163 of the Backup and Recovery chapter.
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THE OPTIONS TAB
The Options tab allows you to view and configure several options affecting extended
drive functionality. We recommend you pay special attention to the functions
available through the Extended Drive Properties Options tab and configure them
appropriately. These options are designed to make administering your extended drive
easier and to help prevent file read/write and space issues.

To view and configure extended drive options:
1 With the Extended Drive Properties dialog box open, click the Options tab.

Figure 34: Extended Drive Properties Dialog Box: Options Tab

The upper section of the Options tab shows a list of extended drive options
available for configuration. The option information in the bottom section of the
Options tab changes to reflect the configuration aspects available for the option
selected in the list in the top section of the Options tab.
Each of these options is discussed in detail below and in the order in which they
appear in this list. Again, we recommend you configure each of these options as
appropriate to your system needs in order to ensure optimal system performance
and data security.

2 After configuring your extended drive options, you have three choices:

� Click OK to save your changes and close the Extended Drive Properties
dialog box.

� Click Apply to save your changes without closing the Extended Drive
Properties dialog box.

� Click Cancel to discard all changes and close the Extended Drive Properties
dialog box.



Chapter Three: Extended Drive Administration

62 Application Storage Manager System Guide

Extended Drive Options
Each of the configurable extended drive options is discussed below. The
configuration options that appear in the lower part of the Options tab correspond to
the option selected in the list in the upper part of the Options tab.

Backup mode for managed files:
Use this option to configure how DISKXTENDER managed files are saved during a
backup using a third-party backup system. Files become “managed” by
DISKXTENDER once they are moved to media. Since the file data is managed by DX
on storage media, you can select to have the backup system only back up the file tag
for those files.

Figure 35: Backup Mode For Managed Files Option

Fast backup – read only DISKXTENDER tracking data: select this option to
backup only the file tags of DISKXTENDER managed files. This is the default.

Full backup – read all file data, including tracking data: select this option to
backup all file tags and the file data of DISKXTENDER managed files.

NOTE ����
This backup setting pertains only to third-party system backups external to
DISKXTENDER and is not related in any way to the Extended Drive Backup Utility.
We still recommend that you use the Backup Utility to back up your DX files.

WARNING ����
If you are using any backup program that does NOT backup extended file attributes,
this setting should be left at Full.  Setting this option for Fast backup may result in
file data not being backed up properly.
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Direct read memory cache (MB):
Use this option to configure the amount of memory space, in megabytes, to be
allocated for direct reads from media. Direct read means that when files are
requested, they are read directly from the media rather than being fetched to the
extended drive first. The file data for direct read files must be fetched to a temporary
cache on the extended drive for distribution to the requesting client. This setting
determines how much extended drive space to allow for that temporary cache.

Figure 36: Direct Read Memory Cache (MB) Option

In the text box enter the maximum number of megabytes to use for caching direct
read files upon client request. Cache size can be determined by considering the
number of files that may be retrieved at any time and the typical sizes of those files.
The default is 1MB.

Disable file size fixup:
Use this option to change the way purged DX files appear in Windows Explorer.
What file fixup does is display the actual file size of all DX files. Disabling file size
fixup will change the display of purged DX files to show a file size of 0 bytes
(because the file data has been moved to media and purged from the extended drive).
All other file attributes remain the same.

Figure 37: Disable File Size Fixup Option
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Disable file size fixup (show purged files as 0 bytes): select this option to show all
files that have been moved to media and purged as 0 byte files.

Show purged file sizes as the actual file size: select this option to show all files that
have been moved to media and purged with the actual file size as it would be if the
file data were present on the extended drive. This is the default.

Disable folder rename check:
Use this option to manage whether or not users can rename folders on the extended
drive. The folder rename check allows only folders containing Window Native file
system media to be renamed. OTG File System formatted media do not support
folder renaming. Disabling the folder rename check allows users to rename DX
folders on the extended drive, regardless of whether the rename is supported by
media or not.

Figure 38: Disable Folder Rename Check Option

Disable rename folder check (allow rename of all folders): select this option to
allow users to rename folders.

Prevent folder renames when not supported by media: select this option to only
allow the renaming of folders that contain Windows Native formatted media, which
supports folder renaming. This is the default.
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Fetch request timeout minutes:
Use this option to configure the number of minutes DX will wait after a fetch request
has been made before canceling the request. This option allows you to reduce
network traffic by stopping requests in cases where the user no longer expects the
file to open because of the amount of elapsed time since the request.

Figure 39: Fetch Request Timeout Minutes Option

Enter the number of minutes before timeout in the text box. You should set this
number to be high enough not to cancel requests for which clients could conceivably
still be waiting. The default is 10 minutes.

Force direct read for all files:
Use this option to add the direct read attribute to all files purged from this extended
drive. Direct read means that when files are requested, they are read directly from the
media rather than being fetched to the extended drive first.

Figure 40: Force Direct Read For All Files Option

Force all files to be read using direct read: select this option to apply the direct
read attribute to all files purged from this extended drive, regardless of whether
individual direct read setting on these files is enabled or disabled.
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Use direct read only for files marked for direct read: select this option to only
apply the direct read attribute to files that have been otherwise configured for direct
read (either through move or purge rules or Explorer Add-ons). This is the default.

Force moves when nothing to purge:
The Force moves when nothing to purge function only activates when the purge
watermark for the extended drive has been reached and there are no files written to
the purge list (eligible to be purged). Since files on the extended drive cannot be
purged until they are moved to media, enabling this option forces processing of the
move list, so that files can be written to the purge list (if appropriate) and purged
from the extended drive. Essentially, this option activates the Move files to media
activity for the extended drive.

Figure 41: Force Moves When Nothing To Purge Option

Force file moves when there is nothing to purge: select this option to force
processing of the move list when the purge list is empty and space still needs to be
cleared on the extended drive to reach the purge stop watermark.

Do not force moves when there is nothing to purge: select this option to cause DX
to stop purging once the purge list is empty, even if space still needs to be cleared on
the extended drive to reach the purge stop watermark. Purging will resume the next
time a file is added to the purge list. This is the default.

NOTE ����
If you are concerned about running out of space and you have configured move rules
with age delays, make sure your drive scan schedule is set to run regular drive scans
in order to add files to the move and purge lists.

Prevent file delete:
Use this option to limit delete rights for files in media folders that contain write-once
only media. This type of media includes WORM and CD media and any media
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formatted with FAT file system. This option will not affect files in media folders
associated with re-writable media.

Figure 42: Prevent File Delete Option

Prevent deletion of files stored on write-once and read-only media (this includes
tape, WORM, and CD media): select this option to prevent clients from deleting
files from DX media folders that contain only write-once media.

Do not prevent the delete operation for any files: select this option to allow clients
to delete any files. This is the default.

NOTE ����
If file deletion is not prevented, deletion of files stored on write-once and read-only
media will delete the files (and/or file tags) from the extended drive, making DX no
longer able to track the files on the media.
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Prevent file modification:
Use this option to restrict user rights to modify files in media folders that contain
only write-once media. This includes WORM and CD media and any media
formatted with the FAT file system. This option will not affect files in media folders
associated with re-writable media.

Figure 43: Prevent File Modification Option

Prevent modification of files stored on write-once and read-only media (this
includes tape, WORM, and CD media): select this option to prevent clients from
modifying files in media folders that contain only write-once media.

Do not prevent modification of any files: select this option to allow clients to
modify any files in DX media folders that contain only write-once media. This is the
default.

NOTE ����
If file modification is not prevented, modification of files stored on read-only media
only modifies the files on the extended drive.
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Purge start watermark (drive percent full):
Use this option to configure the percentage of used drive space that must be
exceeded to cause DX to start processing the purge list. Processing of the purge list
will continue until the purge list is empty or until the purge stop watermark is
reached.

Figure 44: Purge Start Watermark (Drive Percent Full) Option

Enter the percentage of space used on the extended drive that, when exceeded, will
cause DX to start processing the purge list to clear space on the extended drive. The
default is 95% full.

Purge stop watermark (drive percent full):
Use this option to configure the percentage of used drive space that must be reached
to cause DX to stop processing the purge list once processing has been triggered (by
the purge start watermark configuration).

Figure 45: Purge Stop Watermark (Drive Percent Full) Option

Enter the percentage of space used on the extended drive that when reached (after
processing has started) will cause DX to stop processing the purge list. The default is
90% full.
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Warn when free space is getting low (MB):
Use this option to configure whether DX will create a warning when the free space
on the extended drive reaches a (configured) critical point. You may also enter the
number of MB free space that will trigger the warning. Warnings can be sent out as
Alerts using the Alerts tab in the Service Properties.

Figure 46: Warn When Free Space Is Getting Low (MB) Option

Warn when free space falls below ___ MB: select this option to configure
warnings concerning low free space. Specify the amount of free extended drive space
(in MB) that will trigger the warning.

Do not warn when extended drive is low on free space: select this option to
disable low free space warnings. This is the default.

Defer fetch request if fetch is disabled:
If you have set the Allow fetches from media option in the media activity schedule to
be inactive at any time, clients will be unable to retrieve purged files from media
during those times. DX allows you to determine whether those requests for files will
be rejected outright, or queued as deferred fetch requests until the fetch schedule
becomes active again. If you select the Defer fetch requests if fetch is disabled
option, all client file retrievals will be postponed until the Allow fetches from media
schedule becomes active. At that time, all requested (queued) files will be retrieved
from media. Refusing fetch requests is the default.

NOTE����
This option only applies when you have set time-based restrictions to purged files by
disabling the Allow fetches from media schedule in the media activity scheduler.



Chapter Three: Extended Drive Administration

Application Storage Manager System Guide 71

Figure 47: Defer Fetch Request If Fetch Is Disabled

Defer fetch requests if fetch is disabled: select this option to configure DX to
accept but defer all requests for purged files made when the Allow fetches from
media schedule has been disabled. The queued requests will be processed when the
schedule becomes active again.

Refuse fetch requests if fetch is disabled: select this option to configure DX to
reject all requests for purged files made during times when the Allow fetches from
media schedule is inactive.
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THE STATISTICS TAB
The Statistics tab provides statistics on files on the extended drive. These statistics
are based on information collected during the last drive scan.

To view the statistics tab of the extended drive properties:
� With the Extended Drive Properties dialog box open, click the Settings tab.

Figure 48: Extended Drive Properties Dialog Box: Statistics Tab

The following table describes each of the items on the Statistics tab of the
Extended Drive Properties dialog box:

Table 13: Extended Drive Properties: Statistics Tab Items

GROUP: ITEM: DESCRIPTION:

Moved
Files:

Fetched: The number of files fetched between the
most recent drive scan and the drive scan
immediately preceding it.

Purged: The number of files purged between the most
recent drive scan and the drive scan
immediately preceding it.

Total: The sum of the number of files fetched and
the number of files purged between the most
recent drive scan and the drive scan
immediately preceding it.
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GROUP: ITEM: DESCRIPTION:

Pending
Files:

Move: The number of files currently on the move
list for the extended drive.

Purge: The number of files currently on the purge
list for the extended drive.

Last Drive
Scan:

Start Time: The time at which the last drive scan for the
extended drive began.

Duration: The amount of time that the last drive scan
took to process.

Next Scan
Time:

The date and time of the next scheduled drive
scan.

Last
Backup:

Start Time: The time at which the last backup of the
extended drive began.

Duration: The amount of time that the last extended
drive backup took to process.

Next Backup
Time:

The date and time of the next scheduled
extended drive backup.
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CCHHAAPPTTEERR
FFOOUURR

DX COMPUTER ADMINISTRATION

DISKXTENDER contains several functions that allow you to administer, diagnose and
troubleshoot DX. In addition, because the DISKXTENDER program functions as a
Windows NT/2000 service, part of administering the DX computer includes
administering the DX Service. This chapter discusses the available tools for
administering your DX computer through the DX Administrator interface (and
through the Windows Control Panel where applicable).

The Service Properties dialog box lets you view and manage DX computer
configuration. You can view general information about the DX installation. You can
also configure options to control the behavior of the hardware devices holding the
media to which DX moves files. This chapter describes each of the tabs in the
Service Properties dialog box.

Troubleshooting can be done using the diagnostic utilities in the Tools menu and the
Service menu. You can look up error definitions in the Administrator using the Error
Glossary feature. Information on each of these utilities is provided in this chapter.



Chapter Four: DX Computer Administration

76 Application Storage Manager System Guide

MANAGING THE DX SERVICE

DX functions as a Windows NT/2000 service rather than a user-mode application.
As a Windows service, DX can be configured for various startup settings, including
Automatic startup, which starts DX upon Windows system startup, Manual startup,
which allows you to start the service manually, and Disabled, which disables the
service and does not allow it to start until that status is changed. As a Windows
NT/2000 service, DX can continue to be active even after you log off Windows, as
long as the computer is still running.

SERVICE MANAGEMENT VIA DX ADMINISTRATOR
With DX, you can perform all of the following functions:

� Check DX status on both local and remote DX computers.

� Start, pause, and stop DX service on local and remote DX computers.

� Set service startup options.

The DX service must be started in order for the Administrator to connect to it.

Opening Service Manager
DX service management can be performed through the DX Service Manager, which
can be accessed from the Tools menu (located on the main menu) or the icon on the
toolbar. You can select which DX computer to manage services for from the
Computer drop-down list box, or by selecting an extended drive for a computer in
the tree view.

To open the service manager:
� You have two options:

� Select Service Manager from the Tools Menu.

� Click the Service Manager icon on the toolbar.

Figure 49: Service Manager Toolbar Button

The Service Manager dialog box appears.
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Figure 50: Service Manager Dialog Box

The Service Manager indicates the status of the DX service just below the traffic
light signal in the center of the Service Manager dialog box. A green light indicates
the service is started, a yellow light indicates the service is paused, and a red light
indicates the service is stopped.

Table 14: Service Manager Status Indicator

STATUS: INDICATOR APPEARANCE: DESCRIPTION:

The DX service
is stopped.

When the service is stopped, the
red light is lit, and the word
Start is active in the window.

The DX service
is paused.

When the service is paused, the
yellow light is lit, and the words
Start and Stop are active in the
window.

The DX service
is started.

When the service is started, the
green light is lit. The word Start
is grayed-out and Pause and
Stop are active in the window.

Starting, Pausing, and Stopping DX
Using the Service Manager dialog box, you can easily start and stop the
DISKXTENDER Service for a DX computer.
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NOTE ����
You can start, stop and pause service for any registered DX computer, even if the
selected computer is not currently connected through the administrator. DX
computers that are not connected are listed in the tree view with a status of
(Disconnected).

Starting a DX service
Service Manager allows you to start the DX service for the currently active DX
computer.

To start a DX computer:
1 Select the DX computer name in the Computer: drop-down list box.

2 Double-click the word Start in the Service Manager dialog box.

3 Click Yes in the “Start DISKXTENDER service?” message box.

Pausing a DX service
When you plan to pause DX service, it is a good idea to broadcast a message. This
will give users enough time to finish their tasks before the pause is initiated.

To pause a DX service:
1 In the Service Manager dialog box, double-click Pause.

2 Click Yes in the “Pause DISKXTENDER service?” message box.

Stopping a DX service
Once again, when you plan to shut down the DX service, it is a good idea to
broadcast a message telling users the service will be stopped. This will give users
enough time to finish their tasks.

To stop a DX service:
1 In the Service Manager dialog box, double-click Stop.

2 Click Yes in the “Stop DISKXTENDER service?” message box.

NOTE����
To broadcast a shutdown message, simply proceed to the command prompt and type
net send /users “message”. The message is then sent to all users
connected to the DX computer.
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Configuring Service Settings
The DX service, like any Windows NT/2000 service, can be set to start in a number
of ways. For example, you may want DX service to start immediately upon system
startup, or you may want the ability to manually start or even disable the DX service.
The following lists the possible service settings for DX (or any Windows NT/2000
service).

Table 15: DX Service Settings

SETTING: DESCRIPTION:

Automatic Automatic services start every time the system starts.

Manual Manual services can be started by a user or by a dependent service.

Disabled A disabled service cannot be run until the disabled status is
changed.

To edit service settings:
1 In the Service Manager dialog box, click Edit Service Settings. The Edit Service

Settings dialog box appears.

Figure 51: Edit Service Settings Dialog Box

2 Select the appropriate Startup Type option: Automatic, Manual, or Disabled.

3 In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of DISKXTENDER on the
computer. To select to have the service login as the System Account, enable that
option.

4 Click OK to change the service settings or Cancel to abort.
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NOTE����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your DX system.

SERVICE MANAGEMENT THROUGH WINDOWS
The Control Panel in Windows NT, and the Administrative Tools application in
Windows 2000 allow you to modify the system while working in Windows. An icon
in the Control Panel represents each option that can be changed. The Services option
allows you to start and stop Windows NT services, as well as configure service
parameters. The Services and Applications option in the Administrative Tools allow
you to start and stop Windows 2000 services as well as configure service parameters.
Control Panel and Administrative Tools options affect only the local machine.

Starting and Stopping the DX service
The Control Panel in Windows NT and the Administrative Tools in Windows 2000
can be used to start and stop Windows services.

To access the service panel for Windows NT:
� On the DX computer, open the Windows Service Manager. From the Start

menu, select Control Panel → Services.

Figure 52: Windows NT Services Dialog Box
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To access the service panel for Windows 2000:
1 On the DX computer, open the Windows Service Manager. From the Start

menu, select Programs → Administrative Tools → Services. The Services
dialog box appears.

Figure 53: Windows 2000 Services Dialog Box

2 From Windows Services dialog box, select OTG DISKXTENDER from the service
list. From Windows 2000 Services dialog box, double-click OTG DISKXTENDER
from the service list.

3 Select the Start, Stop, Pause, or Continue button as needed.

4 Select the Close button when finished.

Configuring Settings
The Control Panel (Windows NT) and Administrative Tools (Windows 2000) can
also be used to edit DX service settings. From the Services dialog box, Windows NT
services can be set for automatic or manual startup (it can also be disabled).

To edit DX service settings via the Windows NT control panel:
1 In the Service dialog box, select OTG DISKXTENDER and click Startup.

2 The Service dialog box appears allowing startup options to be changed.
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Figure 54: Service Dialog Box

3 Select the appropriate option for startup type.

4 In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of DISKXTENDER on the
computer. To select to have the service login as the System Account, enable that
option.

5 Select OK to return to the Services dialog box and then Close to exit.

NOTE����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your DX system.

To edit DX service settings via the Windows 2000 service panel:
1 On the DX computer, open the Windows Service Manager. From the Start

menu, select Programs → Administrative Tools → Services. The Services
dialog box appears.
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Figure 55: Windows 2000 Services Dialog Box

2 From the Services dialog box, double-click OTG DISKXTENDER from the
service list. The OTG DISKXTENDER Properties dialog box appears.

Figure 56: OTG DiskXtender Properties Dialog Box

3 Select the appropriate startup type option from the drop-down list in the Startup
type section of the General tab.

4 Click on the Log On tab to activate it.
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Figure 57: OTG DiskXtender Properties Dialog Box – Log On Tab

5 In the Log On As section, This Account option is enabled by default and should
contain the login and password entered on installation of DISKXTENDER on the
computer. To select to have the service login as the System Account, enable that
option.

6 Click OK to return to the Services dialog box and then Close to exit.

NOTE����
Check with your network administrator to determine if the System Account or This
Account option is appropriate for your DX system.

CONFIGURING DX PROPERTIES

DISKXTENDER allows you to view and configure DX service properties in the
Service Properties dialog box. You can view information relating to the DX
installation on the currently active DX computer.

Each DX computer has a Service Properties dialog box that displays tabs of
information pertaining to DX service. These tabs include: General, Settings, Options,
and Alerts.
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To open the DX Service Properties dialog box:
� From the Service menu, select Properties.

Figure 58: Service Properties Dialog Box

Click OK to close the dialog box and return to the DX Administrator.

GENERAL TAB
The General tab displays identifying information for the DX computer.

Figure 59: Service properties – General Tab
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Table 16: DX Service Properties: General Tab

ITEM: DESCRIPTION:

Computer Name The Windows computer name for the DX computer.

Installation Date The date that DX was installed (or updated).

Version The installed version of DX.

THE SETTINGS TAB
The Settings tab of the DX Service Properties dialog box allows you to map a
partition to the DX extended drive which allows clients (like DISKXTENDER clients
or OTG’s APPLICATIONXTENDER) to connect to the DX service via a Remote
Protocol Connection (RPC).

Figure 60: Service Properties – Settings Tab

Creating the partition essentially creates a media folder that mimics a DX partition,
and then you must map the partition to the extended drive where it resides.

Mapping Partitions
Partition mapping allows clients (like DX clients or OTG’s APPLICATIONXTENDER)
to connect to the DX service using a Remote Protocol Connection (RPC). Creating a
partition creates a media folder that mimics a DX partition, and mapping the
partition points to the extended drive on which the folder actually resides.

The Partition Map dialog box, accessed by clicking the Partition Map button on the
Settings tab of the Service Properties dialog box, allows you to create, view, edit and
delete mapped partitions.
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When creating a New Partition Map Entry, type in the name of the partition in the
Partition Name dialog box and select the appropriate extended drive from the
Extended Drive drop-down list.

When editing a Partition Map Entry, you can change the name of the partition in the
Partition Name dialog box and/or select a different extended drive for the partition
from the Extended Drive drop-down list.

To create a new partition:
1 On the Settings tab of the Service Properties dialog box, click Partition Map.

The Partition Map dialog box appears.

Figure 61: Partition Map Dialog Box

The Partition List in the Partition Map dialog box lists all mapped partitions and
the extended drives to which they have been mapped. When you first access the
dialog box, the list is empty.

2 In the Partition Map dialog box, click New. The New Partition Map Entry dialog
box appears.

Figure 62: New Partition Map Entry Dialog Box

3 Enter a name for the partition in the Partition Name text box.

4 Select the extended drive for the partition from the Extended Drive drop-down
list.
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5 Click OK. You are returned to the Partition Map dialog box, which now lists the
created partition and the extended drive to which it has been mapped.

Figure 63: Partition Map Dialog Box

To edit a mapped partition:
1 On the Settings tab of the Service Properties dialog box, click Partition Map.

The Partition Map dialog box appears.

Figure 64: Partition Map Dialog Box

The Partition List in the Partition Map dialog box lists all mapped partitions and
the extended drives to which they have been mapped.

2 Select the partition you want to change and click Edit. The Edit Partition Map
Entry dialog box appears.
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Figure 65: Edit Partition Map Entry Dialog Box

3 Make the necessary changes to the Partition Name and/or select a different
extended drive from the Extended Drive drop-down list and click OK. The
Partition Map dialog box reappears with the edits to the mapped partition.

To delete a mapped partition:
1 On the Settings tab of the Service Properties dialog box, click Partition Map.

The Partition Map dialog box appears.

Figure 66: Partition Map Dialog Box

2 The Partition List in the Partition Map dialog box lists all mapped partitions and
the extended drives to which they have been mapped.

3 Select the partition you want to delete and click Delete. The mapped partition is
deleted.
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THE OPTIONS TAB
The Options tab allows you to configure options that control the behavior of the
hardware devices holding the media to which DX moves files. We recommend you
pay special attention to the functions available through the Service Properties
Options tab and configure them appropriately. These options are designed to make
administering your DX Services easier and to improve performance.

Figure 67: Service Properties – Options Tab

To view and configure the Service Properties Options tab:
1 With the Service Properties dialog box open, click the Options tab.

Figure 68: Service Properties – Options Tab



Chapter Four: DX Computer Administration

Application Storage Manager System Guide 91

The upper section of the Options tab shows a list of DX Service options
available for configuration. The option information in the bottom section of the
Options tab changes to reflect the configuration aspects available for the option
selected in the list in the top section.
Each of these options is discussed in detail below and in the order in which they
appear in the list.

2 After configuring your DX Service options, you have three choices:

� Click OK to save your changes and close the Service Properties dialog box.

� Click Apply to save your changes without closing the Service Properties
dialog box.

� Click Cancel to discard all changes and close the Service Properties dialog
box.

DX Service Options
Each of the configurable DX Service options is discussed below. The configuration
options that appear in the lower part of the Options tab correspond to the option
selected in the list in the upper part of the Options tab.

Drive saver minutes (CD-ROM):
Use this option to configure how long DISKXTENDER will wait after CD-ROM media
becomes inactive before it will automatically spin down the media. Automatically
spinning down media means that the media is still mounted, but lies idle until the
media is requested by DX or dismounted. The default is 5 minutes.

Figure 69: Service Properties – Options Tab

Enter the number of minutes you want DX to wait after CD-ROM media becomes
inactive before it automatically spins down the media.
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Timeslice value - minimum mount (CD-ROM):
Use this option to configure the minimum amount of time DISKXTENDER will keep
CD-ROM media in a drive after it has been mounted. This means that CD-ROM
media will remain in the drive for at least the amount of time you have entered. It
will not automatically dismount CD-ROM media, and you will not be able to
dismount the media before the time limit is up. The default is 30 seconds.

Figure 70: Service Properties – Options Tab

Enter the number of seconds you want DX to require CD-ROM media to stay in the
drive before it can be dismounted.
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Timeslice value - last fetch (CD-ROM):
Use this option to configure the amount of time CD-ROM media must remain
mounted after DX has fetched data from that media. This means that CD-ROM
media will not be dismounted immediately after a fetch, but instead DX will wait at
least the entered amount of time before dismounting the media. The default is 5
seconds.

Figure 71: Service Properties – Options Tab

Enter the number of seconds you want DX to have to wait after completing a fetch
before CD-ROM media can be dismounted.
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Timeslice value - maximum mount (CD-ROM):
Use this option to limit the amount of time CD-ROM media can stay mounted if it is
inactive, has no pending fetches, and there is other CD-ROM media that does have
pending fetches. This allows DX to dismount inactive media in favor of other media
that is being requested. The default is 60 seconds.

Figure 72: Service Properties – Options Tab

Enter the maximum number of seconds you want DX allow inactive CD-ROM
media to remain in the drive if other media is being requested.
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Drive saver minutes (DVD):
Use this option to configure how long DISKXTENDER will wait after DVD media
becomes inactive before it will automatically spin down the media. Automatically
spinning down media means that the media is still mounted, but lies idle until the
media is requested by DX or dismounted. The default is 5 minutes.

Figure 73: Service Properties – Options Tab

Enter the number of minutes you want DX to wait after DVD media becomes
inactive before it automatically spins down the media.
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Timeslice value - minimum mount (DVD):
Use this option to configure the minimum amount of time DISKXTENDER will keep
DVD media in a drive after it has been mounted. This means that DVD media will be
mounted for at least the amount of time you have entered. It will not automatically
dismount DVD media, and you will not be able to dismount the media before the
time limit is up. The default is 30 seconds.

Figure 74: Service Properties – Options Tab

Enter the number of seconds you want DX to require DVD media to stay in the drive
before it can be dismounted.
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Timeslice value - last fetch (DVD):
Use this option to configure the amount of time DVD media must remain mounted
after DX has fetched data from that media. This means that DVD media will not be
dismounted immediately after a fetch, but instead DX will wait at least the entered
amount of time before dismounting the media. The default is 5 seconds.

Figure 75: Service Properties – Options Tab

Enter the number of seconds you want DX to have to wait after completing a fetch
before DVD media can be dismounted.
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Timeslice value - maximum mount (DVD):
Use this option to limit the amount of time DVD media can stay mounted if it is
inactive, has no pending fetches, and there is other DVD media that does have
pending fetches. This allows DX to dismount inactive media in favor of other media
that is being requested. The default is 60 seconds.

Figure 76: Service Properties – Options Tab

Enter the maximum number of seconds you want DX to allow inactive DVD media
to remain in the drive if other media is being requested.
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Drive saver minutes (Optical):
Use this option to configure how long DISKXTENDER will wait after Optical media
becomes inactive before it will automatically spin down the media. Automatically
spinning down media means that the media is still mounted, but lies idle until the
media is requested by DX or dismounted. The default is 5 minutes.

Figure 77: Service Properties – Options Tab

Enter the number of minutes you want DX to wait after Optical media becomes
inactive before it automatically spins down the media.
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Timeslice value - minimum mount (Optical):
Use this option to configure the minimum amount of time DISKXTENDER will keep
Optical media in a drive after it has been mounted. This means that Optical media
will be mounted for at least the amount of time you have entered. It will not
automatically dismount Optical media, and you will not be able to dismount the
media before the time limit is up. The default is 30 seconds.

Figure 78: Service Properties – Options Tab

Enter the number of seconds you want DX to require Optical media to stay in the
drive before it can be dismounted.
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Timeslice value - last fetch (Optical):
Use this option to configure the amount of time Optical media must remain mounted
after DX has fetched data from that media. This means that Optical media will not
dismounted immediately after a fetch, but instead DX will wait at least the entered
amount of time before dismounting the media. The default is 5 seconds.

Figure 79: Service Properties – Options Tab

Enter the number of seconds you want DX to have to wait after completing a fetch
before Optical media can be dismounted.
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Timeslice value - maximum mount (Optical):
Use this option to limit the amount of time Optical media can stay mounted if it is
inactive, has no pending fetches, and there is other Optical media that does have
pending fetches. This allows DX to dismount inactive media in favor of other media
that is being requested. The default is 60 seconds.

Figure 80: Service Properties – Options Tab

Enter the maximum number of seconds you want DX to allow inactive Optical media
to remain in the drive if other media is being requested.
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Tape block size default value (K):
Use this option to configure the size settings DISKXTENDER will use for formatting
Tape media. The value you use will dictate the default block size of Tape media that
DX formats. This value will be used by the Media Format and Prepare wizards to set
the default block size of the Tape media. The default is 64 kilobytes.

Figure 81: Service Properties – Options Tab

Enter the number of kilobytes that you want DX to use as the default block size
when DX formats Tape media.
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Timeslice value - minimum mount (Tape):
Use this option to configure the minimum amount of time DISKXTENDER will keep
Tape media in a drive after it has been mounted. This means that Tape media will be
mounted for at least the amount of time you have entered. It will not automatically
dismount Tape media, and you will not be able to dismount the media before the
time limit is up. The default is 300 seconds.

Figure 82: Service Properties – Options Tab

Enter the number of seconds you want DX to require Tape media to stay mounted
before it can be dismounted.
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Timeslice value - last fetch (Tape):
Use this option to configure the amount of time Tape media must remain mounted
after DX has fetched data from that media. This means that the Tape media will not
be dismounted immediately after a fetch, but instead DX will wait at least the entered
amount of time before dismounting the media. The default is 60 seconds.

Figure 83: Service Properties – Options Tab

Enter the number of seconds you want DX to have to wait after completing a fetch
before Tape media can be dismounted.



Chapter Four: DX Computer Administration

106 Application Storage Manager System Guide

Timeslice value - maximum mount (Tape):
Use this option to limit the amount of time Tape media can stay mounted if it is
inactive, has no pending fetches, and there is other Tape media that does have
pending fetches. This allows DX to dismount inactive media in favor of other media
that is being requested. The default is 1200 seconds.

Figure 84: Service Properties – Options Tab

Enter the maximum number of seconds you want DX to allow inactive Tape media
to remain in the drive if other media is being requested.
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Use hardware compression:
Use this option if you want DX to compress data. Data compression allows DX to
store data in a format that requires less space than usual. It enables devices to
transmit the same amount of data in fewer bytes, thus not requiring as many
resources to fetch data.

Not all hardware devices support data compression. This option will only work with
devices that support data compression. The default is Do not use hardware
compression.

Figure 85: Service Properties – Options Tab

Enable hardware compression if supported by drive: Select this option if you
want to compress migrated data. This will only work if the device supports data
compression.

Do not use hardware compression: Select this option if you do not want to
compress data. This is the default option.

Use secure file delete:
Normally, when a file is deleted on OSS-formatted Erasable Optical media, a media
transaction is sent to the media marking the file for deletion. This ensures that the
file will be removed the next time the media is compacted and formatted; however, it
does not cause the file to be deleted from the media at the time of delete.

Enable this option to cause DX to send a file transaction to media that causes the file
data on the media to be overwritten when the transaction is written out to media.
This ensures that rather than just removing the file pointer and marking the file data
for deletion, that the file on the media is rendered completely irretrievable. The
default is Do not use secure file delete.
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Figure 86: Service Properties – Options Tab

Enable secure file delete (overwrite file data): Select this option to cause DX to
send a file transaction to media that causes the file data on the media to be
overwritten when the transaction is written out to media.

Do not use secure file delete: Select this option to only remove the file pointer from
the extended drive, and mark the file data on media for deletion at the time of
compaction and reformat. This is the default.

NOTE ����
This option only functions for Erasable Optical (Magneto Optical) media using the
OTG File System (OSS formatted).

Use special application filtering:
Use this option to allow DX to force a type of data access (listed below) for purged
files when those files are called by specific software applications. For example, you
may not want your virus scanning software to recall purged file data from media
during a virus scan. Or you may want a program to read files directly from the
media. DX installation provides a default list of applications set for filtering. You
may add to this list as necessary. See Table 17 below for a default list of applications
set for filtering. The default is Disable special application filtering.



Chapter Four: DX Computer Administration

Application Storage Manager System Guide 109

Figure 87: Service Properties – Options Tab

Enable special application filtering: Select this option to force a type of data access
for purged files when those files are called by specific software.

1 If this option is selected, click Edit List. The Special Application List dialog box
appears.

Figure 88: Special Application List Dialog Box

2 Highlight the Application Name and click Edit to change the action for each
application.
Direct Read: Select this access option if you want the software application to
read the purged file data directly from the media.
No Recall: Select this access option if you want the software application to
ignore purged files (program will see purged files as 0 bytes and skip over
them).
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3 After you have edited the application actions, click OK.

Disable special application filtering: Select this option if you do not want DX to
force a type of data access for purged files.

WARNING��������

There are four Tivoli Backup executables listed in the Special Application list:
DSM.EXE, DSMC.EXE, DSMCSVC.EXE and DAMAGENT.EXE. They are set to
Direct Read by default and should remain that way.  If you are using Tivoli Storage
Manager (TSM) as your media service, changing the Action for these four files to No
Recall can result in potential data loss.

Table 17: Default Applications Listed for Filtering

SPECIAL APPLICATION
NAME

EXE NAME EXE TYPE DEFAULT
ACTION

AVX Anti-Virus avxmonitornt.exe Service No recall

AVX Anti-Virus avxw.exe GUI No recall

AVX Anti-Virus avxc.exe CmdLine No recall

AVX Anti-Virus avxlite.exe Schedule No recall

Dr. Solomon’s Anti-Virus mcshield.exe Service No recall

Dr. Solomon’s Anti-Virus scan32.exe GUI No recall

F-Secure Anti-Virus fpavsvc.exe Service No recall

F-Secure Anti-Virus fpwm32.dll GUI No recall

McAfee Anti-Virus netshield.exe Service No recall

McAfee Anti-Virus vsmain.exe GUI No recall

McAfee Anti-Virus scan.exe CmdLine No recall

McAfee Anti-Virus vshwin32.exe schedule No recall

Norton Anti-Virus navwnt.exe Service No recall

Panda Anti-Virus pavsrv.exe Service No recall

Panda Anti-Virus iface.exe GUI No recall

Panda Anti-Virus pavjobs.exe schedule No recall

Tivoli Backup dsm.exe GUI Direct Read

Tivoli Backup dsmc.exe CmdLine Direct Read

Tivoli Backup dsmagent.exe Service Direct Read

Tivoli Backup dsmcsvc.exe Direct Read
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WARNING ����
DX allows you to delete applications from this list; however, deleting default
applications set by DX may cause system problems (including deadlock) due to both
the application and DX attempting to run conflicting processes at the same time.

Use write verify command:
The Write Verify command functions by sending data to the device buffer, writing
the data to the media, then reading the data from the media and comparing it to the
data in the buffer. This ensures that the media properly accepted the file data, and
that no error occurred during migration.

It is possible to disable write verification for your DX system by disabling this
option. However, note that without write verification, you have no assurance that
data has been correctly transferred to media. This option is particularly
recommended if you frequently select to purge files immediately after move.

Figure 89: Service Properties – Options Tab

Verify data after writing to media (best data integrity): Select this option to
enable the Write Verify command. This is the default.

Do not verify data after writing (best speed): Select this option to disable write
verification. Remember, selecting this option gives you no assurance that data has
been correctly transferred to media.

WARNING ����
By disabling this option, you have removed the primary safeguard against undetected
data corruption on media. Note that you will be responsible for any damage to your
data incurred as a result of disabling this option.
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NOTE ����
This option only applies for Erasable Optical (Magneto Optical), WORM and DVD
media using the OTG File System. Write verification for NTFS and FAT systems is
not managed by DX.

NOTE ����
If you have performance concerns, it is recommended that you improve performance
by upgrading your hardware, rather than by disabling this option.

THE ALERTS TAB
The Alerts tab allows you to configure DISKXTENDER to send alerts to specific users,
workstations, email addresses, or domains. There is also a text box on the bottom of
the Alerts tab allowing you to specify the SMTP Mail Server you want to use to send
the configured email alerts. Details on configuring alerts are discussed below.

Figure 90: Service Properties – Alerts Tab

Configuring Alerts
An alert is a message box that instantaneously appears notifying the recipient of an
error or warning on the DX system. Alerts that are configured for the DX computer
will broadcast any warnings or errors relating to the DX computer or DX service.

The alerts tab allows you to enter the name of the mail server being used to distribute
the alerts. You can add email addresses, or the names of domains, computers, or
users on your network to the Send Alerts To list. For each category added, you can
choose whether to configure notification of warnings, errors, or both.
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NOTE ����
If no error or warning notification is enabled for an assigned user or computer, then
no alerts will be broadcasted to that user or computer. You can leave a name on the
list and then disable both options to temporarily hinder alerts.

The computer or user names entered in the Alerts dialog box should correspond to
existing user or computer names on your Windows NT network.

To configure alert settings:
1 From the Service Properties dialog box click the Alerts tab. The Alerts tab

appears.

Figure 91: Service Properties – Alerts Tab

The alerts tab provides a text box at the bottom in which you can enter the name
of the mail server that will be used to distribute configured email alerts. The
well-known port for SMTP servers is supported, so no additional configuration
should be required for use with mail servers, routers or firewalls.

2 If configuring email alerts, type in the name of the mail server being used to
deliver the alerts in the Mail Server text box at the bottom of the Alerts tab.

3 Click Add. The Alert Settings dialog box appears.

Figure 92: Alert Settings Dialog Box
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4 From the Type drop-down list box, select the type of alert that you would like to
configure. You have the following choices:

� Computer

� Domain

� E-Mail

� User

5 In the Send To text box, enter the email address, or the domain, user, or
computer name to which you want alerts to be sent.

6 Below the Send To box you may configure the following options:

� If you want the alert to be sent for warnings and errors, enable both the
Notify warnings and Notify errors checkboxes.

� If you want an alert to be sent for warnings but not for errors, enable the
Notify warnings checkbox.

� If you want an alert to be sent for errors but not warnings, enable the Notify
errors checkbox.

� If you want to temporarily disable the alert, disable both the Notify
warnings and Notify errors checkboxes. You can enable either of these
options at a later time.

7 When you are finished choosing the alert settings, click Add. The information in
the Send To box disappears as the recipient is added to the alerts listing.

8 After a recipient has been added, you may enter another recipient into the Send
To box and/or change the Type setting and options and click Add again.

9 When you have finished configuring all of the alerts desired, click Close on the
Alert Settings dialog box. The chosen alert configurations appear in the Alert list
in the Alerts tab.

Once Alerts have been established, you may use the Alerts tab in the service
properties dialog box to edit or delete configured alerts.

To change configured alert settings:
1 From the Service menu in the Administrator, select Properties.

2 Select the Alerts tab. The Alerts tab appears, listing all currently configured
alerts.
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Figure 93: Service Properties – Alerts Tab

3 You have the following choices:

� To remove an alert from the list, select the alert in the list and click Delete.
A message appears asking you to confirm the deletion. Click Yes. The alert
is deleted.

� To edit an alert, select the alert in the list and click Edit. The Alerts dialog
box appears. Change the Type and Send To and other setting information as
appropriate and click Add, then click Close.

4 When you have made all necessary changes to the Alert list, click OK to save
the changes and close the Service Properties dialog box or click Apply to apply
the changes without closing the Properties dialog box.
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THE LICENSING INFORMATION TAB
The Licensing Information tab displays license information for the DX computer.

Figure 94: Service Properties – Licensing Information Tab

Table 18: DX Service Properties: Licensing Information Tab

ITEM: DESCRIPTION:

Licensee The user information entered during the DX installation.

Company The company information entered during the DX
installation.

License Server The name of the computer containing the installation of
License Server that is currently administering the DX
licenses for this DX service.

Licensing Details Detailed description of the DX licenses configured in the
License Server. This includes the number of DX Licenses
and type and file size capacity of the media services
available for use with DX.

DISKXTENDER DIAGNOSTIC TOOLS

DISKXTENDER has built in utilities for monitoring events, errors, and warnings on the
extended drive. The Extended Drive Viewer contains a listing of all DX events,
errors, and warnings. This information is also logged to event, error, and warning
logs. Errors and warnings are logged automatically while other events are not logged
by default (however, event logging can be enabled).
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TRACKING DX EVENTS, ERRORS AND WARNINGS
The logs provide a quick look at the activities of DX. They allow you to monitor all
aspects of extended drive events. Logs can help identify and solve potential problems
during runtime that might otherwise become critical problems if ignored. DX event
tracking utilities include:

� The Extended Drive Viewer: Where events, errors, and warnings all appear in
one location.

� Event Log: Used for debugging and problem identification through a
chronological listing of DX events related to that extended drive.

� Error Log: Used for detecting and diagnosing extended drive errors.

� Warning Log: Used to warn you of possible problems on the extended drive.

Using the Event Viewer
The Extended Drive Viewer displays all events for the extended drive. If you do not
want to automatically save a record of the events on the extended drive, you can
disable event logging in the Extended Drive Event Configuration dialog box and
simply monitor events in the Extended Drive Viewer. You can also take a “snapshot”
of the contents of the Extended Drive Viewer and save it for later use.

Opening the Event Viewer
The Event Viewer allows you to view recent events even if event logging is disabled.
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To open the event viewer
� From the Service menu, select Event Viewer. The Service Event Viewer

window appears.

Figure 95: Service Event Viewer: All Events

Taking Snapshots
A snapshot can be taken of a viewer in order to save or “capture” the contents of the
viewer as displayed at the time of the snapshot. A snapshot is a capture of up to the
last 2048 lines of the Extended Drive Viewer.

To take a snapshot of the event viewer:
� From the File menu in the Service Event Viewer, select Snapshot.

A snapshot is then taken of the current viewer. RtfPad automatically opens,
displaying the viewer’s text. DX also creates a temporary file when the snapshot is
taken. This file should be saved, so that you can view the information at a later time
(once RtfPad is closed).

USING DX LOGS
In addition to the viewing capabilities offered by the Event Viewer, DX also contains
log features that save events, errors, and warnings for the DX computer to a log file.

Opening DX Logs
You can open the DX Event, Error, and Warning logs from the Service menu. Each
log lists events, warnings, or errors relating to DISKXTENDER. When opened, the logs
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slow down DX performance. When closed, the impact they have on performance is
insignificant. The logs should be opened and used only for debugging purposes.

To open a log:
1 From the Service menu, select Event Logs.

2 From the Event Logs menu, select whether to view the All Events, Warnings
Only or Errors Only log.

3 The selected log opens in RtfPad and can be printed or saved.

Event Log
There are three Event Logs available under the Event Log command in the Service
menu: All Events, Error Log and Warning Log. As their names indicate, the Error
Log lists only DX system errors, the Warning Log lists only DX system warnings
and the All Events Log (also called the Service Event Log) lists all activities on the
DX service.

Event Logs are used for debugging purposes only. It provides logging services for
internal subsystems to assist with problem identification. If technical support is
needed, you may be asked to open this log and specify the information reported.

Each Event Log displays both the time and a message for each event. The most
recent events are last on the list (the list automatically scrolls to display the most
current events).

To display the all events log:
� From the Service menu, select Event Logs and then select All Events. The log

opens in RtfPad and can be printed or saved.

Figure 96: Service Event Log – All Events
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NOTE ����
Service event logging is disabled by default. In order to enable logging of service
events, you must uncheck the Disable log file (viewer only) option in the Event
Settings. For instructions, see Configuring DX Service Event Logging on page 123.

Error Log
The Error Log is a useful tool for detecting and diagnosing system errors. Every
DISKXTENDER error passes through the Error Log. All system errors are displayed in
both Event Viewer and Event Log, but the Error Log provides a more precise focus
for error tracking. Because these tools are necessary for system diagnostics, error
logging cannot be disabled.

To display the error log:
� From the Service menu, select Event Logs and then select Error Log. The log

opens in RtfPad and can be printed or saved.

Figure 97: Service Error Log

Warning Log
The Warning Log includes caution messages to warn you of possible problems in
DX. The Warning Log provides warnings for problems such as:

� Requests for media (either to read or write to a file) that could not be satisfied
because the media was not present on the DISKXTENDER system (not in any
drive or library).
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� Files that could not be migrated, due to media being full or no more media being
available in a move group.

� Disk full warnings for the NTFS volume on the extended drive.

The purpose of this list is to provide a simpler means of discovering where problems
exist that are hindering DISKXTENDER performance; for example, which media needs
to be added to the system to ensure that all user requests are fulfilled. These
warnings also pass through the Extended Drive Viewer and the Event Log, but the
Warning Log provides a more specific focus on these important warnings.

To display the warning log:
� From the Service menu, select Event Logs and then select Warning Log. The log

opens in RtfPad and can be printed or saved.

Figure 98: Service Warning Log

The Warning Log displays the time and a message for each event. The most recent
events are listed last in the list (the list automatically scrolls to display the most
current events).

USING RTFPAD
The Service Event, Warning, and Error Logs appear in RtfPad. You can view the
event logs at any time to monitor the progress of scheduled events or to troubleshoot
problems. Logs from RtfPad can be saved or printed, or you can send a copy of the
log via email. Using RtfPad, you can also easily find and view descriptions of system
errors.
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Saving, Sending and Printing Logs
Logs that appear in RtfPad can be saved, sent by email, or printed. These commands,
accessed through the File menu of RtfPad are standard Windows commands, and
function in RtfPad as they would in any Windows-based program.

Error Format
RtfPad can be viewed in a black-and-white interface, or with color to contrast errors
and warnings from other events. If RtfPad is set for Error Format, errors appear in
red text and warning messages appear in yellow text so that they are easily noticed.
Header text appears in green.

To set RtfPad to display information in error format:
� From the View menu, select Error Format. This is a toggle command. When

enabled (selected), a checkmark appears to the left of the command.

Errors appear in red text when enabled, while message-logging enabled/disabled
appears in green and warnings appear in yellow text.

To disable error format:
� From the View menu, select Error Format again. This is a toggle command.

When disabled, no checkmark appears to the left of the command.

RtfPad Error Lookup
When an error appears in RtfPad, an error number appears in parentheses with the
error message. This error number identifies the error and allows you to use the
RtfPad error lookup feature to obtain additional information about the error,
including the error name and a brief description.

To obtain additional information about an error:
1 With the error log open, highlight the error number.

2 You have the following choices:

� From the View menu, select Error Lookup.

� Press <F2>.
A dialog box appears with the error name and description.
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CONFIGURING DX SERVICE EVENT LOGGING
Event logging is necessary only when tracing events of interest to you. You can
configure which events are traced. Because tracing events impedes system
performance, no events are traced by default, though errors and warnings are logged
automatically because of their necessity for troubleshooting.

DX allows you to configure which events are logged, and whether to trace the local
service events or remote procedure calls (remote administration events).

For all logs, you can control the format of the log entries, and adjust the maximum
sizes for the log files. For the Event Log, you can disable logging and enable the
tracing of events upon startup. You can enable logging to the Windows Application
Log for the Warning and Error Logs.

Log Properties Configuration
You can control several aspects of logging functionality, including log entry format,
log file size, DX event logging, automatic startup of event logging and logging of
errors and warnings to the Windows Application Log.

To configure log properties:
1 From the Service menu, select Event Settings. The Service Event Configuration

dialog box appears. The Configuration Tab is active by default.

Figure 99: Service Event Configuration Dialog Box
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2 In the Line Format section, enable or disable logging of particular event
attributes by clicking in the checkbox next to each option to place or clear the
checkmark.

Table 19: Service Event Configuration: Line Format Options

ATTRIBUTE: DESCRIPTION:

Time: The time the event occurred

Date: The date the event occurred

Thread ID: The thread which the event used to communicate with the
processor

3 To disable logging to the event log, click the checkbox Disable log file (viewer
only).

4 If event logging is enabled, the Maximum Log Size text box is active. Use this
box to set the maximum event log size by typing the number of megabytes into
the Maximum Log Size text box. The default size is 5 megabytes.

5 To automatically initiate event logging when DX is started, click a check in the
checkbox next to Trace messages on startup.

6 In the Warning Log, enter the maximum size for the Warning Log file. The
default size is 5 megabytes. You can also enable logging to the Windows
Application Log by clicking a check in the checkbox next to the Write to
Windows Application Log option.

7 In the Error Log section, enter the maximum size for the Error Log file. The
default size is 5 megabytes. You can also enable logging to the Windows
Application Log by clicking a check in the checkbox next to the Write to
Windows Application Log option.

NOTE ����
The Warning Log and Error Log files are always written and cannot be disabled.

Event Tracing Configuration
You can configure which events are to be traced and reported to the Event Log. By
default, all event tracing is disabled. Unless instructed to enable tracing of events by
a technical support representative, you can leave the default settings in place.

NOTE ����
Event tracing configuration affects events only; errors and warnings relating to
events of the types listed are logged regardless of event tracing settings.
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WARNING ����
Enabling event tracing hinders performance and should be performed only when
debugging is required.

To configure events to be logged:
1 From the Service menu, select Event Settings. The Service Event Configuration

dialog box appears.

2 Click the Trace tab. This tab allows you to configure which events will be
logged. The System drop-down list displays Server Processing by default.

Figure 100: Service Event Configuration: Trace Tab

3 From the System drop-down list, select whether to trace Server Processing (local
machine service events) or Remote Procedure Calls (remote administration
service events).

4 In the Options window, individual events are listed. Click the checkbox next to
an event to enable tracing of that event. To disable tracing, clear the checkbox
by clicking it again.

5 After selecting the appropriate options, you have the following choices:

� Click Apply to save changes for the tab without closing the dialog box.

� Click OK to save the new settings and close the dialog box.

� Click Cancel to close the dialog box without saving any changes.
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DISKXTENDER ADMINISTRATIVE TOOLS
DX provides a number of ways to perform diagnostics on the DX system.
Comprehensive error messaging is built in, so every time an error condition occurs, a
message with information about the condition causing the error appears. DX contains
an error lookup feature that allows you to quickly translate the error codes provided
in DX messages. In addition, reports can be created on the Windows Registry and
the media services configured to your DX system to help you monitor DX status.

In addition to diagnostic capabilities, DX provides an administrative utility to help
you repair the DX computer in the event of system failure.

Error Lookup
Each DX error is displayed as an error number. The DX error lookup feature allows
you to obtain additional information about the error, including the error name and
description.

To look up an error:
1 From the Help drop-down menu in the Administrator’s window, select Error

Glossary. The System Error Lookup dialog box appears.

2 Enter the error number in the Error Number text box and click Look Up.

Figure 101: System Error Lookup Dialog Box

3 The error string (if applicable) and its description are displayed in the dialog
box.

4 Click the forward or backward arrows to scroll through the list of system errors.
Click Help to access context-sensitive help for the error glossary. Click Tech
Notes to launch the Xtender Solutions Knowledge Base.

5 Click Close to exit the dialog box.
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REPORTS

The DX reporting feature is a useful tool for tracking system statistics. Using the
Report Wizard, you can create various reports of system activities, including
extended drive information, media information, media services, and DISKXTENDER
settings in the Windows NT/2000 registry.

You can create reports in DX and create custom layouts for your reports. Custom
layouts are particularly useful because they can be saved and reused every time you
run a report. For instructions, see Reports Layout Editor on page 154.

The DISKXTENDER reporting feature is a useful tool for tracking system statistics.
DX gives you six different types of reports, each of which are detailed in this
chapter.

Since DX is designed to allow you to manage multiple registered DX computers
from a single Administrator interface, you can run any one of the available reports on
multiple computers and multiple extended drives. You can also select to run more
than one report at a time, allowing you to view several different aspects or details
about several different registered DX computers/extended drives, in one consolidated
report.

The available DX Reports are as follows:

� Extended Drive Information – detailed information about the selected extended
drive(s). See Extended Drive Information Report on page 130.

� Media – detailed information on selected pieces of media. See Media Report on
page 133.

� Media Files – generates a report based on the information compiled using a File
Report media task. See Media Files Reports on page 138

� Media Services – detailed information about the media services configured for
the selected DX computer(s). See Media Services Report on page 142.
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� Media Tasks – lists all pending media tasks for selected media. See Media Tasks
Report on page 145.

� Product Registry Information – lists all of the DX information contained in the
windows registry for the selected DX computers. See Product Registry
Information Report on page 151.

All of the reports available through DX are run using the Report Generator found in
the Tools menu of the Administrator. The Report Generator is a wizard function that
leads you through the step-by-step process of creating and customizing your reports.

CREATING REPORTS - REPORT WIZARD
The Report Generator wizard allows you to create various reports of system
activities on one or more registered DX computers, including information about each
extended drive and its components, media, and media task information. It also allows
you to select to run more than one report at a time, allowing you to view several
different aspects, or details about several different registered DX
computers/extended drives, in one consolidated report.

NOTE ����
DX allows you to run multiple reports at once. If you choose to do this, the
appropriate report wizard pages for each report will be merged to form one wizard
that will lead you through the report generation process.

Once a report has been generated, it appears on your screen in RtfPad. RtfPad allows
you to save, print or send the report via email. For instructions, see Saving, Printing
and Mailing Reports on page 153.
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To open the report wizard:
1 From Tools menu, select Report Generator. The Report Wizard opens and the

Select Report(s) To Run Page appears.

Figure 102: Report Wizard

The Select Report(s) To Run page lists all available DISKXTENDER reports. A
description of the report appears as a pop-up text box when you rest the mouse
pointer on any report option.

2 Select the appropriate report type(s). You can use a standard Windows <SHIFT>
or <CTRL> technique to select more than one type of report.

3 Click Next. The next report wizard page for the chosen report type appears.
Select Cancel to abort the procedure.

Specific information about creating each type of report is provided in the sections
below.
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Extended Drive Information Report
The Extended Drive Information Report displays information about selected
extended drive(s). This includes properties and assigned media. Full reports also
display scan statistics, the scan schedule, and log configuration.

To create an extended drive report:
1 From the Select Report(s) To Run page, select the Extended Drive Information

option.

Figure 103: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 104: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computers for which you want to
generate a report.
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4 Click Next. The Select Extended Drive(s) page appears.

Figure 105: Report Wizard Select Extended Drive(s) Page

The Select Extended Drive(s) page lists all available extended drives for the
selected DX computers.

5 In the Select Extended Drive(s) page, select the Extended Drive(s) for which
you want to generate a report.

6 Click Next. The Options page appears.

Figure 106: Extended Drive Information Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.
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7 If there is more than one computer/layout listed, select the one you want to use
for your report.

8 Select the amount of detail you want on the report: Full or Summary.

9 Click Next. The Summary page appears.

Figure 107: Extended Drive Information Report Summary Page

10 Review the information in the Summary page. If the information in the summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.

Figure 108: Extended Drive Information Report
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As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see Saving, Printing and Mailing Reports on page
153.

Media Report
The Media Report includes information on the selected media, either as a
summarized list or a detailed description of properties. Information displayed in the
detailed report includes location info, total/free space, and read/write/mount
statistics.

To run a media report:
1 From the Select Report(s) To Run page, select the Media option.

Figure 109: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.
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Figure 110: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computers for which you want to
generate a report.

4 Click Next. The Select Extended Drive(s) page appears.

Figure 111: Report Wizard Select Extended Drive(s) Page

The Select Extended Drive(s) page lists all available extended drives for the
selected DX computers.

5 In the Select Extended Drive(s) page, select the Extended Drive(s) for which
you want to generate a report.

6 Click Next. The Select Media for Media Report page appears.
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Figure 112: Select Media for Media Report Page

The Select Media for Media Report page lists all available media for which you
can generate a report. It lists the DX computer where the media is located and
the name of the media.

7 Select one of the media types from the Listed Media drop-down list. Selecting a
specific media type from the drop-down list will narrow the number of media
listed in the Media list, and may make it easier to find and choose media for the
report.

Figure 113: Listed Media Drop-Down List
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8 Select the media for which you want to generate the report. You may select
multiple pieces of media using the standard Windows <SHIFT> and <CTRL>
technique.

9 Click Next. The Options page appears.

Figure 114: Media Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.

10 If there is more than one computer/layout listed, select the one you want to use
for your report.

11 Select the amount of detail you want on the report: Full or Summary.

12 Click Next. The Summary page appears.
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Figure 115: Media Report Summary Page

13 Review the information in the Summary page. If the information in the summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.

Figure 116: Media Report

As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see Saving, Printing and Mailing Reports on page
153.
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Media Files Reports
A Media Files Report displays a formatted report based on the list of files generated
by processing a File Report task on one or more pieces of media.

NOTE ����
You cannot run a Media Files report unless you have previously processed a File
Report task for at least one piece of media on the selected extended drive(s).

To run a media files report:
1 From the Select Report(s) To Run page, select the Media Files option.

Figure 117: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 118: Report Wizard Select Computer(s) Page
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The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computers for which you want to
generate a report.

4 Click Next. The Select Extended Drive(s) page appears.

Figure 119: Report Wizard Select Extended Drive(s) Page

The Select Extended Drive(s) page lists all available extended drives for the
selected DX computers.

5 In the Select Extended Drive(s) page, select the Extended Drives for which you
want to generate a report.

6 Click Next. The Select Media for Media Files Report page appears.

Figure 120: Select Media for Media Files Report Page
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The Select Media for Media Files Report page lists all media for which the File
Report media task has previously been run. This window also notes whether the
Summary or Complete option was selected when the media task was configured.

7 Select one of the listed media for which you want to generate the report.

8 Click Next. The Select Media File Report Options page appears.

Figure 121: Select Media File Report Options Page

The selection options available in this page are as follows:

Table 20: Report Wizard: Select Media File Report Options Page

ITEM: DESCRIPTION:

List Files Select this option to list all files on the media.

Sort Click a check in the checkbox to configure a particular
sort order for the files.

Key 1 Select the first factor to sort by from the Key 1 drop-down
list box and select Ascending or Descending sort order.

Key 2 Select the next factor to sort by from the Key 2 drop-down
list box and select Ascending or Descending sort order.

List directories
only

Select this option to list only the directories on the media
and select Ascending or Descending sort order.

Summary only Select this option to list only summary information on the
piece of media. This is the only option available if the
media you selected for the report only had the Summary
option configured for the File Report media task.

9 Select the appropriate report option(s) and click Next. The Options page
appears.
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Figure 122: Media File Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.

10 If there is more than one computer/layout listed, select the one you want to use
for your report.

11 Select the amount of detail you want on the report: Full or Summary.

12 Click Next. The Summary page appears.

Figure 123: Media File Report Summary Page
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13 Review the information in the Summary page. If the information in the summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.

Figure 124: Media Files Report

As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see Saving, Printing and Mailing Reports on page
153.

Media Services Report
The Media Services Report provides information on the media services configured
on the selected DX computer(s). You may choose to run the report either as a
summarized list or a detailed description of properties. Information displayed in the
detailed report includes location information, total/free space, and read/write/mount
statistics.
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To run a media services report:
1 In the Report Wizard, from the Select Report(s) To Run page, select the Media

Services option.

Figure 125: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 126: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computer(s) for which you want
to generate a report.

4 Click Next. The Options page appears.
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Figure 127: Media Services Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.

5 If there is more than one computer/layout listed, select the one you want to use
for your report.

6 Select the amount of detail you want on the report: Full or Summary.

7 Click Next. The Summary page appears.

Figure 128: Media Services Report Summary Page

8 Review the information in the Summary page. If the information in the summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.
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Figure 129: Media Services Report Window

As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see Saving, Printing and Mailing Reports on page
153.

Media Tasks Report
The Media Tasks Report displays a list of media tasks that are pending, are in
progress, or that have failed for selected media on the selected extended drive(s).
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To run a media tasks report:
1 From the Select Report(s) To Run page, select the Media Tasks option.

Figure 130: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 131: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computer(s) for which you want
to generate a report.

4 Click Next. The Select Extended Drive(s) page appears.
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Figure 132: Report Wizard Select Extended Drive(s) Page

The Select Extended Drive(s) page lists all available extended drives for the
selected DX computers.

5 In the Select Extended Drive(s) page, select the Extended Drive(s) for which
you want to generate a report.

6 Click Next. The Select Media for Media Task Report page appears.

Figure 133: Select Media For Media Task Report Page

The Select Media for Media Task Report page lists all available media for which
you can generate a report. It lists the DX computer where the media is located
and the name of the media.

7 Select one of the media types from the Listed Media drop-down list. Selecting a
specific media type from the drop-down list will narrow the number of media
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listed in the media list, and may make it easier to find and choose media for the
report.

Figure 134: Listed Media Drop-Down List

8 Select the media for which you want to generate the report. You may select
multiple pieces of media using the standard Windows <SHIFT> or <CTRL>
technique.

NOTE ����
Be sure to select media that currently has pending media tasks assigned to it. If
you select media with no pending media tasks, the report will still be generated
but will contain no information for that media.

9 Click Next. The Options page appears.
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Figure 135: Media Tasks Report Layout Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.

10 If there is more than one computer/layout listed, select the one you want to use
for your report.

11 Select the amount of detail you want on the report: Full or Summary.

12 Click Next. The Summary page appears.

Figure 136: Media Tasks Report Summary Page
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13 Review the information in the summary page. If the information in the Summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.

Figure 137: Media Tasks Report

As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see Saving, Printing and Mailing Reports on page
153.
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Product Registry Information Report
The Product Registry Information report provides a complete listing of all
information contained in the Windows registry about the DISKXTENDER service on
the selected DX computer(s). The report information includes a listing of all registry
keys (and associated values) used by DISKXTENDER.

To run a product registry information report:
1 In the Report Wizard, from the Select Report(s) To Run page, select the Product

Registry Information option.

Figure 138: Select Report(s) To Run Page

2 Click Next. The Select Computer(s) page appears.

Figure 139: Report Wizard Select Computer(s) Page

The Select Computer(s) page lists all registered and connected DX computers.

3 In the Select Computer(s) page, select the DX computers for which you want to
generate a report.
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4 Click Next. The Options page appears.

Figure 140: Product Registry Information Report Options Page

The options page allows you to select the level of detail for the report (if
applicable) and select the layout for the report being generated. If you want to
edit a selected layout, click Edit Layouts. For detailed information on using the
Reports Layout Editor, see Reports Layout Editor on page 154.

5 If there is more than one computer/layout listed, select the one you want to use
for your report.

6 Select the amount of detail you want on the report: Full or Summary.

7 Click Next. The Summary page appears.

Figure 141: Product Registry Information Report Summary Page
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8 Review the information in the Summary page. If the information in the summary
is correct, click Finish to create and display the report. The report appears in
RtfPad.

Figure 142: Product Registry Information Report Window

As with any information appearing in RtfPad, you may choose to save, print or email
the report using the appropriate commands in the File menu of the RtfPad window.
For details on these functions, see the Saving, Printing and Mailing Reports section
below.

Saving, Printing and Mailing Reports
Once generated and displayed in the DX Report window, a report can be saved or
printed for future reference using RtfPad commands. In addition, you can send a
report to someone by email.

Figure 143: RtfPad File Menu
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By default, once the report (RtfPad window) is closed, the information is lost. While
the DX report window is open, you can perform the following functions using the
report window File menu:

� Use Save As to save the report.

� Use Send to email the report.

� Use Print and Print Setup to print the report in the appropriate format.

� Use Print Preview to preview the report before printing.

REPORTS LAYOUT EDITOR
The DX Report Layout Editor allows you to define font, font sizes, tab stops, and
header and footer contents. The styles and layouts can be set and saved as report
defaults; however, you can override these options whenever necessary.

DX also allows you to create and save new layouts on different DX computers.
These layouts are available for use any time a report is run for that DX computer,
regardless of whether the report is being run from that DX computer itself, or from a
remote DX computer. When you generate a report using the Report Wizard for a
remote DX computer that has saved layouts, those layouts will appear in the Report
Wizard Options page.

To open the reports layout editor:
� From the Tools menu on the main menu bar, select Report Layouts. The Report

Layout Editor dialog box appears.

Figure 144: Report Layout Editor

The following procedures outline how to create, edit, view, and delete custom report
layouts. Once created, a report layout is available for use with all DISKXTENDER
reports.
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To assist you with creating and editing your custom report layouts, the Report
Layout Editor window contains the following options:

� Use the drop-down list for the Name text box to select an existing layout to
view, edit or delete.

� Click Preview to preview the report layout listed in the Name text box.

� Click Update to save changes to a report layout without exiting the Report
Layout Editor.

� Click OK to save changes to a report layout and exit the Report Layout Editor.

� Click Cancel to exit the Report Layout Editor without saving changes.

Each of the following procedures begins from the Report Layout Editor dialog box
shown in Figure 144 above.

Creating a New Layout
Each layout should be identified by a specific, descriptive name, in order to make the
layout easy to identify for use with your reports.

To create a new layout:
1 Click New. The Enter New Layout Name dialog box appears.

Figure 145: Enter New Layout Name Dialog Box

.

2 Type a name in the text box and click OK. A new layout with that name and the
default layout settings is created.

Changing Headers and Footers for Layouts
The Report Layout Editor dialog box contains two text boxes entitled Text, one for
the header and one for the footer. These boxes allow you to enter specific text for the
headers and footers. DX also allows you to insert dynamic codes, which retrieve
specific values and writes them directly into the header or footer with the specified
text. Placing these dynamic codes in custom headers or footers, and thereby on the
reports generated with a custom layout, can help you identify, file and retrieve
reports later.
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To change a header or footer for a layout:
1 Click in the appropriate text box and type or edit the desired text.

2 If you want to insert a dynamic code, place the cursor where you want the code
value to appear.

3 Click Insert Code under the appropriate text box. The Select Report Code to
Insert dialog box appears.

Figure 146: Select Report Code To Insert

4 Select the code that you want to insert. You have six options:

Table 21: Select Report Code To Insert Options

OPTION: DESCRIPTION:

User Name Inserts the name of the currently logged in DX user.

Network Domain Inserts the Domain on which DX is running.

Date Inserts the system date the report is generated.

Time Inserts the system time the report is generated.

Report Name Inserts the name given to the report when generated.

Product Version Inserts the version of DISKXTENDER being used to
generate the report.

5 Click OK to insert the code and return to the Report Layout Editor dialog box.

NOTE ����
Spaces are not automatically inserted around the code. If you want spaces to appear
before or after the value the code inserts, place spaces in the text box before and after
the code as appropriate.
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Editing Layout Paragraph Styles
The Report Layout Editor allows you to customize the look of your reports by giving
you font, size, color, and other stylistic options for each type of paragraph used in
generating report output. This makes it easier to call attention to specific information
in the reports and may make your reports easier to read and interpret.

To edit styles for a layout:
1 Make sure the layout you want to modify appears in the Name text box.

2 Click Edit Styles. The Styles dialog box appears.

Figure 147: Report Layout – Styles Dialog Box

Each paragraph type has a drop-down list containing all available style profiles.

3 For each paragraph style profile you have two options (each paragraph style
must be edited separately):

� Select a profile from the drop-down list.

� Click Edit next to the paragraph profile text box to open the Report Style
Editor.

If you are selecting profiles from the drop-down lists, skip the next steps and
continue with step 7 below.
If you click Edit next to a style text box, the Report Style Editor dialog box
appears.

Figure 148: Paragraph Style Editor Dialog Box
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4 Select the desired characteristics for Font, Font Size, Text Color, and Alignment
from the appropriate drop-down lists.

5 Enable or disable the Underline and Bold characteristics for the paragraph by
clicking in the checkbox next to each option.

6 Click OK to save your changes to the paragraph style and return to the Report
Layout-Styles dialog box. Your new style properties appear in the paragraph
profile text box.

7 Once you have configured all necessary styles, you can preview the report
layout by selecting the Preview button on the Report Layout-Styles dialog box.
A Report Layout Preview appears.

Figure 149: Report Preview – Sample Report

8 Once you are satisfied with your layout styles, click OK to save changes and
return to the Report Layout Editor dialog box.

Switching from one layout to another
If you have created or made edits to a report layout, and you want to create or edit
another one, you should click Update to save your changes. If you select another
layout from the Name drop-down list box or click New without clicking the Update
button, DX will prompt you to save unsaved changes to the current layout.

Figure 150: Save Changes Verification Message
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Click Yes to save changes or No to discard changes made since the last time you
clicked Update.

To rename a layout:
1 Make sure that the correct layout appears in the Name text box.

2 Click Rename. The Enter New Layout Name dialog box appears.

Figure 151: Enter New Layout Name Dialog Box

3 Type the new name in the text box and click OK. The new name appears in the
Name text box in the Report Layout Editor dialog box.

To delete a layout:
1 Make sure the correct layout appears in the Name text box.

2 Click Delete.

3 DX will then ask you to confirm that the layout should be deleted. Click OK to
permanently delete the layout or Cancel to stop the delete operation.

Figure 152: Verification Message
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CCHHAAPPTTEERR  SSIIXX
BACKUP AND RECOVERY

Because constant and reliable access to your data is one of the most critical parts of
your system, we recommend that you have a comprehensive disaster recovery plan in
place in the event of system problems or an entire system shutdown, DISKXTENDER
contains several functions that can make creation and/or maintenance of your
recovery plan easier. DX also contains registry and data backup utilities that can help
you restore DX files and registry information, even when the problem is a minor one.

The functions available in DISKXTENDER to help you maintain continuous access to
DX managed data include:

� DISKXTENDER’S ability to run in a clustered environment, allowing for fail-over
and fail-back of DX processes between clustered servers. See Clustering on
page 162.

� The Extended Drive Backup utility, allowing for complete backups of extended
drive data, and complete restoration of that data when needed. See Extended
Drive Backup Utility on page 163 and Restoring Extended Drive from Backup
on page 184.

� The Repair Disk utility, allowing for creation of master and backup copies of
DX computer registry entries, and restoration of the registry when needed. See
Repair Disk Utility on page 174 and Restoring DX Registry Settings on page
179.

� The Change Extended Drive Serial Number utility – allowing for reassignment
of extended drive serial numbers, if required, after an extended drive a drive is
reformatted. See Change Extended Drive Serial Number Utility on page 182.

This chapter discusses the issues associated with each of these functions, details what
each function or utility does, and where applicable, provides step-by-step procedures
for both creating recovery files and restoring those files (and your DX system) when
necessary.
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CLUSTERING

Clustering is the process of connecting two or more computers together in such a
way that they behave like a single computer, and so that they share a single storage
device. The server computers that are part of the cluster are called nodes or systems.

A typical clustered environment consists of two servers (a Primary node and a
Secondary node) and a RAID array. The figure below shows a basic clustered
environment.

Figure 153: Example of Clustered Architecture

Secondary Server
Computer Name:

Cluster_Srv_2

Shared RAID

Primary Server
Computer Name:

Cluster_Srv_1

Special Cluster
Adapter

DiskXtender Installed
on Primary Node Secondary Node  takes

over if Primary fails

Logical Cluster Name
seen on Network:

DX_Cluster

Registry and
program info
shared so that

servers are
identical

Because the cluster is designed to function as a single computer, users and programs
do not access individual nodes when connecting to the cluster. They instead access a
logical cluster name. The logical cluster name represents the “single computer” that
all of the individual components within the cluster have formed to create.

The Primary node constantly updates the Secondary node with registry information
so it can intervene when needed. The Secondary node assumes the functions of the
Primary node if the Primary ever goes off-line.

The ability of a cluster to transfer functions to a Secondary node when the Primary
fails is called fault tolerance. The act of transferring functions to the Secondary
nodes is called fail-over. If the Primary node fails or is paused for repairs, the
processes will fail-over to the Secondary node. Because the Secondary node has the
same configuration as the Primary node, the Secondary node can run cluster
operations with little or no disruption of server activity.

When the Primary node comes back online, it is now available to take over the
processing functions if/when necessary, and effectively becomes the Secondary
node. In the event the new Primary node (which was the Secondary node before the
fail-over) fails, the Cluster operations will return to the original Primary node. The
act of transferring functions back to the original Primary node is called fail-back.
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DISKXTENDER has the capability to run on a clustered environment. The
administrator needs little interaction, as the installation procedure recognizes that the
program is being installed on a cluster, and modifies the installation appropriately.
The Windows operating system handles all other special cluster-related functions.

DX cluster installation is supported on a Windows NT Enterprise Edition or
Windows 2000 Advanced Server Edition cluster server using Microsoft Cluster
Server in active/passive mode.

If you are planning to run DISKXTENDER in a clustered environment, you must install
the DX program either from a remote machine or directly on the Primary server (the
server node currently in control). If installing from a remote machine, make sure to
select the logical cluster name to add to the list of computers for install. If installing
directly on the Primary server, be advised that the installation program can detect
whether the computer is the current Primary server, and will fail if initiated on a
machine other than the Primary server of the cluster. See the DX2000 Getting
Started Guide for detailed instructions on installation.

In addition, you must to obtain a cluster-enabled DX license when licensing a
cluster-installed copy of DX. Be sure to inform your sales representative when
purchasing your DX license that you will be running DISKXTENDER in a clustered
environment.

Remote administrators and DISKXTENDER clients will access the DX program by
connecting to the logical cluster name via the network.

DX BACKUP FUNCTIONS

DISKXTENDER contains several utilities that allow you to effectively backup the most
important aspects of your DX system, to include the files on your extended drive and
the registry settings used by DX. This section provides information and procedures
for setting up backup files and configurations in the event you ever need to restore
your DX system after a disaster or catastrophic system failure.

EXTENDED DRIVE BACKUP UTILITY
Extended drive backups should be performed periodically in order to back up
DISKXTENDER managed files and file tags. While you may be using a system backup
program, these programs can often be limited when it comes to backing up all of the
data necessary to restore your DISKXTENDER files in the event of a system problem
or disaster. There are two basic limitations when using traditional backup solutions
with extended drives: performance issues and incomplete backup sets. The extended
drive backup feature provides an alternative solution for these problems.

Backup programs that are not “NTFS aware” suffer from performance problems
when running with DISKXTENDER. These programs open files in a “normal mode”
and cause file data to be fetched from remote storage. This can make backup
impossible (due to time constraints) and can cause backup failures due to insufficient
disk space resources.
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Even backup solutions that are “NTFS aware” may not be suitable for DISKXTENDER
because they do not backup (and restore) all NTFS data. A complete backup for an
extended drive must include the following information:

� File names and metadata (for DX-managed files)

� File data (for non-DX managed files)

� File stream data

� Security information

� Extended attributes (additional metadata)

Since DISKXTENDER stores its file tracking data in NTFS extended attributes, this
data is critical to any backup and restore strategy. Many backup programs do not
backup and restore this data, making them ineffective as disaster recovery solutions
for DISKXTENDER.

A DX extended drive backup set will contain all necessary data for disaster recovery
of a DISKXTENDER extended drive. This feature provides a compact, high-speed,
backup of any extended drive. Backup sets will contain different data depending on
the type of file being backed up:

Table 22: Types of Data Backed up By DISKXTENDER

DISKXTENDER FILES: NON-DISKXTENDER FILES:

File names and metadata

File stream data

Security information

Extended attributes

File names and metadata

File stream data

Security information

Extended attributes

File data

Notice that extended drive backup sets do not include file data for DISKXTENDER
managed files (files that DX has already moved to media). This data is permanently
archived on remote storage media and can always be retrieved, and, therefore is not
necessary in a standard backup. This optimization significantly reduces the size of
backup data sets and the time it takes to backup large volumes.

Once DISKXTENDER has created a backup set, this data must be archived (like any
other backup data) for disaster recovery. Because the DISKXTENDER backup set
contains all necessary information to restore an extended drive, any backup software
can be used to archive DX backup sets. Limitations of backup software (i.e., not
backing up extended attributes, etc.) will not be an issue in this configuration
because the DX backup set contains all vital information for proper disaster
recovery.
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Creating Extended Drive Backups
During an extended drive backup, DX inventories all of the files on an extended
drive and sees that the appropriate information (file data, file tags and all necessary
additional data) is saved. The Extended Drive Backup utility allows you to set a
network path for the backup data, set your backup schedule, and select to run both
full and incremental backups.

Incremental backups are generally used in between full backup schedules to back up
files not previously backed up by DX. Incremental backups take significantly less
time than full backups. A Full DX backup will create a backup file for all files on the
extended drive, regardless of whether those files are managed by DX or not.

Extended drive backups can be forced or scheduled. Extended drive backup
scheduling is managed at the extended drive level, using the Backup button on the
Settings tab in the properties for each extended drive. Until you set up a backup
schedule for the extended drives, automatic backups are disabled.

Scheduling Extended Drive Backups
The extended drive backup scheduling function is accessed through the Extended
Drive Properties. For the most complete backup results, you will want to schedule
your extended drive backups to occur when the fewest number of users are likely to
be accessing DX files. While the backup will run when users have files open, most
applications will not allow simultaneous access to open files, meaning any open files
will be “locked” to the backup process. Files that are locked when the backup is run
are skipped at that time, but will be captured during the next backup.

To access the extended drive backup schedule:
1 You have two choices:

� With the appropriate extended drive highlighted in the tree view, select
Properties from the Edit menu.

� Right-click on the appropriate extended drive and select Properties from the
shortcut menu.

The Extended Drive Properties dialog box appears.
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Figure 154: Extended Drive Properties Dialog Box

2 Click the Settings Tab. The Settings Page appears.

Figure 155: Extended Drive Properties – Settings Page

3 Click Backup. The extended drive Backup dialog box appears.
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Figure 156: Extended Drive Backup Dialog Box

The Backup dialog box contains three sections. The top section allows you to type in
or to browse to the folder in which you want your backup files saved. The second
section is a Scheduling section that allows you to select a regular schedule for
incremental backups. The third section is a Full Backup section that allows you to set
regular schedules for complete DX backups, and to select to force DX to create a full
backup the next time the incremental backup schedule is active.

To set an extended drive backup schedule:
1 In the UNC Path text box of the Location section of the Backup dialog box, type

in or browse to the folder in which you want to have your backup sets saved.
When your backup is created, DX will create a folder hierarchy within the
identified folder that lists the name and serial number of the extended drive, and
within that, a folder with the date of the backup created.
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Figure 157: Backup Folders Created in Explorer

Each time a new full backup is created, a new dated folder is created that
replaces the old one. This means that only the current full and associated
incremental backups are resident in the UNC path at any given time.

2 In the Scheduling section of the Backup dialog box, select the frequency with
which you want incremental (and if selected, forced full) extended drive
backups created. This schedule is disabled by default, and will remain disabled
until you set a schedule.
The table below lists the scheduling options and descriptions available for
incremental (and forced full) backups.

Table 23: Incremental Backup Scheduling Options

OPTION: DESCRIPTION:

Disable Disables all backup functions.

Once Creates a one-time backup at the time and date specified in
the Time and Date spin boxes. After the backup is created,
the schedule setting returns to disabled.

Daily Creates a backup every day at the time specified in the
Time spin box.

Weekly Creates a backup at the time specified in the Time spin box
on the day(s) of each week specified by checking the
Select Day(s) of Week checkbox(es).

Monthly Creates a backup at the time specified in the Time spin box
on the day of each month specified in the Day of Month
spin box.
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NOTE ����
If you need detailed information on how to use this scheduler, please see the
Incremental Backup Scheduling Options on page 170.

3 In the Full Backup section of the extended drive Backup dialog box, there are
two checkboxes that pertain to the creation of full backups. Full backups are
extended drive backup sets containing all file information for the extended drive.

Figure 158: Full Backup Options in Backup Dialog Box

4 Enable the Force next backup to be full (setting cleared upon completion) option
to force DISKXTENDER to create a full extended drive backup the next time the
incremental backup schedule is activated. Once completed, this setting is
cleared. (Selecting this option will not affect any scheduled full backups
described in step 5 below.)

5 Enable the Perform at scheduled interval option to set a regular schedule for
DISKXTENDER to create full extended drive backups. (Selecting this option will
not affect a forced full backup described in step 4 above.)

6 If you enabled the Perform at scheduled interval option, click Full Backup
Frequency. The Full Backup Frequency dialog box appears.

NOTE ����
DISKXTENDER will not allow you to schedule full backups more frequently than
incremental backups. For this reason, you will notice that the Perform at
scheduled interval option on the Backup dialog box, and the full backup
scheduling options in the Full Backup Frequency dialog box may be grayed out,
depending on your incremental backup schedule.

Figure 159: Full Backup Frequency Dialog Box

7 You have three options:
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� Select Always to create a full extended drive backup every time the
incremental backup schedule is active. If you select this option, DX will
always create a full backup and never create incremental backups.

� Select Once per week on ____ to create a full extended drive backup once
per week on the selected day. If you select this option, DX will create a full
backup on the selected day, and create incremental backups at the time(s)
configured for the incremental backup schedule.

� Select Once per month on the ___ (1st – 4th) ______ (day) to create a full
extended drive backup once a month on the selected day of the month. If
you select this option, DX will create a full backup on the selected day, and
create incremental backups at the time(s) configured for the incremental
backup schedule.

Full backups can often be time-consuming because a full backup will include all
files on the extended drive, regardless of whether or not they are managed by
DISKXTENDER. Please keep this in mind when setting your full backup schedule.

8 After setting your Full Backup Frequency schedule, click OK. You are returned
to the Backup dialog box.

9 When all extended drive backup schedule settings are complete, click OK to
return to the Extended Drive Properties Settings tab.

Incremental Backup Scheduling Options
The Scheduling section of the Backup dialog box allows you to schedule backups as
frequently as is appropriate for your system needs. Backups can be scheduled to
occur once, daily, weekly, or monthly. You can also disable automatic backups.
Disable is the default, and backups will remain disabled until you set a schedule.

To perform a one-time backup:
1 Click Once in the Scheduling section of the Backup dialog box. The Date and

Time spin-boxes appear.

Figure 160: One-time Backup Options

2 In the Date spin-box, specify the date you want the backup to occur.

3 In the Time spin-box, specify the time you want the backup to occur.
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NOTE ����
The default values for the Date and Time spin boxes are today’s date and 12:00AM
respectively. Because it is likely this default time occurs in the past, the backup will
not run unless you change the defaults to a date and/or time in the future.

NOTE ����
After a one-time backup is processed, the backup schedule is disabled, meaning
backups will not occur again unless forced or scheduled.

To configure the backup to occur on a daily basis:
1 Click Daily in the Scheduling section of the Backup dialog box. The Time spin-

box appears.

Figure 161: Daily Backup Options

2 In the Time spin-box, specify the time when you want the backups to occur.

To configure the backup to occur on a weekly basis:
1 Click Weekly in the Scheduling section of the Backup dialog box. The Time

spin-box, and checkboxes for the days of the week appear.

Figure 162: Weekly Backup Options

2 In the Time spin-box, specify the time you want the backups to occur.

3 Under Select Day(s) of Week, specify which day(s) of the week you want the
backups to occur.
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To configure the backup to occur on a monthly basis:
1 Click Monthly in the Scheduling section of the Backup dialog box. The Time

spin box, and the Day of Month drop-down list box appear.

Figure 163: Monthly Backup Options

2 In the Time spin-box, specify the time you want the backups to occur.

3 In the Day of Month drop-down list box, specify the date for the backups to
occur.

To disable automatic backups for this drive:
� Click Disable in the Scheduling section of the Backup dialog box.

Figure 164: Disable Backup Option

Forcing an Extended Drive Backup
Like the Force Drive Scan function, DISKXTENDER allows you to force an extended
drive backup whenever needed. Forcing an extended drive backup is similar to
running an incremental backup using the Once option. All files that have not been
marked as having been previously backed up, will be backed up at that time.

If there is no current backup of the DX extended drive, forcing an extended drive
backup will force a full backup (essentially an incremental backup of all files,
because they have not been backed up before). If there has been a backup of the DX
extended drive created at some point, forcing an extended drive backup will create a
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true incremental backup, capturing all files since the last backup (either full or
incremental) was run.

A forced extended drive backup uses the folder specified in the UNC Path text box
of the Backup dialog box to save the backup. You must have this path information
entered in order to force an extended drive backup.

To force an extended drive backup:
1 You have two choices:

� With the appropriate extended drive highlighted in the tree view, select
Force Backup from the Edit menu.

� Right-click on the appropriate extended drive and select Force Backup from
the shortcut menu.

A message appears reminding you that an extended drive backup may take a
considerable amount of time for a large extended drive.

Figure 165: Force Extended Drive Backup Warning Message

2 Click Yes on the message to continue with the forced extended drive backup. If
you have not configured a UNC Path in the Backup dialog box, you will receive
an error message.

Figure 166: Force Extended Drive Backup Error – No Path Defined

Click OK to close the message and return to DISKXTENDER. Follow the
Scheduling Extended Drive Backups instructions beginning on page 165 to set a
UNC Path for your backup.

If you have a location path configured, the backup will proceed and the forced
backup will be saved in the specified UNC Path folder.

Stopping an Extended Drive Backup in Progress
DX allows you to stop an extended drive backup after one has started. This function
may be useful if a scheduled backup begins at an inconvenient or inappropriate time,



Chapter Six: Backup and Recovery

174 Application Storage Manager System Guide

or if you forced a backup and later determined it was going to take more time that
could be allotted for the function.

When you stop an extended drive backup in progress, the system will finish backing
up the file it was on when the stop backup command was issued, and will retain
whatever files were backed up to that point. Any files not backed up will be captured
during the next backup process.

To stop an extended drive backup in progress:
1 While a backup is running, you have two choices:

� With the appropriate extended drive highlighted in the tree view, select
Abort Backup from the Edit menu.

� Right-click on the appropriate extended drive and select Abort Backup from
the shortcut menu.

A verification message appears.

Figure 167: Abort Extended Drive Backup Verification Message

2 Click Yes to abort the extended drive backup. Click No to allow the backup to
continue.

3 If you clicked Yes, a message appears confirming that the extended drive
backup was aborted.

Figure 168: Extended Drive Backup Aborted Message

4 Click OK to close the message and return to DISKXTENDER.

REPAIR DISK UTILITY
In the event that the DX computer drive becomes corrupted, DX contains a Repair
Disk utility that periodically creates a disk image of the DX computer system drive.
You can create a current disk image when needed using the Repair Disk utility or, in
the event of a DX computer crash, use an existing disk image to restore the DX
configuration.
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The Repair Disk utility can be used to create a backup copy of the registry
information for DX system. Every time a change is made to the DX configuration,
DX automatically updates the registry backup. You can set the location where the
repair disk is automatically saved, set a location for a copy of the registry for the
current DX configuration, or restore DX registry settings using the Repair Disk
Wizard.

This section provides procedures for setting the backup location for your repair disk
and for creating a copy of the repair disk backup. For information and instructions on
restoring a repair disk file, see Restoring DX Registry Settings on page 179

Setting the Repair Disk Location
The Repair Disk Wizard allows you to designate where DX will store the registry
information image it creates. In order to ensure fail-proof disaster recovery, the
image should be copied to a location separate from your Windows Server files.
Ideally, you should copy them to a different volume.

NOTE����
The location of the disk image should be backed up regularly.

To set the repair disk location:
1 Select Repair Disk from the Tools menu to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 169: Repair Disk Wizard

2 Choose the Set the automatic repair disk location option and click Next. The
Automatic Repair Disk Location page appears.
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Figure 170: Automatic Repair Disk Location

3 The default directory path appears in the Location text box. You may change it
by entering a different directory path in the Location text box. To search for a
location, click the Browse button and select a path in the Browse for Folder
dialog box, then click OK to return to the Automatic Repair Disk Location page.

4 Once you have entered a path in the Location text box, click Next. The
Summary page appears.

Figure 171: Repair Disk Summary Page

5 Review the information in the summary. To change the location, click Back to
return to the previous page.

6 When the information in the Summary is correct, click Finish to complete the
wizard. A progress message appears, indicating that the auto disk repair location
is being saved. Once the message disappears, the location setting is complete.
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Copying the Current Configuration
In addition to designating where the registry backup is stored, The Repair Disk
Wizard also allows you to store a copy of the current registry settings at will. When
you use the Repair Disk Wizard to set a location for a copy of the current
configuration, DX creates a copy of the DX configuration as soon as the wizard is
completed.

NOTE����
Setting a location for a copy of the current configuration does not affect the location
for automatic backup. DX will continue to back up DX registry information to the
location set for automatic repair disk creation.

NOTE����
You must pause the DX service in order to create a backup of the product registry.

To store a copy of the current disk image:
1 Select Repair Disk from the Tools menu to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 172: Repair Disk Wizard

2 Select the Copy current repair disk information to another location option

3 Click Next. The Copy Repair Disk Information page appears.
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Figure 173: Copy Repair Disk Information Page

4 Enter a directory path in the Location text box. To search for a location, click
the Browse button and select a path in the Browse for Folder dialog box, then
click OK to return to the Copy Repair Disk Location page.

5 Once you have entered a path in the Location text box, click Next. The
Summary page appears.

Figure 174: Copy Repair Disk Summary Page

6 Review the information in the summary. To change the location, click Back to
return to the previous page.

7 When the information in the Summary is correct, click Finish to complete the
wizard. A progress message appears, indicating that the copy disk repair
location is being saved. Once the message disappears, the location change is
complete.
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DX RESTORE FUNCTIONS

In the event of catastrophic system failure, the same DX utilities that allowed you to
create backups of your extended drive files and your registry settings, also allow you
to restore those backups to your DX system. The restore functions for the DX Repair
Disk utility and the Extended Drive Backup utility, make recovery and re-
configuration of your system after a disaster both faster and more accurate.

This section provides information and procedures for restoring backup files and
registry configurations in the event you ever need to restore your DX system after a
disaster or catastrophic system failure.

Before You Restore DX
When a system failure or disaster occurs, the following steps should be taken in
order to most effectively restore your DX system, DX files, and DX configurations:

To restore your DX system:
1 Reformat DX computer hard drive.

2 Reinstall Windows NT/2000.

3 Reinstall DISKXTENDER.

4 Restore Repair Disk (DX Registry) file.

5 Run Change Extended Drive Serial Number wizard (will automatically appear if
the change is required – otherwise, continue with next step).

6 Restore Extended Drive Backup.

These steps should be sufficient to get your DX system back up and running after a
disaster or system failure. As always, however, if you run into any problems, contact
your technical support representative for assistance.

RESTORING DX REGISTRY SETTINGS
When NTFS corruption occurs on your DX computer, you can restore your DX
registry configuration by restoring the disk image using the backup registry copies.
Once you have reinstalled all of the necessary software components, you can use the
Repair Disk Wizard to restore your DX service configuration.

NOTE ����
Depending on what problems occurred to cause you to have to restore your DX
system, you may be prompted to run the Change Extended Drive Serial Number
wizard before restoring the DX registry. If the wizard appears, we recommend that
you click Cancel and run the repair disk restore first.
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To restore the DX registry configuration:
1 From the Tools menu, select Repair Disk to start the Repair Disk Wizard. The

Repair Disk Wizard page appears.

Figure 175: Repair Disk Wizard

2 Choose the Restore service configuration from a repair disk option and click
Next. The Restore Repair Disk page appears.

Figure 176: Restore Repair Disk Location Page

3 Enter the directory path to the repair disk in the Location text box. To search for
a location, click the Browse button and select the path in the Browse for Folder
dialog box, then click OK to return to the Restore Repair Disk page.

4 Once you have entered a path in the Location text box, click Next. The Restore
Repair Disk – Warning page displays. Read carefully.
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Figure 177: Restore Repair Disk – Warning Page

NOTE����
In the event that there is a problem with the stored disk image, you may want to
go back and copy the current configuration to a different location before
proceeding. This will save an image of the current DX configuration, if
appropriate.

5 Click Next. The Restore Repair Disk – Note page appears.

Figure 178: Restore Repair Disk Note Page

This page provides a reminder that the current product configurations will be
overwritten with the saved configuration from the specified repair disk location.

6 To continue, click Next. The Summary page appears.
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Figure 179: Summary Page

7 The Summary page lists details about the restore. Review this information
carefully. To change the location, click Back three times to scroll back through
the wizard and return to the Location page. Click cancel to exit the process
without restoring the configuration.

8 When the information in the Summary is correct, click Finish to complete the
wizard. The registry information is copied and the backup DX configuration is
restored to your machine

After your DX registry is restored, we recommend restarting the DX computer in
order to make sure that the necessary changes have been made to the registry. After
restart, if necessary, DX may prompt you to run the Change Extended Drive Serial
Number wizard.

CHANGE EXTENDED DRIVE SERIAL NUMBER UTILITY
DISKXTENDER tracks extended drives by the volume serial number assigned to each
NTFS volume. This number is set during the format process, and uniquely identifies
each NTFS volume on a network.

In a disaster recovery scenario, it is likely that the volume serial number for a drive
will change (due to reformatting the drive). In this case, the extended drive in
DISKXTENDER (identified by the old serial number) will appear as OFFLINE in the
administrator, indicating that the extended drive cannot be found.

The Change Extended Drive Serial Number wizard allows users to view all
OFFLINE extended drives, and redefine volume serial numbers for each drive. When
completed, this wizard will reset the DISKXTENDER configuration to recognize “old”
extended drives under the “new” volume serial number.

This wizard is typically used after restoring a DISKXTENDER repair disk. In most
cases, the extended drive has been lost and reformatted before restoring the DX
repair disk. Although the repair disk restores all pre-existing configuration
information for DISKXTENDER, it has no way of knowing what drives have been
reformatted, or what their new serial numbers are.
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Using the Change Extended Drive Serial Number utility, you may select new volume
serial numbers from a drop down list containing all unused volume serial numbers on
the DISKXTENDER computer.

Be advised, there is no way to manually start the Change Extended Drive Serial
Number utility. The wizard will automatically start when the DISKXTENDER service
starts and determines that one or more extended drives are offline.

To process the Change Extended Drive Serial Number Wizard:
1 When the wizard starts, the Welcome page appears.

Figure 180: Change Extended Drive Serial Number Wizard Welcome Page

2 Read the information in the Welcome page and click Next. The Select New
Serial Number(s) page appears.

Figure 181: Select New Serial Number Page
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The Select New Serial Number(s) page lists all offline extended drives, and the
serial number previously assigned to those drives. At the bottom of the page is a
drop-down list of all currently unassigned drive letters on the DISKXTENDER
computer.

3 Highlight the drive with the serial number you want to change and select the
appropriate drive letter (and new serial number) from the drop-down list.

4 Click Next. The Summary page appears.

Figure 182: Summary Page

5 Review the information in the summary. If necessary, click Back to return to the
previous page and change the selected options.

6 If the information in the summary is correct, click Finish. A progress message
appears, letting you know that the extended drive is being remapped.

Figure 183: Progress Message

When the process is complete, you are returned to the DISKXTENDER Administrator
and your extended drive should now appear in the tree view.

RESTORING EXTENDED DRIVE FROM BACKUP
If you have created extended drive backups, DX allows you to restore the backed up
files. If it is necessary, the Extended Drive Backup Restore function allows you to



Chapter Six: Backup and Recovery

Application Storage Manager System Guide 185

restore extended drive files backed up from a different extended drive, in the event
that the entire structure of your DX system had to change to accommodate recovery.

The extended drive backup restoration utility functions as a wizard that leads you
step by step through the extended drive file restoration process.

Be advised, that an extended drive backup restore will not overwrite files created on
the extended drive since the backup was created, and as such, will not restore files
from a backup if a file of the same name already exists on the extended drive.
Because of the potential for confusion or for maintenance of outdated or corrupted
files, we strongly recommend that you not use the extended drive backup restore
function except as a disaster recovery tool.

To start the extended drive backup restore wizard:
1 You have two choices:

� With the appropriate extended drive highlighted in the tree view, select
Restore Backup from the Edit menu.

� Right-click on the appropriate extended drive and select Restore Backup
from the shortcut menu.

The Extended Drive Backup Restore Wizard welcome page appears.

Figure 184: Extended Drive Backup Restore Wizard Welcome Page

2 Click Next to continue with the wizard. The Provide Backup Set Location page
appears.
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Figure 185: Provide Backup Set Location Page

3 The extended drive backup folder location appears in the UNC Path text box by
default. If this is not the correct path, type in or browse to the appropriate folder
and click Next. The Select Backup Set page appears.

WARNING ����
You must select the same UNC path that you specified for the extended drive
backup. Do not attempt to specify the DX-created extended drive backup folder
(identified by date) for the restore. The extended drive restore utility will find the
most recent backup(s) automatically, and allow you to select the appropriate one
through the wizard

Figure 186: Select Backup Set Page

Since you can create backup sets for more than one extended drive and maintain
them in the same UNC path, you may have multiple backup sets to choose from.
However, DX only retains the most recent backups for each extended drive, so
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you will have only one backup set to choose from within each extended drive
backup folder.

4 Highlight the appropriate backup set and click Details to view the folder and
date information.

Figure 187: Backup Set Details Dialog Box

5 When you are finished viewing the details, click Done. You are returned to the
Select Backup Set page.

6 Make sure the backup set you want restored is highlighted and click Next. If for
some reason you are restoring an extended drive backup to a different extended
drive than the one from which the backup was created, or if you had to change
the serial number of the extended drive as part of the recovery procedure, a
verification message appears.

Figure 188: Backup Verification Message

7 Click Yes to continue with the restore. The Summary page appears.
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Figure 189: Extended Drive Backup Restore Summary Page

The summary page lists the information for the backup set you want to restore.

8 Review the information in the summary page. If it is correct, click Finish. If
necessary, click Back to return to the previous page in the wizard to adjust your
selection.

9 After clicking Finish, your extended drive files are restored to the point at which
the backup was created.

After restoring your extended drive backup, you may want to run one or more of the
available DX reports to make sure that your system has been returned to the
appropriate state and that DX files, system registry, and media have been reset to
their proper configuration.
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EXPLORER ADD-ONS

DISKXTENDER Explorer Add-ons provide access to limited administrative functions
for DX files. In order to perform these functions from a client workstation connected
to a DX extended drive, a full DISKXTENDER setup is not necessary. Those
workstations from which you want to run those functions only need to install the
Explorer Add-ons.

Explorer Add-ons can be installed on client workstations to allow users access to file
and directory information for files managed by DX. An Explorer Add-ons
installation sets up the Explorer Add-ons module on the workstation. Explorer Add-
ons can be run on a Windows NT/2000 server or workstation, or a Windows
95/98/ME workstation.

This chapter deals specifically with installation, use and configuration of the
Explorer Add-On components. For information on uninstalling the Explorer Add-
Ons, see Chapter Eight: Removing DX and DX Components on page 217.

NOTE ����
The term “DX File” refers to any file managed by DISKXTENDER. DISKXTENDER is
not considered to be managing files until the file has been moved by DX to media,
even though the file may currently reside on the extended drive.

INSTALLING EXPLORER ADD-ONS

Like all DISKXTENDER components, the Explorer Add-Ons have a setup wizard that
leads you through the necessary steps for installing the Explorer Add-ons. The Next
button continues to the following step; the Back button (when active) returns to the
preceding step. The Cancel button exits Setup, canceling the process.

For your convenience, the setup wizard allows you to install the Explorer Add-Ons
on multiple computers at once, provided those computers are visible on your network
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and you have Administrator privileges on those computers. To take advantage of this
feature, you may want to determine which computers are to have Explorer Add-Ons
installed on them and make sure you have the appropriate privileges on those
workstations before you run the installation wizard. This will enable you to only run
the installation once rather than multiple times.

NOTE ����
Before running Setup, exit all applications. Setup may not be able to write to all
necessary files if other software is running.

To install the explorer add-ons:
1 Insert the DISKXTENDER setup CD-ROM into the drive. From the Windows

Start menu, select Run. The Run dialog box appears.

2 You can either browse to the file or type the path in the Open text box:
D:\DX2000.XXX\DISKXTENDER EXPLORER ADD-ON\SETUP.EXE

(In this path, D represents the drive holding the setup CD-ROM and XXX
represents the DX2000 version number.)

3 Once the file/path appears in the Open text box, click OK. DISKXTENDER
Explorer Add-ons setup is initiated (which may take up to two minutes), and
then the DISKXTENDER Setup wizard appears, starting with the Explorer Add-
ons Installation page.

Figure 190: Explorer Add-ons Installation Page

The Explorer Add-ons Installation page briefly describes the installation
process.

4 Click Next. The Explorer Add-ons Installation Options page appears.
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Figure 191: Explorer Add-ons Installation Options Page

5 Select the Install New Product option and click Next. The Explorer Add-ons
License Agreement page appears.

Figure 192: Explorer Add-ons License Agreement Page

6 You must accept the terms of the license agreement before you can proceed with
the installation. Click the checkbox next to Accept terms of agreement to agree
to the terms of the agreement. Click Next. The Explorer Add-ons Registration
Information page appears.
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Figure 193: Explorer Add-ons Registration Information Page

7 Enter the customer name and organization name. Click Next. The Select Target
Computers page appears.

Figure 194: Select Target Computers Page

8 If you want to install Explorer Add-ons on more computers, click Add. The
Browse Computers dialog box appears.
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Figure 195: Browse Computers Dialog Box

9 Under Available Computers, navigate to and select the computer on which you
want to install the Explorer Add-ons. Click Add. The computer you have
selected is listed under Selected Computers. Repeat this step for each additional
computer on which you want to install the Explorer Add-ons.

10 Click OK. You are returned to the Select Target Computers page.

11 When the Target Computers list is complete, click Next. The Explorer Add-ons
Setup Summary page appears. This page shows the customer name and
organization and lists the target computers for the Explorer Add-ons installation.

Figure 196: Explorer Add-ons Setup Summary Page

12 Verify the accuracy of the information. If all information is correct, click Finish.
The Explorer Add-ons Setup copies all program files onto the system, and adds
Explorer Add-ons entries and the program group to the system configuration for
each target computer selected. A progress message displays the status of the
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operation, while a DISKXTENDER window displays information about DX, its
components, and utilities.

Figure 197: Setup Progress Bar

NOTE ����
If necessary, you can cancel the setup procedure by clicking Cancel.

The Explorer Add-ons Setup Results dialog box appears, listing the installation
results for each computer you specified.

Figure 198: Explorer Add-ons Setup Results Dialog Box

13 Take note of any computers that need to be restarted (or computers on which the
installation failed). Click OK.
If you are not required to restart the computer the Explorer Add-ons installation
has been successfully completed. Otherwise, installation will be complete after
restart.

The DISKXTENDER Explorer Add-ons program group is installed. The Explorer Add-
ons are now ready for use by the client workstation.

USING EXPLORER ADD-ONS

You can install DX Explorer Add-ons on any DISKXTENDER client machine. The
Explorer Add-Ons allow users to view DX file and media folder properties from
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client machines without a full installation of DISKXTENDER. The Explorer Add-Ons
enable this by connecting to the extended drive through Windows Explorer.

You can use the DX Explorer Add-ons to perform the following functions:

� View file properties – see DISKXTENDER File Properties on page 199

� Run file reports – see File Reports on page 204

� Set direct read for specified files – see Direct Read on page 210

� Purge specific files – see Purge Files on page 213

The DX Explorer Add-ons can be accessed from the Start menu or from shortcut
menus in Windows Explorer.

NOTE ����
The term “DX Files” refers to any file managed by DISKXTENDER. DISKXTENDER is
not considered to be managing files until the file has been moved by DX to media,
even though the file may currently reside on the extended drive.

SHELL XTENSIONS WIZARD
The DISKXTENDER Shell Xtensions Wizard provides a simple step-by-step process
for executing the Explorer Add-Ons functions. The wizard is accessible both from
the OTG DISKXTENDER program group in the Start menu and through the shortcut
menu in Explorer.

Explorer Add-Ons functions work identically whether accessed through the Shell
Xtension Wizard or through the Explorer Add-Ons commands in the Shortcut menu.
The advantage of using the Wizard over the specific shortcut menu commands is the
ability to select multiple files from multiple directories through the Select Files page
of the wizard. If you are selecting one or more files from only one directory (or all
the files in a single directory), it may be faster to use the shortcut menu commands.
(For information, see Explorer Add-Ons Shortcut Menu on page 198.)

When you first open the wizard, a dialog box appears with four function selection
options: Reports, File Properties, Direct Read and Purge Files. Each of these
functions and the information they provide is discussed later in this chapter. This
section deals specifically with parts of the wizard that will not appear when using the
shortcut menu commands.

Accessing the DISKXTENDER Shell Xtensions wizard:
1 You have two options for accessing the wizard:

� Navigate to the OTG DISKXTENDER program group in the Start menu and
select Shell Xtensions Wizard.

� Right-click in the Windows NT/2000 Explorer and select DISKXTENDER
Shell Wizard from the DISKXTENDER option on the shortcut menu.
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Figure 199: DiskXtender Shell Wizard

2 Select any one of these options and click Next. The Select Files window
appears.

Figure 200: File Selection Window

The options available in this window are as follows:

Table 24: DISKXTENDER Shell Wizard File Selection Page Options

OPTION: DESCRIPTION:

Add File Click this button to browse for files to add to the file list.
You can choose individual files, or you can select a folder
and add it. By default, if a folder is selected, all files in the
folder will be included.

Remove File Select a file or folder in the File List and click this button
to remove it from the file list. If a folder is removed, all
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OPTION: DESCRIPTION:
files in the folder will be removed.

File List This list shows the file or folder specifications that have
been selected for processing.

File Spec Once you have added folders to the File List, you can
restrict the files to include in those folders. Select the
folder in the File List, and then edit the File Spec text box
to specify the file extension for the files on which you
want to perform the action you selected.

Recurse
directories

Enable Recurse directories to include subdirectories.

Update If you have made changes to the file specification, click
the Update button.

3 Click Add File. The Select Files and/or Directories window opens.

Figure 201: Browse Files Window

This window allows you to select one or multiple files or directories for use in
the Explorer Add-Ons function. If you select one or more directories in this
window, you can restrict what files in those directories are added to the file list
by entering a file name or type in the Restrict to text box at the bottom of this
window.

4 After the files you want (or directories) are selected and the File Name(s) or
Restrict to text boxes are filled in, click Done. You are returned to the Select
Files dialog box, with the selected files/directories shown in the File List.
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Figure 202: Select Files Window

If you have added a directory to this list, the Directory Options are active and
you may choose to limit the files selected from that directory using the File Spec
text box. You may also enable or disable the Recurse directories option. If the
Recurse directories option is enabled, the wizard will include files in any
subdirectories in the selected directory.

5 If you make any changes in the Directory Options, click Update to update the
information in the File List.

6 To add additional files from other directories (or other directories), repeat steps
3 - 5.

7 Once the files to be used for the Explorer Add-Ons function appear in the File
List, click Next.

The window that appears next is determined by what function you are running. For
details on continuing through the wizard, see each of the following sections:

� DISKXTENDER File Properties -- page 199

� File Reports – page 204

� Direct Read – page 210

� Purge Files – page 213

EXPLORER ADD-ONS SHORTCUT MENU
The Shortcut menu commands for the Explorer Add-Ons provide the same functions
as the Shell Xtensions Wizard and produce the same results. The only advantage
provided by using the wizard over specific commands from the shortcut menu is that
the wizard allows you to select multiple files from multiple directories. The shortcut
menu only allows for the selection of single or multiple files in one directory, or the
selection of single or multiple directories. In addition, shortcut menu access will not
allow you restrict which files in a selected directory are to be used.
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Essentially, the Shortcut menu provides quick and easy access to the Explorer Add-
Ons functions for any file(s) that can be selected in Windows NT/2000 Explorer.

When you open the DISKXTENDER Explorer Add-Ons shortcut menu, you will see
six options: DISKXTENDER Shell Wizard, View File Properties, Enable Direct Read,
Disable Direct Read, and Purge Files and File Report.

Figure 203: Explorer Add-Ons Shortcut Menu

NOTE ����
The File Report option only appears on the Shortcut menu if multiple files (or a
directory containing multiple files) are selected.

The DISKXTENDER Shell Wizard option opens the Wizard the same way selecting
Shell Xtensions Wizard from the OTG DISKXTENDER program group does. For a
detailed discussion of the Wizard, see the Shell Xtensions Wizard section on page
195.

The other shortcut menu options process the functions listed for the file or files
selected, or for all files in the directory or directories selected.

If you select to Enable Direct Read, Disable Direct Read or Purge Files for the
selected files, you will receive a confirmation message before the function is
processed. If you select to run a File Report on the files selected (or files in the
directory you’ve selected) you will receive a window allowing you to select report
options.

The Explorer Add-Ons functions are discussed in detail below.

DISKXTENDER FILE PROPERTIES
DISKXTENDER File Properties are accessed by selecting to View File Properties from
the DISKXTENDER shortcut menu, or by selecting File Properties from the Shell
Xtensions Wizard.

The File Properties dialog box has three tabs: General, Media and Settings. The
information contained in each tab is discussed in detail in the table below the picture
of each tab.



Chapter Seven: Explorer Add-Ons

200 Application Storage Manager System Guide

File Properties - General Tab
Figure 204: File Properties - General Tab

Table 25: File Properties Dialog Box: General Tab Information

OPTION: DESCRIPTION:

File Name The name of the file for which properties are currently
displayed.

File Size The size of the file including file data.

Compressed Size The compressed size of the file on the extended drive. (If
the file is not compressed, this value will be zero.)

Last Write Time The last time the file was modified (or the create time if the
file has not been modified).

ISS Token The sector address on media where the file data for the file
has been stored by DX.

DX Attribute
Value

The numbers here represent various DX attributes that have
been configured for the file.

NOTE ����
If you attempt to view the properties for a non-DX file, the General Information data
is replaced by a message stating that DISKXTENDER does not manage the file.
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File Properties - Media Tab
Figure 205: File Properties - Media Tab

Table 26: File Properties Dialog Box: Media Tab Information

OPTION: DESCRIPTION:

File Name The name of the file for which properties are currently
displayed.

Name The name of the piece of media to which the file has been
migrated.

Serial No The serial number of the piece of media to which the file
has been migrated.

Status The current status of the piece of media to which the file
has been migrated. Status settings include: Online, Offline,
Task in Progress, Task Aborted, Task Failed, Task Pending.
If a file is purged and you try to open it, but DX is taking a
long time to retrieve it, check the media status to determine
if the media is in a state that will allow retrieval. File data
that has been purged from the extended drive (see File
Properties - Settings Tab below for the migration status)
can only be retrieved from media that is online. You must
correct the condition preventing retrieval before the file can
be retrieved (for example, put the media online, clear error
status on the media, or cancel the task in progress).

File System The type of file system used on the media.

Folder The DX media folder where the media is located.
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File Properties - Settings Tab
Figure 206: File Properties - Settings Tab

The following table describes each option on the Settings tab:

Table 27: File Properties Dialog Box: Settings Tab Information

OPTION: DESCRIPTION:

File Name The name of the file for which properties are currently
displayed.

Migration Status This value indicates whether the file is Fetched (file data is
present on the extended drive) or Purged (file tag is
present on the extended drive but file data has been purged
to media).

Purge File Data If the Migration Status indicates the file is Fetched, the
Purge File Data button is active. Select this button to purge
data from the file, leaving a file tag on the extended drive
and the file data on media. This command can only be
used on files with a current Migration Status of Fetched.

Direct Read
Setting

Enabled - When the direct read attribute is enabled for a
file, that file is read directly from media when it is
retrieved, rather than being fetched to the extended drive.
Disabled - When the direct read attribute is disabled, the
file is fetched to the extended drive and opened from there.

File Properties - File Stream Information Tab
The File Stream Information tab only appears if the file whose properties you
selected to view is made up of file streams. File streams occur when an operating
system is designed to save different “parts” of a file (file attributes, properties, file



Chapter Seven: Explorer Add-Ons

Application Storage Manager System Guide 203

data) separately into segments called “streams.” Currently, file streams relate
primarily to Macintosh platform files that have been saved to NT.

Figure 207: File Properties – File Stream Information Tab

The following table describes each option on the File Stream Information tab:

Table 28: File Properties Dialog Box: File Stream Information Tab

OPTION: DESCRIPTION:

File Name The name of the file for which properties are currently
displayed.

Stream Name The name of each stream within the file for which
properties are currently displayed.

Stream Size The size of each stream within the file for which properties
are currently displayed.

To view DX file properties through the wizard:
1 There are two ways to open the Shell Extensions Wizard:

� Right-click any file in Explorer and select DISKXTENDER Shell Wizard
from the DISKXTENDER option on the shortcut menu.

� Select the Shell Xtensions Wizard option from the OTG DISKXTENDER
program group accessible through the Start menu.

The Shell Extensions Wizard opens.

2 Select File Properties – Display file properties for selected files or folders. The
Select Files page appears.

3 Select files and options using the functions described in Table 24 on page 196.

4 Click Next. The Summary page appears. Review the information in the
summary page. Click Back to change any of the information entered.
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5 If the summary information is correct, click Finish. The DISKXTENDER File
Properties dialog box or dialog boxes appear, containing properties for the
selected files. If you have selected to view properties for multiple files, a
separate Properties dialog box will appear for each selected file, and those boxes
will be cascaded on the screen.

Figure 208: Multiple Files - File Properties Dialog Boxes

NOTE ����
You may only view the properties for up to 15 files at one time. If you select
more than 15 files, you will receive a message box informing you of this
limitation, and the first 15 file Properties dialog boxes will appear.

To view DX file properties through the shortcut menu:
1 In the Windows Explorer, select one or more files and folders.

2 Right-click on any of the selected files to open the shortcut menu.

3 From the shortcut menu, select the DISKXTENDER option and then select View
File Properties.
The DISKXTENDER File Properties dialog box or dialog boxes appear, containing
properties for the selected files. If you have selected to view properties for
multiple files, your Properties dialog boxes will appear cascaded on the screen
(see Figure 208 above).

FILE REPORTS
You can use DX Explorer Add-ons to run a file report on one or more files and
folders. The File Report function allows you to choose whether to run a Full Detail
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or a Summary report, and whether to report on All Files selected or only those files
managed by DISKXTENDER.

The information contained in a Summary report includes:

Table 29: Summary File Report Information

FILE DATA: DESCRIPTION:

File Name Name of the file

File Size Size of the file (in bytes)

File Date Date and time the file was last accessed and saved

Media Name Label of the media where the file is stored

Status Whether the file is currently Fetched to the extended drive or
Purged (only file tag exists on the extended drive)

DR Indicates whether Direct Read is enabled for this file or not

The information contained in a Full Detail report includes:

Table 30: Full Detail File Report Information

FILE DATA: DESCRIPTION:

Filename Full name of the file (including directory information)

File Size Size of the file (in bytes)

File Date Date and time the file was last accessed and saved

Media Name Label of the media where the file is stored. Also indicates
whether that media is online or offline.

Media Type Type of media where the file is stored

File System File System used on the media where the file is stored

Hardware Type Type of hardware storing the media where the file is stored

Status Whether the file is currently Fetched to the extended drive
or Purged (only file tag exists on the extended drive)

DR Indicates whether Direct Read is enabled for this file or not

NOTE ����
Where applicable, the file report indicates which files are not managed by
DISKXTENDER in place of the media information provided for the report.



Chapter Seven: Explorer Add-Ons

206 Application Storage Manager System Guide

To run a DX file report through the wizard:
1 There are two ways to open the Shell Extensions Wizard:

� Right-click any file in Explorer and select DISKXTENDER Shell Wizard
from the DISKXTENDER option on the shortcut menu.

� Select the Shell Xtensions Wizard option from the OTG DISKXTENDER
program group accessible through the Start menu.

The Shell Extensions Wizard opens.

2 Select Reports – Generate file reports for selected files or folders and click Next.
The File Selection window appears.

3 Select files and options using the functions described in Table 24 on page 196.

4 Click Next. The File Report Options page appears.

Figure 209: File Report Options Page

The File Report Options page allows you to configure report details. The options
on the Report Options page are as follows:

Table 31: DX File Report Configuration Options

OPTION: DESCRIPTION:

Report Details Select Full detail to provide a detailed file report; select
summary to report only summary file information.

File Filter Select All Files to report on all files; select
DISKXTENDER files to report on only DX files. Selecting
DISKXTENDER files activates the Media Filter option.

Media Filter This option is only active if DISKXTENDER files are
selected under File Filter. Select media in the list to
specify media on which the report should be performed.
You can select All media to choose all DX media on the
extended drive.
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OPTION: DESCRIPTION:

File Name Configure a location for the output report file.

Browse Click to browse for a location for the output report file.

Make these
options defaults

This option is disabled by default. Enable this option to
use the selected Report Details, File Filter, Media Filter
and File Name options as defaults each time you
generate a report.

Explorer
bypasses wizard

This option is disabled by default. Enabling this option
allows you to bypass this options page when running a
report using the shortcut menu (see shortcut menu
procedures below).

NOTE ����
If you enable the Explorer bypasses wizard option, the default settings will be
used. These default settings are the system defaults unless you have changed the
default settings by enabling the Make these options defaults function in this
window.

5 Configure your DX File Report options as necessary and click Next. The
Summary page appears.

Figure 210: File Report Summary Page

6 Review the information in the summary page. Click Back to change any of the
information entered.

7 If the summary information is correct, click Finish. The report is created and the
File Report appears on your screen in RtfPad.
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Figure 211: RtfPad File Report Window

To run a DX file report using the shortcut menu:
1 In the Windows Explorer, select multiple files or single or multiple folders.

2 Right-click on any of the selected files to open the shortcut menu.

3 From the shortcut menu, select the DISKXTENDER option and then select File
Report. The File Report Options page appears.

Figure 212: File Report Options Page

The File Report Options page allows you to configure report details. The options
on the Report Options page are as follows:
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Table 32: DX File Report Configuration Options

OPTION: DESCRIPTION:

Report Details Select Full detail to provide a detailed file report; select
summary to report only summary file information.

File Filter Select All Files to report on all files; select
DISKXTENDER files to report on only DX files. Selecting
DISKXTENDER files activates the Media Filter option.

Media Filter This option is only active if DISKXTENDER files are
selected under File Filter. Select media in the list to
specify media on which the report should be performed.
You can select All media to choose all DX media on the
extended drive.

File Name Configure a location for the output report file.

Browse Click to browse for a location for the output report file.

Make these
options defaults

Select Make these options defaults to use these options
as defaults each time you generate a report.

Explorer
bypasses wizard

Enabling this option allows you to bypass this options
page when running a report using the shortcut menu.

4 Configure your DX File Report options as necessary and click Next. The
Summary page appears.

Figure 213: File Report Summary Page

5 Review the information in the summary page. Click Back to change any of the
information entered.

6 If the summary information is correct, click Finish. The report is created and the
File Report appears on your screen in RtfPad.
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Figure 214: RtfPad File Report Window

NOTE ����
If you have previously enabled the Explorer bypasses wizard option in the File
Report Options page, the report will automatically be run on the selected files when
the File Report option is selected from the shortcut menu. To disable this option, you
must run a report through the Shell Xtensions Wizard, and uncheck the option in the
Options page.

DIRECT READ
You can enable and disable direct read for DX files and folders using the DX
Explorer Add-ons. The Direct Read attribute on a file means that the file will always
be read from the media when requested by a client, rather than being fetched to the
extended drive first.

NOTE ����
Direct read can only be set for DISKXTENDER files. If you select any non-
DISKXTENDER files (or folders containing non-DISKXTENDER files), the operation
will fail and the direct read attribute will not be changed for any files.

To enable or disable direct read through the wizard:
1 There are two ways to open the Shell Extensions Wizard:

� Right-click any file in Explorer and select DISKXTENDER Shell Wizard
from the DISKXTENDER option on the shortcut menu.

� Select the Shell Xtensions Wizard option from the OTG DISKXTENDER
program group accessible through the Start menu.
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The Shell Extensions Wizard opens.

2 Select Direct Read – Set direct read option for selected files or folders and click
Next. The File Selection window appears.

3 Select files and options using the functions described in Table 24 on page 196.
Click Next. The Direct Read Setting page appears.

Figure 215: Direct Read Settings Page

4 Select to Enable or Disable direct read for the files selected.

Table 33: DISKXTENDER File Properties: Settings Tab: Direct Read Setting

OPTION: DESCRIPTION:

Disabled When the direct read attribute is disabled, the file is fetched to the
extended drive and opened from there.

Enabled When the direct read attribute is enabled for a file, that file is
read directly from media when it is retrieved, rather than being
fetched to the extended drive.

5 Click Next. The Summary Page appears.
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Figure 216: Direct Read Summary Page

6 Review the information in the Summary page. If it is correct, click Finish. A
confirmation message appears, verifying that you want to enable or disable the
Direct Read attribute for the files chosen.

Figure 217: Enable Direct Read Verification Message

Figure 218: Disable Direct Read Verification Message

7 Click Yes. The selected Direct Read setting is applied to the selected files.

NOTE ����
You can also enable or disable the Direct Read attribute through the Settings tab of
the File Properties dialog box. For information, see File Properties - Settings Tab on
page 202.
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To enable or disable direct read through the shortcut menu:
1 In the Windows Explorer, select one or more files or folders.

2 Right-click on any of the selected files to open the shortcut menu.

3 From the shortcut menu, select the DISKXTENDER option and then select Enable
Direct Read or Disable Direct Read as appropriate.
A confirmation message appears, verifying that you want to enable or disable
the Direct Read attribute for the files chosen.

Figure 219: Enable Direct Read Verification Message

Figure 220: Disable Direct Read Verification Message

4 Click Yes. The selected Direct Read setting is applied to the selected files.

NOTE ����
You can also enable or disable the Direct Read attribute through the Settings tab of
the File Properties dialog box. For information, see File Properties - Settings Tab on
page 202.

PURGE FILES
The Purge files function allows you to select and manually purge DX files from your
extended drive on a one-time basis, independent of the purge rules for your extended
drive. Purging files truncates the file data on the extended drive, leaving a file tag
that points to the (complete) file on the media.

To purge DX Files through the wizard:
1 There are two ways to open the Shell Extensions Wizard:

� Right-click any file in Explorer and select DISKXTENDER Shell Wizard
from the DISKXTENDER option on the shortcut menu.

� Select the Shell Xtensions Wizard option from the OTG DISKXTENDER
program group accessible through the Start menu.
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The Shell Extensions Wizard opens.

2 Select Purge Files – Purge file data for selected files or folders and click Next.
The File Selection window appears.

3 Select files and options using the functions described in Table 24 on page 196.

4 Click Next. The Summary Page appears.

Figure 221: Purge Files Summary Page

5 Review the information in the Summary page. If it is correct, click Finish. A
confirmation message appears, verifying that you want to purge the selected
files.

Figure 222: Purge Files Verification Message

6 Click Yes. The selected files are purged.

To purge files using the shortcut menu:
1 In the Windows Explorer, select one or more files or folders.

2 Right-click on any of the selected files to open the shortcut menu.

3 From the shortcut menu, select the DISKXTENDER option and then select Purge
Files. A confirmation message appears, verifying that you want to purge the
selected files.
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Figure 223: Purge Files Verification Message

4 Click Yes. The selected files are purged.
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REMOVING DX AND DX COMPONENTS

DISKXTENDER can be removed from the DX computer if necessary. When DX is
removed, all configuration settings and system files are deleted. When reinstalled,
new settings must be configured. Caution should be taken when removing the
product, as all settings are permanently lost.

THE DX Setup program, accessed through the OTG DISKXTENDER program group in
the Windows start menu, provides a wizard that takes you step by step through the
uninstall process. However, DISKXTENDER requires that you remove several key
components before you attempt to uninstall the program. If you run the DX Setup
wizard to uninstall DX before removing these components, the wizard will display a
message stating you must remove these items from your DISKXTENDER
configuration before uninstalling the program.

This chapter includes a list of actions necessary before uninstalling DX and
procedures for completing each of those actions. In addition, you will find
instructions on running the Setup Wizard to uninstall the DISKXTENDER program, the
DISKXTENDER Remote Administrator and the DISKXTENDER Explorer Add-Ons.

NOTE ����
You may use the Repair Disk function to create a copy of your DX configuration and
restore that configuration after uninstalling and reinstalling DISKXTENDER if
appropriate. For more information on using the Repair Disk function, see Chapter
Four: DX Computer Administration on page 75.

PREPARING FOR UNINSTALLING DISKXTENDER

In preparation for removing DISKXTENDER, you must remove all existing extended
drives (and any media folders and any media in the media folders on those extended
drives) and force a drive scan to update the affected Windows settings. Before
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running Setup to uninstall DISKXTENDER, make sure you have completed the actions
listed below. Instructions for completing each action appear after the list.

For your convenience, the setup wizard allows you to uninstall DISKXTENDER from
multiple computers at once. To take advantage of this feature, you may want to
determine which computers are to have DISKXTENDER removed from them before
you run the setup wizard, enabling you to run the wizard once rather than multiple
times. You still have to perform the preparation steps below on each computer from
which you are removing DISKXTENDER, so you need to prepare each computer from
which you will be removing DX prior to running the Setup Wizard.

To prepare for removing DX:
1 Delete any scheduled media tasks.

2 Remove media from each media folder.

3 Force drive scans for each extended drive.

4 Delete each extended drive.

5 Remove all media services.

6 Reboot each DX computer.

7 If configured for Automatic Startup, stop the DX service after reboot.

NOTE ����
The above steps are only necessary if you are removing the DISKXTENDER program
itself. The preparation steps do not apply if you are uninstalling the Remote
Administrator or the Explorer Add-Ons.

DELETING SCHEDULED MEDIA TASKS
The Media Task Queue Manager lists all media that have assigned tasks ready to be
performed and allows you to abort any tasks currently in progress and delete all
scheduled tasks for media on the extended drive.
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To access the media task manager:
� With any item in the extended drive tree selected, select Media Task Manager

from the Tools menu. The Media Task Queue Manager appears.

Figure 224: Media Task Queue Manager

NOTE ����
The Media Task Queue Manager is specific to each extended drive. If you have more
than one extended drive configured for your DX system, make sure you delete all
tasks for media on all extended drives.

Canceling a Task in Progress
Logically, you cannot delete a task if it is already in progress. The task in progress
must be canceled or aborted first. Then the remaining task(s) for the media can be
deleted.

NOTE ����
The Format task cannot be canceled or aborted once it is in progress.
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To stop a task already in process:
1 Select the media in the queue and click the Abort Task in Progress button.

Figure 225: Abort Task In Progress Button

A message appears, prompting you to confirm that the task should be stopped.

2 Click Yes. The task is stopped (and removed).

Deleting Scheduled Media Tasks
You can remove all pending tasks for media through the Media Task Manager dialog
box. When you use the Delete Tasks button, all tasks are deleted and the media is
removed from the queue.

To delete tasks for media:
1 Select the media in the queue and click the Delete Tasks button.

Figure 226: Media Task Queue Manager
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A message appears, confirming that all tasks should be deleted for the piece of
media.

2 Click Yes. All tasks are deleted and the media is removed from the queue.
Repeat this for all media listed in the queue.

NOTE ����
The Media Task Manager is specific to each extended drive. If you have more than
one extended drive configured for your DX system, make sure you delete all tasks
for media on all extended drives.

REMOVING MEDIA FROM MEDIA FOLDERS
In order to remove media from a media folder, all pending media tasks for the media
must first be deleted, or if in progress, stopped. If media has a task in progress that
cannot be aborted, it cannot be removed until the task completes.

Files that are on the media are not affected when the media is removed; however,
those files are removed from the extended drive. In the tree view, media that is
removed from a media folder reappears in the Available Media tree for the extended
drive.

As stated, when media is removed from a media folder, files are removed from the
folder on the NTFS volume only. No files are deleted from the actual media.

Using the Shortcut Menu
The shortcut menu available for each piece of media contains a Remove command
that allows you to remove that piece of media. If the media has pending tasks, the
remove command is grayed out. You cannot remove media until all pending tasks
have processed or been deleted.

To remove a single piece of media from a media folder:
1 Right-click the piece of media you want to remove. A shortcut menu appears.

2 From the shortcut menu, select Remove. A message appears, verifying that you
wish to remove the selected media.

3 Click Yes.

4 A message appears stating that the media will not be removed until a drive scan
is run and asking if you would like to run a drive scan now.

Figure 227: Run Drive Scan Now Message
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5 Click Yes. Another message appears stating that the drive scan has started.

Figure 228: Drive Scan Started Message

6 Click OK. Once the drive scan completes, the media is removed from the media
folder and appears in the Available Media tree for the extended drive.

Using the Remove Media Wizard
The Remove Media Wizard allows you to remove multiple pieces of media from a
media folder at once. The Remove Media wizard is accessed from the shortcut menu
for the Media node under the media folder, or from the Edit menu or shortcut menu
for the extended drive. You cannot remove media with pending tasks.

To remove multiple pieces of media from a media folder:
1 You have the following choices:

� Right-click the Media node under the appropriate media folder. A shortcut
menu appears. From the shortcut menu, select Remove Media.

� Right-click the node for the extended drive. A shortcut menu appears. From
the shortcut menu, select Remove Media from Media Folders.

� Select the extended drive and select the Remove Media from Media Folders
option from the Edit menu.

The Remove Media From Media Folder page of the Remove Media wizard
appears.
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Figure 229: Remove Media From Media Folder Page

2 Select the media to be removed, and click Next. The Summary page appears.

3 To remove the media from the media folder click Finish. DX verifies that the
media does not have any pending media tasks. If the media has any pending
media tasks, the attempt to remove the piece of media will fail.

Figure 230: Summary Page
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4 A message appears stating that a drive scan must be performed to finish
removing the media and asking if you would like to run a drive scan now.

Figure 231: Run Drive Scan Now Message

5 Click Yes. Another message appears stating that the drive scan has started.

Figure 232: Drive Scan Started Message

6 Click OK. Once the drive scan completes, the media is removed from the media
folder and appears in the Available Media tree for the extended drive.

DELETING MEDIA FOLDERS
When you delete a media folder, you delete all of the move groups and move, purge,
and delete rules you have created for that folder. Media contained in the media folder
must be removed before you can delete the folder. For instructions, see Removing
Media from Media Folders on page 221.

You can delete each media folder individually or you can delete all the media folders
at once.

Deleting a Single Media Folder
The shortcut menu available for each media folder contains a single Delete
command. Use this to delete each media folder separately.

To delete individual media folders:
1 Right-click the media folder you want to remove. A shortcut menu appears

consisting of one command: Delete.

2 Select the Delete command. A message appears, verifying that you wish to
remove the selected media folder.

3 Click Yes. DX verifies that the media folder does not contain media and the
media folder is removed from the extended drive.
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Figure 233: Delete Media Folder Verification Message

Deleting Multiple Media Folders
Both the Edit menu and the shortcut menu for the extended drive contain a command
that will allow you to select and delete all media folders on that extended drive at
once. Remember that all media must be removed from the media folders before they
can be deleted from the extended drive.

To delete multiple media folders:
1 Expand the Media node(s) of the media folder to verify that all media has been

removed from the media folder(s).

2 Right-click on the extended drive where the media folder is located or open the
Edit menu and select Delete Media Folder. The Delete Media Folder dialog box
appears.

Figure 234: Delete Media Folder Dialog Box

3 Select the folder(s) to be deleted, and click OK. The media folders are removed
from the extended drive.

DELETING EXTENDED DRIVES
When an extended drive is deleted from DISKXTENDER, all associated components
are deleted as well, to include all schedules and configured options for that extended
drive. The media will still exist as part of the media service, and the media service
must be removed separately. For instructions, see Removing Media Services on page
226.
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All components of the extended drive should be deleted prior to deleting the
extended drive. The only objects you should see in the tree view are the Extended
drive and the Available Media nodes.

To delete an extended drive:
1 You have two choices:

� With the Extended Drive selected, select Delete Extended Drive from the
Edit menu.

� Right-click the extended drive and select Delete Extended Drive.
A message appears, prompting you to verify deletion.

2 Click Yes. The extended drive and its components are deleted.

Once all of your extended drives are deleted, your administrator view will be empty.

REMOVING MEDIA SERVICES
When your extended drives have been deleted, you will notice your Administrator
window is empty. However, unless you have deleted them previously, your media
services remain and must be deleted prior to uninstalling DISKXTENDER. Repeat the
following procedure for each media service configured to DISKXTENDER.

To delete a media service:
1 Make sure that all NAS, OTGMS, and TSM media have been deallocated from

extended drives.

2 From the Service menu of the Administrator select Configure Media services.
The Configure Media Services dialog box appears.

Figure 235: Configure Media Services Dialog Box

3 Select the media service from the list and click Delete. A verification message
appears.
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Figure 236: Delete Media Service Verification Message

4 Click Yes. If the media service is still online, a message appears stating the
media service must be set offline to be deleted.

Figure 237: Delete Media Service Verification Message

5 Click Yes. The media service is deleted from your DX configuration and the
Configure Media Services window reappears without the deleted service.

UNINSTALLING DISKXTENDER

Once you have completed the steps listed in the Preparing for Uninstalling
DISKXTENDER section on page 217 for each computer from which you will be
removing the DISKXTENDER program, while it is not required, it is recommended
that you restart each computer.

After restarting the computer(s), you are now ready to uninstall DISKXTENDER. The
same DX Setup wizard that installed the program can be used to uninstall the
program. Because the setup wizard allows you uninstall DISKXTENDER from
multiple computers at once, you may want to determine which computers are to have
DISKXTENDER removed from them before you run the setup wizard, enabling you to
run the wizard once rather than multiple times.

DX Setup is a wizard that leads you through the necessary steps for removing
DISKXTENDER. The Next button continues to the following step; the Back button
(when active) returns to the preceding step. The Cancel button exits Setup, canceling
the process.
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To remove DX:
1 Select Setup from the OTG DISKXTENDER program group accessed through the

Start menu. The Shell Extensions warning box appears.

Figure 238: Extensions Warning Dialog Box

2 Click Yes to remove the DISKXTENDER Shell Extensions from memory. The
DISKXTENDER Setup wizard appears, starting with the DISKXTENDER
Installation page.

Figure 239: DX Removal: DISKXTENDER Installation Page

3 Click Next. The DISKXTENDER Installation Options page appears.
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Figure 240: DX Removal: DISKXTENDER Installation Options Page

4 Select the Remove product and related items option and then click Next. A
warning appears informing you that Uninstalling cannot be undone.

Figure 241: Uninstall Warning Message

5 Click Yes to continue. The Select Target Computers page appears with the local
computer already listed in the Target Computers list.

Figure 242: DX Removal: Select Target Computers Page
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NOTE ����
If you have other computers registered through the DX Administrator, those
computers will also appear in the initial Target Computers list.

6 If you want to remove DX from other computers, click Add. The Browse
Computers dialog box appears.

Figure 243: DX Setup: Browse Computers Dialog Box

7 Under Available Computers, navigate to and select the computer from which
you want to remove DX. Click Add. The computer you have selected is listed
under Selected Computers. Repeat this step for each additional computer from
which you want to remove DX.

8 Click OK. You are returned to the Select Target Computers page.

Figure 244: DX Removal: Select Target Computers Page
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9 Carefully review the list of target computers. Remove any computers in the list
for which you do not want DX uninstalled by selecting the computer and
clicking Delete.

10 When the list of target computers for removing DX is correct, click Next. The
Summary page appears, listing the target computers from which DX will be
removed.

Figure 245: DX Removal: Summary Page

11 Click Finish to complete uninstalling DX. A progress bar appears indicating the
completion percentage of the removal process. If you are uninstalling from
multiple DX computers, separate progress bars will subsequently appear
indicating the percentage complete for the program removal from each
computer.

Figure 246: DX Removal: Progress Bar

Any settings related to DX in the Windows NT/2000 registry, all program files
in the installation path, and the DISKXTENDER program group/folder are
removed. When uninstalling is complete, the DISKXTENDER Setup Results
dialog box appears, listing the results for each target computer specified.
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Figure 247: DISKXTENDER Removal Results Dialog Box

12 Take note of any computers that need to be rebooted (or computers on which the
uninstall failed). Click OK.

13 Restart each computer for which the DISKXTENDER Setup Results dialog box
indicates a reboot is required.

REMOVING DISKXTENDER REMOTE ADMINISTRATOR

DISKXTENDER Remote Administrator can be removed from a machine if necessary.
Removing the Administrator from a remote machine does not affect the DX machine
to which it points. Only the system files for the remote Administrator and Service
Manager are deleted. This means you do not need to perform the preparation steps
necessary for uninstalling the DISKXTENDER program itself.

The same Remote Administrator Setup wizard that installed the program can be used
to uninstall the program. Because the setup wizard allows you uninstall the Remote
Administrator from multiple computers at once, you may want to determine which
computers are to have the Administrator removed from them before you run the
setup wizard, enabling you to run the wizard once rather than multiple times.

DX Remote Administrator Setup is a wizard that leads you through the necessary
steps for removing the Remote Administrator. The Next button continues to the
following step; the Back button (when active) returns to the preceding step. The
Cancel button exits Setup, canceling the process.
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To remove DX remote administrator:
1 Select Setup from the OTG DISKXTENDER Administrator program group

accessed through the Start menu. The Shell Extensions warning box appears.

Figure 248: Shell Extensions Warning Dialog Box

2 Click Yes. The Setup Wizard opens with the Administrator Installation page.

Figure 249: Remote Administrator Removal: Installation Page

3 Click Next. The Administrator Installation Options page appears.

Figure 250: Remote Administrator Removal: Installation Options Page



Chapter Eight: Removing DX and DX Components

234 Application Storage Manager System Guide

4 Select the Remove product and related items option and then click Next. A
warning appears informing you that Uninstalling cannot be undone.

Figure 251: Uninstall Warning Message

5 Click Yes to continue. The Select Target Computers page appears with the local
computer already listed in the Target Computers list.

Figure 252: Remote Administrator Removal: Select Target Computers Page

6 If you want to remove the Remote Administrator from other computers, click
Add. The Browse Computers dialog box appears.

Figure 253: Remote Administrator Removal: Browse Computers Dialog Box
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7 Under Available Computers, navigate to and select the computer from which
you want to remove the Remote Administrator. Click Add. The computer you
have selected is listed under Selected Computers. Repeat this step for each
additional computer from which you want to remove the Administrator.

8 Click OK. You are returned to the Select Target Computers page.

Figure 254: Remote Administrator Removal: Select Target Computers Page

9 Carefully review the list of target computers. Remove any computers in the list
for which you do not want the Remote Administrator uninstalled by selecting
the computer and clicking Delete.

10 When the list of target computers for removing the Administrator is correct,
click Next. The Summary page appears listing the target computers from which
the Remote Administrator will be removed.

Figure 255: Remote Administrator Removal: Summary Page
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11 Click Finish to complete uninstalling Remote Administrator. A progress bar
appears indicating the completion percentage of the removal process. If you are
uninstalling from multiple computers, separate progress bars will subsequently
appear indicating the percentage complete for the program removal from each
computer.

Figure 256: Remote Administrator Removal: Progress Bar

Any settings related to the Remote Administrator in the Windows NT registry,
all program files in the installation path, and the DISKXTENDER ADMINISTRATOR
program group/folder are removed. When uninstall is complete, the
Administrator Setup Results dialog box appears, listing the results for each
target computer specified.

Figure 257: Administrator Removal Results Dialog Box

12 Take note of any computers that need to be rebooted (or computers on which the
uninstall failed). Click OK.

13 Restart each computer for which the Administrator Setup Results dialog box
indicates a reboot is required.

REMOVING DISKXTENDER EXPLORER ADD-ONS

DISKXTENDER Explorer Add-ons can be removed from a machine if necessary.
Removing the Explorer Add-ons from a machine does not affect the DX service.
Only the system files for the Explorer Add-ons are deleted. This means you do not
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need to perform the preparation steps necessary for uninstalling the DISKXTENDER
program itself.

The same DISKXTENDER Explorer Add-Ons Setup wizard that installed the program
can be used to uninstall the program. Because the setup wizard allows you uninstall
the Explorer Add-Ons from multiple computers at once, you may want to determine
which computers are to have the Explorer Add-Ons removed from them before you
run the setup wizard, enabling you to run the wizard once rather than multiple times.

DISKXTENDER Explorer Add-Ons Setup is a wizard that leads you through the
necessary steps for removing the Explorer Add-Ons. The Next button continues to
the following step; the Back button (when active) returns to the preceding step. The
Cancel button exits Setup, canceling the process.

To remove DX Explorer Add-Ons:
1 Select Setup from the OTG DISKXTENDER Explorer Add-Ons program group

accessed through the Start menu. The Shell Extensions warning box appears.

Figure 258: Shell Extensions Warning Dialog Box

2 Click Yes. The Setup Wizard opens with the Explorer Add-Ons Installation
page.

Figure 259: Explorer Add-ons Removal: Installation Page

3 Click Next. The Explorer Add-Ons Installation Options page appears.
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Figure 260: Explorer Add-ons Removal: Installation Options Page

4 Select the Remove product and related items option and then click Next. A
warning appears informing you that Uninstall cannot be undone.

Figure 261: Uninstall Warning Message

5 Click Yes to continue. The Select Target Computers page appears with the local
computer already listed in the Target Computers list.

Figure 262: Explorer Add-ons Removal: Select Target Computers Page
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6 If you want to remove the Explorer Add-Ons from other computers, click Add.
The Browse Computers dialog box appears.

Figure 263: Explorer Add-ons Removal: Browse Computers Dialog Box

7 Under Available Computers, navigate to and select the computer from which
you want to remove the Explorer Add-Ons. Click Add. The computer you have
selected is listed under Selected Computers. Repeat this step for each additional
computer from which you want to remove the Explorer Add-Ons.

8 Click OK. You are returned to the Select Target Computers page.

Figure 264: Explorer Add-ons Removal: Select Target Computers Page

9 Carefully review the list of target computers. Remove any computers in the list
for which you do not want the Explorer Add-Ons uninstalled by selecting the
computer and clicking Delete.
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10 When the list of target computers for removing the Explorer Add-Ons is correct,
click Next. The Summary page appears listing the target computers from which
the Explorer Add-Ons will be removed.

Figure 265: Explorer Add-ons Removal: Summary Page

11 Click Finish to complete uninstalling the Explorer Add-ons. A progress bar
appears indicating the completion percentage of the removal process. If you are
uninstalling from multiple computers, separate progress bars will subsequently
appear indicating the percentage complete for the program removal from each
computer.

Figure 266: Explorer Add-ons Removal: Progress Bar

Any settings related to the Explorer Add-Ons in the Windows registry, all
program files in the installation path, and the OTG DiskXtender Explorer Add-
Ons program group/folder are removed. When uninstall is finished, the Explorer
Add-Ons Setup Results dialog box appears, listing the results for each target
computer specified.
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Figure 267: Explorer Add-Ons Removal Results Dialog Box

12 Take note of any computers that need to be rebooted (or computers on which the
uninstall failed). Click OK.

13 Restart each computer for which the Explorer Add-Ons Setup results dialog box
indicates a reboot is required.

After restarting, uninstall is complete.
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